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®  Enter into discussions with other software customers
® Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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http://h20230.www2.hp.com/new_access_levels.jsp
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business needs, includes a full list of Integrations between HP Products, as well as a listing of ITIL Processes. The URL for this Web site is

http://h20230.www2.hp.com/sc/solutions/index.jsp
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Introduction

This chapter provides an overview of the HP Universal CMDB (UCMDB) - HP Service Manager
(SM) integration (also referred to as the Universal CMDB (UCMDB) integration or UCMDB-SM
integration throughout this document).

This chapter includes:
e "Who Should Read this Guide" below
o "Purpose of the Integration" below

e "How Cl information is Synchronized Between UCMDB and Service Manager" on page 16

Who Should Read this Guide

This guide is intended for a system implementer or system administrator who will be establishing
and maintaining a connection between the UCMDB and Service Manager systems. This guide
assumes that you have administrative access to both systems. The procedures in this guide may
duplicate information available in your UCMDB and Service Manager help systems, but is provided
here for convenience.

Note: This document replaces the following documents that have been published before this
release:

e HP Universal CMDB Integration Guide (for Service Manager 9.30, dated July 2011)

e UCMDB-SM Integration Standards and Best Practices Guide (dated 31 May 2010)

Purpose of the Integration

An integration between HP Universal CMDB (UCMDB) and HP Service Manager enables you to
share information about the actual state of a configuration item (Cl) between your UCMDB system
and a Service Manager system. Cls commonly include IT services, hardware and software. Any
organization that wants to implement the best practices Configuration Management and Change
Management ITIL processes can use this integration to verify that Cls actually have the attribute
values the organization has agreed to support.

You can use this integration to automate the creation of Service Manager change or incident
records to update or rollback Cls that have unexpected attribute values. Service Manager allows
you to programmatically define what actions you want to take whenever a Cl’s actual state does
not match the expected state as defined in the Cl record.

The integration offers several different ways for users to view Cl actual state information:

o By default, the integration automatically updates the managed fields of Service Manager ClI
records as part of the regular UCMDB synchronization schedule. You can choose the option to
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configure the integration to automatically create change or incident records instead.

o A Service Manager user can view the current actual state of a Cl by looking at the Actual State
section in the Cl record. When you open the Actual State section, Service Manager makes a
web services request to UCMDB and displays all Cl attributes the request returns. Service
Manager only makes the web service call when you open this section.

o A Service Manager user can use the View in UCMDB option to log in to the UCMDB system
and view the current Cl attributes from UCMDB. The Service Manager user must have a valid
UCMDB user name and password to log in to the UCMDB system.

Supported Use Cases

This section describes use cases that are supported by the UCMDB-SM integration. The supported
use cases provide the core business processes that are enabled by the UCMDB-SM integration.

There are four main business use cases supported by the UCMDB-SM integration. They are as
follows:

o Planned Change: A change created in SM through the formal SM change process.

« Unplanned Change: A change or incident that occurred in SM and does not conform to the formal
SM change process.

¢ Retrieving SM Ticket Information: The ability to view SM ticket information in UCMDB.
¢ Actual State: The ability to view the UCMDB ClI information in SM.
All of the use cases provide important functionalities that enable the user to perform ITIL (IT

Infrastructure Library) processes. The ITIL processes refer to a set of best practices that define and
outline how organizations should manage their IT.

Enabling ITIL Processes

By activating Cl push from UCMDB to SM the user facilitates ITIL processes such as Incident,
Problem and Change Management in SM.

SM utilizes the data pushed from UCMDB in the following modules:

o Incident Management: the Service Desk operator (SD Agent) selects the “Service” and the
“Affected CI” for the specific Incident record.

« Problem Management: the SD agent selects the “Service” and the “Primary CI” for the specific
Problem record.

o Change Management: the SD agent selects the “Service” and the “Affected Cl(s)” for the
specific Change record.

In each of the previously mentioned ITIL processes, SM utilizes Cl information for Service,
Affected Cls and Primary Cls that all originate in UCMDB.
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Managing Planned Changes

The purpose of the “Planned Change” use case is to provide IT organizations a formal process by
which changes to the IT infrastructure are introduced after thorough review and analysis. This is
performed according to the “Change Management” process defined in ITIL v3.

A “Planned Change” is initiated by the SM user via the formal “Change Management” process
module in SM. This is followed by the actual change implementation.

The actual changes are discovered by a discovery tool such as HP DDMA, and then updated in
UCMDB and the relevant modifications are pushed to SM. Once the user has validated the change,
the user closes the relevant planned change in SM.

Managing Unplanned Changes

The purpose of the “Unplanned Change” use case is to provide IT organizations a formal process by
which all changes that occur to the IT infrastructure are both logged and conventionalized through
the organizations formal approval process.

An “Unplanned Change” is a change that is recognized by a Discovery tool such as DDMA. The
change is first updated and visible in UCMDB and then the data is pushed to SM. SM recognizes
the change and as aresult an “Incident” or “Change” record is generated.

These Changes are seen also in the SM “Pending Changes” section in the Configuration Item form,
once approved they are moved to the SM “Historic Changes” section.

Retrieving Service Manager Ticket Information

Retrieving SM ticket information from within UCMDB provides all HP Software applications users
with access to this information by using UCMDB's federation capabilities and supporting APIs.
These applications include Business Service Management (BSM), Asset Manager (AM),
Operations Orchestration (OO), etc.

SM ticket data is accessed from within UCMDB using UCMDB federation capabilities. SM ticket
dataincludes Incident, Problem and Change records as well as a key set of their attributes.

UCMDB enables users to create reports/views that combine the federated ticket data from SM with
Cl information from UCMDB.

Retrieving Actual State of UCMDB Cls

The purpose of “Actual State” is to enable SM users insight into Cls’ current state as detected by
“Discovery Tools” and populated in UCMDB. This state provides up-to-date information that may
vary from the information displayed in SM both in content and in scope.

The “Actual State” of the Cl is displayed in SM in order to enable the user to validate the current
state of the CI that resides in UCMDB or in another data repository.

SM users retrieve the Actual State of Cls from UCMDB or additional data sources by viewing the
Cl's Actual State section in the SM Configuration Item form.
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Accessing UCMDB CIs from Service Manager

SM users can open the UCMDB User Interface in the context of a specific Cl, by clicking the View
in UCMDB button in the SM CI record. When the user clicks the View in UCMDB button, a
UCMDB login screen displays; After the user enters a UCMDB username and password, UCMDB
displays a topological view of the specific Cl together with all related Cls that are linked to it.

Tip: You can configure Lightweight Single Sign-On (LW-SSO) for the integration, so that
Service Manager web client users can bypass the UCMDB login screen after clicking the View
in UCMDB button. For more information, see "How to Enable Lightweight Single Sign-On
(LW-SSO) Configuration" on page 93.

If the UCMDB Browser URL is specified in the SM System Information Record, this button is
replaced by the View in UCMDB Browser button. When you click the View in UCMDB Browser
button, a UCMDB Browser login screen displays; After you entera UCMDB Browser username
and password, the Cl is displayed in the UCMDB Browser Ul.

Core Features

This section explains the rudimentary concepts behind the Federation, Push, and Population
features as they pertain to the integration.

This sectionincludes:
e "Push" below
o "Federation" on the next page

o " Population" on the next page

Push

UCMDB can automatically discover most types of Cls available in Service Manager. This
integration enables you to push these types of Cls from UCMDB to Service Manager.

The following figure shows how data is pushed from UCMDB to Service Manager (SM). The data is
physically pushed (copied) from UCMDB to SM. Once the data is physically located in SM, the
data is utilized by the SM user that consumes this information in various SM processes.

UCMDB
|V h> ——
CPUAﬂrl
(. CPU ) Disk DISI{A‘III‘i

Note: Cl Type and Attribute Push
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Only information that is physically present in UCMDB can be pushed to SM.

Federation

With the federation feature, UCMDB pulls various ticket information (for example, Incident,
Problem, and Change ticket information) from SM. This enables users to see Ticket information in
UCMDB as Ticket Cls that are connected to the relevant Nodes.

When data is federated (reflected or mirrored) from SM to UCMDB, the data is not physically
present in UCMDB, instead it is passed over to UCMDB via Web Services.
Population

You can also use this integration to populate those types of Cls that UCMDB cannot automatically
discover or Cls that have been created in Service Manager before you have a UCMDB system
deployed. For more information, see "When do | Need the Population Feature" on page 96.

Population is the reverse of Push. The following figure shows how data is populated from SM to
UCMDB. One SM CI record with multiple attributes is transferred to UCMDB as multiple Cl

records.
UCMDB SM
Population
(cPu ) ( Disk ) Disk Attributes

How CI information is Synchronized Between
UCMDB and Service Manager

This section explains how Cl information is transferred between the UCMDB and Service Manager
systems.

This section includes:

o "Cl Information Usage" on the next page

o "High-Level Components of the Integration" on the next page
« "Relationships Between Integration Components" on page 18
e "What Information is Stored in UCMDB" on page 18

o "What Information is Stored in Service Manager" on page 19
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Cl Information Usage

When referring to the concept of Cl information it is important to make the distinction between a
UCMDB CI and a Service Manager (SM) Cl. The UCMDB model represents a topology that
contains a number of Cl types and relationships.

The UCMDB topology can be represented in Service Manager as a single entity. Multiple Cls from
UCMDB and their attributes are merged into a single record in SM and the relevant UCMDB
attributes are mapped to their appropriate counterparts in the SM record.

~

( UCMDB Cl
Information
p
Topology
( (Hode
\—
P
F | (DiskDevice )
A~ N _
( (Location _
M .r"-- ~.
(Ceru D)
[ (TP Pl —
S | (FileSystem)
( (nterface )—
\ S
A

/

Z Convert to SM Cl >

( SM Cl

Information

Computer Record

o i
Location attributes ]
fossssssssccssssssosnas 1
'|P attributes ]

A
'Interface attributes '

The above figure shows the correlation between the UCMDB topological model and its
representation of the Computer Instance together with its parallel representation in SM. The SM
computer Cl contains all of the UCMDB information that is passed through the integration.

In the push flow, in the UCMDB topological view several Cls such as Node, IP, Interface, Location,
File System, CPU, Disk Device and their Relationships are converted into a single SM computer
record with the IP, MAC Address and Location, File System, CPU and Disk Device attributes.

In the population flow, the conversion is reversed.

High-Level Components of the Integration

The following diagram shows the high-level components of the UCMDB integration, and illustrates
the interactions between UCMDB and Service Manager.

HP Universal CMDB (UCMDB 10.10, CP 13.00)
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Relationships Between Integration Components

The following figure illustrates the relationships between the Service Manager Adapter components
in UCMDB and the associated components in Service Manager.

The Service Manager Adapter includes configuration files, which are used to map UCMDB entities

to their counterparts in Service Manager during data push, as well as map Service Manager Cls to
UCMDB entities during population.

The configuration files utilize UCMDB TQL queries that define a superset of data relevant for the

integration.
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What Information is Stored in UCMDB

Your UCMDB system stores the actual state of Cls and Cl relationships as Cl attributes. Typically,
UCMDB uses one or more integrations and discovery mechanisms (feeders) to automatically
detect Cl attribute values. The UCMDB-SM integration only uses a subset of the Cl attributes
available ina UCMDB system.

For more information, see "Tailoring the Integration" on page 110.
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What Information is Stored in Service Manager

Your Service Manager system stores the managed or expected state of Cls and Cl relationships as
attribute values in a Cl record. To be part of the integration, a Cl attribute in your UCMDB system
must map to a managed field in the Service Manager Cl record. You can add, remove, or update the
managed fields that are part of the integration by tailoring the Service Manager web services that
manage the integration.

Service Manager runs according to a set of rules that define what actions you want the system to
take whenever a Cl’s actual state does not match the expected state as defined in the Cl record.

You define these rules from the Discovery Event Manager (DEM) in Service Manager where you

can do the following:

« Automatically update a Cl record to match the attribute values listed in the actual state. (This is
the default behavior.)

« Automatically create a change record to review the differences between the actual state and the
managed state.

o Automatically create an incident record to review the differences between the actual state and
the managed state.
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Before implementing the integration in your production environment, you can set up the integration
in a test environment using the out-of-the-box integration configurations. This chapter describes the
basic integration setup tasks without any tailoring or multi-tenancy configurations. It covers the
following topics:

o "Integration Requirements" below

o "How to Upgrade Your Integration" on the next page

o "Integration Setup Overview" on page 26

o "HP Service Manager Setup" on page 27

e "HP Universal CMDB Setup" on page 29

¢ "Populating UCMDB with Service Manager Cl Data" on page 34

e "Pushing UCMDB CI Data to Service Manager" on page 38

o "Federating SM Ticket Data to UCMDB" on page 44

Tip: Before you proceed to implementing the integration in your production environment, you
can refer to the following chapters for further information:

e "Multi-Tenancy (Multi-Company) Setup" on page 60, which describes how you set up the
integration in multi-tenancy mode.

e "Standards and Best Practices" on page 79, which describes best practices for
implementing the integration and also provides Frequently-Asked-Questions information.

e "Tailoring the Integration" on page 110, which describes how you can tailor the integration to
better suit your business needs.

e "Troubleshooting" on page 211, which provides information on troubleshooting data push
and population issues.

Integration Requirements

The supported product versions of this integration are listed in the following table.
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Supported product versions

Service Manager UCMDB

9.30 + UCMDB Integration Content Pack 10.01 CP122, 10.10CP13
9.30.0 1

9.31,9.32 10.01 CP12, 10.10 CP13

You must set up the following required components to establish an integration between UCMDB
and Service Manager.

e HP Universal CMDB installation
Add a UCMDB Probe for the population feature if you do not already have one.

o HP Service Manager installation
Add the UCMDB URL to the System Information Record. See "How to Add the UCMDB
Connection Information" on page 28.

o Network connection between the HP Universal CMDB and HP Service Manager systems.

For instructions on installing and configuring your systems, see the UCMDB and Service Manager
documentation.

How to Upgrade Your Integration

The UCMDB Integration Enhancement Content Pack 9.30.0 for Service Manager 9.30 is already
included in the Service Manager 9.32 applications, except for several code changes, which are not
included in order for backward compatibility. This means, to take advantage of the integration
enhancement in SM 9.32, extra steps are required to upgrade your existing SM-UCMDB integration
after you upgrade to Service Manager applications 9.32. This section describes these upgrade
tasks.

Note: If you have already applied the UCMDB Integration Enhancement Content Pack 9.30.0
for Service Manager 9.30, the integration has been upgraded and you need to do nothing. If you
do not want to upgrade your existing integration, you need to do nothing and your integration
can continue to work as before.

This task includes the following steps:

1The UCMDB Integration Content Pack 9.30.0 is available from the HP Live Network at:
https://hpin.hp.com. For instructions on installing the content package, see the Service Manager
9.30 Applications Patch Manager Guide for Content Patches shipped with the content pack
release.

2C| data replication (push) from UCMDB to Service Manager is supported for certain versions of
UCMDB earlier than 9.x with less content and limited error handling; however Cl data population is
supported only for UCMDB 9.05 or later. For this reason, this document does not cover information
about integrating Service Manager with earlier versions of UCMDB. For such information, see the
HP Universal CMDB to HP Service Manager Integration Guide for Service Manager version 9.20,
which is available from http://h20230.www2.hp.com/selfsolve/manuals.
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« "Modify the definitions of certain Cl types in Service Manager." below

o "Copy data to the joinnode table" on page 24

¢ "Align the SM ClI relationship data model with the UCMDB data model." on page 25
o "Update the cirelationship dbdict." on page 26

1. Modify the definitions of certain Cl types in Service Manager.

The SM-UCMDB integration enhancement uses the joinnode table for data mappings of the
following ClI types: mainframe, networkcomponents, storage, and computer. The new data
mappings require certain changes be made to these Cl types in Service Manager 9.32, as
described in the following tables.

Note: For backward compatibility, the definitions of all out-of-box ClI types in Service
Manager 9.32 are identical to those in Service Manager 9.30.

Changes required for Mainframe CI types

Removed
Field Old Value New Value Subtypes
Format Name configurationltem configurationltemNode LPAR
Attr File networkcomponents node
Join Def joinnetworkcomponents joinnode
Bulk Update device.mainframe.bulkupdate = device.node.bulkupdate
Format Name
Added subtypes for Mainframe are:
» Logical Partition
= CPC
Changes required for Network Components CI types
Removed
Field Old Value New Value Subtypes
Format Name configurationltem configurationltemNode LB
Attr File networkcomponents node
Join Def joinnetworkcomponents joinnode
Bulk Update device.mainframe.bulkupdate = device.node.bulkupdate

Format Name
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Added subtypes for Network Components are:

= LoadBalancer

= Bandwidth Manager
= CSU/DSU

= Ethernet

= FDDI

= KVM Switch

= Multicast Enabled Router
= Token Ring

= Voice Gateway

= Voice Switch

= VPN Gateway

s Wireless Access Point

Changes required for Storage CI types

Field Old Value

Format Name configurationltem

Attr File storage
Join Def joinstorage
Bulk Update device.storage.bulkupdate

Format Name
Added subtypes for Storage are:
= SAN Gateway
= SAN Router
= SAN Switch

Storage Array

HP Universal CMDB (UCMDB 10.10, CP 13.00)
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Changes required for Computer Cl types

Removed
Field Old Value New Value Subtypes
Format Name configurationltem configurationitemNode | N/A
Attr File computer node
Join Def joincomputer joinnode
Bulk Update device.computer.bulkupdate ' device.node.bulkupdate

Format Name

Added subtypes for Computer is:
= Virtualized System

To use the integration enhancement, you must modify the following device type definitions in
Service Manager: computer, networkcomponents, mainframe, and storage:

a. Loginto Service Manager 9.32 as a system administrator.

b. Navigate to Configuration Management > Resources > Device Types, and then click
Search.

c. Select one of the Cl types (computer, networkcomponents, mainframe, and storage), and
update its definition as described in the above tables.

d. Repeat the steps above for the rest of the four Cl types.
2. Copy data to the joinnode table

This task in optional. It is required only if you want to use the joinnode-based data mappings. If
you want to use the original tables instead of joinnode (see the above tables), this task is not
needed; instead, you need to modify the data mappings of the Service Manager 9.xx adapter
in UCMDB.

To copy your data from relevant tables to the joinnode table:
a. Loginto Service Manager 9.32 as a system administrator.

b. InDatabase Manager, in the Table field type cidatacopy, and then click Search. The
Copy CI Type Data form opens.

c. Click Search. A list of records displays: joincomputer, joinmainframe,
joinnetworkcomponents, and joinstorage.

d. Select each record from the list, update or add source/target fields as needed, and click the
Copy Data button. One of the following messages occurs:
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i. A message like “<XXX> records were successfully copied, and <YYY> records were
ignored within xxx ms”, where XXX and YYY represent the numbers of records copied
and ignored.

ii. An error message: “Configuration validation failed, and no records were copied.
Please check your Source Fields/Target Fields settings and run Copy Data again.”

e. If the error message occurs, correct your Source Fields/Target Fields settings, and click
Copy Data again until all of your records have been successfully processed.

3. Align the SM CI relationship data model with the UCMDB data model.

To use the integration enhancement, you need to manually update several records in Service
Manager to align the SM ClI relationship data model (relationship types and subtypes) with that
of UCMDB, in order for easy data mapping between the two products.

a. Loginto Service Manager as a system administrator.
b. In Script Library, open the EnableUcmdblntegrationUl script.

c. Click Execute. Running this script will automatically rename each record in the table below
to <record_name>.bak.932, and replace them with new records with the original record
names.

Records replaced and renamed

Record Type Record Name

Format CM.relationship
CM.relationship.gbe
CM.relationship.type
CM.relationship.type.gbe
dataModEventRel.relationship.detail
dataModEventRel.relationship.gbe
am.downstream.relationships.vj

am.upstream.relationships.vj
Extaccess Relationship

Format Control CM.relationship
CM.relationship.type

dataModEvent.relationship
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d. Verify that the Cl relationship form looks like the following:

Configuration Item Relationship

Upstream CI; * =i Q,

Relationship Name: *

Relationship Type: + - D"

Downstream Cls: * =i Q‘
=
Sl
=g/

COutage Dependency

|:| Outage Dependency
Thig Configuration fkem will be considered down if

or more of the supporting configuration tems are down
If you tailored any of these records in the above table, open the <record_name>.bak.932 record
to identify the differences, and merge your customizations in the new record.
4. Update the cirelationship dbdict.
The data length of Cl relationship name in Service Manager is 40 characters, which is not
sufficient for the integration. If a Cl relationship name exceeds this data length, either the
relationship name is truncated after push or the relationship cannot be pushed to Service

Manager due to a duplicate key error. You need to manually increase the data length in Service
Manager:

a. Open the cirelationship table in Database Dictionary.

b. Increase the data length of the relationship.name field from 40 to an appropriate value
(recommended value: 300).

c. Save therecord.

Integration Setup Overview

The integration requires setup on both the UCMDB and Service Manager systems.

This task includes the following steps:
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1. Set up the Service Manager system.
See "HP Service Manager Setup” below.

2. Set upthe UCMDB system.
See "HP Universal CMDB Setup" on page 29.

3. Runthe UCMDB population jobs to synchronize Cls to UCMDB.
See "Populating UCMDB with Service Manager CI Data" on page 34.

4. Runthe UCMDB data push jobs to transfer Cls to Service Manager.
See "Populating UCMDB with Service Manager CI Data" on page 34.

HP Service Manager Setup

You must complete the following tasks from your Service Manager system to support the
integration.

1. Create a dedicated integration user account in Service Manager.
See "How to Create an Integration User Account" below.

2. Add the UCMDB connection information to the system information record.
See "How to Add the UCMDB Connection Information" on the next page.

How to Create an Integration User Account

This integration requires an administrator user account for UCMDB to connect to Service Manager.
This user account must already exist in both UCMDB and Service Manager.

To create a dedicated integration user account in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Type contacts inthe Service Manager command line, and press ENTER.

3. Create a new contact record for the integration user account.
a. Inthe Full Name field, type a full name. For example, UCMDB905x.

b. Inthe Contact Name field, type a name. For example, UCMDB905x.
c. Click Add, and then OK.
4. Type operator inthe Service Manager command line, and press ENTER.
5. Inthe Login Name field, type the username of an existing system administrator account, and

click Search.
The system administrator account displays.
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6. Create a new user account based on the existing one.

a. Change the Login Name to the integration account name you want (for example, ucmdb).
b. Type a Full Name. For example, UCMDB.

c. Inthe Contact ID field, click the Fill button and select the contact record you have just
created.

d. Click Add.
e. Select the Security tab, and change the password.

f. Click OK.

The integration user account is created. Later you will need to add this user account
(username/password) in UCMDB, and then specify this user account in the Credentials 1D field
when creating an integration point in UCMDB. See "How to Create an Integration Point in UCMDB"
on the next page.

How to Add the UCMDB Connection Information

The integration requires the UCMDB connection information to obtain ClI attribute information from
the UCMDB system, and display it in the Actual State section in the Service Manager configuration
item form.

Caution: If you do not specify the correct connection information, an error, instead of UCMDB
Cl information, will display in the Actual State section.

Note: The integration with UCMDB Browser is supported only for Service Manager 9.31 or
later.

This task includes the following steps:

1.

2.

Log in to Service Manager as a system administrator.

Click System Administration > Base System Configuration > Miscellaneous > System
Information Record.

Click the Active Integrations tab.

Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.

In the UCMDB webservice URL field, type the URL to the HP Universal CMDB web service
API. The URL has the following format:
http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService
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Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

6. InUserld and Password, type the user credentials required to manage Cls on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

7. Optionally, if you want to enable an integration to the UCMDB Browser, in the UCMDB
Browser URL field, type your UCMDB Browser URL in the following format:
http://<UCMDB browser server name>:<port>/ucmdb-browser

For example: http://myucmdbbrowserserver:8081/ucmdb-browser

The UCMDB Browser has two themes. By default, it uses the dark color theme; if you want to
use the light color theme, use this format for the UCMDB Browser URL:

http://<UCMDB browser server name>:<port>/ucmdb-browser/?theme=LIGHT

Note: If you specify the UCMDB Browser URL here, the View in UCMDB Browser
button will replace the View in UCMDB button in Cl records synchronized from UCMDB;
only when you leave this field empty, the View in UCMDB button will appear.

8. Click Save. Service Manager displays the message: Information record updated.
9. Log out of the Service Manager system.
10. Log back into the Service Manager system with an administrator account.

The Actual State section and the View in UCMDB Browser or View in UCMDB button will be
available in Cl records pushed from UCMDB.

HP Universal CMDB Setup

You must complete the following tasks from your UCMDB system to support the integration.

1. Create an integration point between UCMDB and Service Manager.
See "How to Create an Integration Point in UCMDB" below.

2. Update the configuration files of the adapter.
See "How to Update the Time Zone and Date Format for the Integration Adapter" on page 33.

How to Create an Integration Pointin UCMDB

A default UCMDB installation already includes the ServiceManagerAdapter9-x package. To use the
integration package, you must create an integration point listing the connection properties for the
integration.

Caution: For data population, this integration supports the use of only one probe for your
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Service Manager system. In other words, you should not run population jobs on different
probes by setting up multiple integration points with different probes for your Service Manager
system. Only one probe is allowed for one Service Manager system.

To create an integration point:
1. Loginto UCMDB as an administrator.

2. Add the integration user account that you created in Service Manager.
a. Click Administration > Users and Roles.

b. Click the Add New User button /.

c. ForUser Name and Password, type the user name and password you created in Service
Manager. See "How to Create an Integration User Account" on page 27.

d. Click Next, and then in the Role List select Admin.
e. Click Finish. The integration user account is added.

3. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

4. Click the New Integration Point button |Z|.
UCMDB displays a New Integration Point properties window.

5. Complete the integration and adapter property fields as described in the following table.
Integration and adapter properties (UCMDB 10.01 or later)

Is
Field name required? Description

Integration Yes Type the name (unique key) of the integration point. For
Name example, Population_CIl_From_S.

Integration No Type a description of current integration point.
Description
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Integration and adapter properties (UCMDB 10.01 or later), continued

Is
Field name required? Description

Adapter Yes For UCMDB 9.05:

Select HP BTO Products or HP Software Products >
Service Manager > Service Manager 9.xx.

For UCMDB 10:

Select HP Software Products > Service Manager > Service
Manager 9.xx.

Note: This adapter, which supports Cl/relationship Data
Push from UCMDB to Service Manager, and Population
and Federation from Service Manager to UCMDB, is
available out-of-the-box only in UCMDB version 9.05 or

later.
Is Integration | Yes Enable this option to indicate the integration point is active.
Activated
Hostname/IP | Yes Type the hostname or IP address of the Service Manager
server.
Forexample, 1ocalhost.
Port Yes Type the communications port of the Service Manager server.

For example, 13080.
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Integration and adapter properties (UCMDB 10.01 or later), continued

Is
Field name required? Description

URL No This field value (if any) supersedes the Hostname/IP and Port
Override settings described above.

Use this field If you want UCMDB to connect to Service
Manager in any combinations of the following ways:

= Connect to Service Manager over HTTPS or over both HTTP
and HTTPS

= Connect to multiple Service Manager server nodes
(vertically scaled environment)

= Connect to one single Service Manager server node through
multiple ports (horizontally scaled environment)

For more information, see "Push in Clustered Environments" on
page 84.

Type one or more Service Manager web services URLs
(separated by a semicolon) in this field.

The following are two example values of this field (each URL
should use this format: http
(s)://<hostname>:<port>/sc62server/ws):

m https://localhost:13443/sc62server/ws

s http://localhost:13080/sc62server/ws;
https://localhost:13443/sc62server/ws;
http://smfped4:13080/sc62server/ws

Credentials  Yes Click Generic Protocol, click the Add button to add the

ID integration user account you created, and then select it. This
account must exist in both Service Manager and UCMDB. See
"How to Create an Integration User Account" on page 27.

Probe Name @ Yes Select the name of the Data Flow Probe used to run population
jobs. You should have already added the data flow probe for the
integration after installing UCMDB. See "Integration
Requirements" on page 20.

6. Click Test Connection to make sure that a successful connection is created.

7. Click OK.
The integration point is created and its details are displayed.
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8. Click the Federation tab, and complete the following configuration.
a. In Supported and Selected Cl Types, select the following Cl types as needed from
Managed Object > ItProcessRecord:
i. Incident

ii. Problem

iii. Request for Change

Supported and Selected Cl Types
B A

= [@]
SR

%] incidert
@ Prablem
| 2| [RequestFor Change

b. Foreach Cl type you selected (Incident, Problem, or Request for Change), in Cl Type
Retrieval Mode select Retrieve Cls of selected Cl Type.

9. Click the Population and Data Push tabs, to view the default integration job details.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. If needed, you can create a new job for the integration point. For
information about creating integration jobs, see "How to Define Data Push Jobs in
UCMDB" on page 38 and "How to Define Population Jobs in UCMDB" on page 35.

10. Click the Save Integration Point button ||.

How to Update the Time Zone and Date Format for
the Integration Adapter

The integration uses an integration user account to connect UCMDB to Service Manager. You
specified this user account in the Credentials ID setting when creating an integration point. See
"How to Create an Integration Point in UCMDB" on page 29. You must make sure that this
integration user account uses the same time zone and date format in both Service Manager and
UCMDB. To do so, you define the same time zone and date format in the integration adapter
configuration file and in the integration user’s operator record in Service Manager.

To update the time zone and date format for the integration adapter:

1. Check or change the time zone and date format of the integration user in Service Manager.
a. Loginto Service Manager as a system administrator.

b. Navigate to System Administration > Ongoing Maintenance > Operators. The
Operators form opens.
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For Login Name, type the integration user name (for example, ucmdb) you set in the
integration point (the Credentials ID field).

Click Search. Service Manager displays the record of the operator.
Click the Login Profiles tab.

View or change the operator's Time Zone and Data Format field values.

Operator Record

& General | & Security | < Login Profiles | & Startup | & Motification | & Security Groups | & Self Service |

Login Profile owledge Groups
Language: English -

|USfMoun13in | = |
fmm/ddjyy Rd
Display Currency |us Dallar | - |Q |
Message Level: |Information | b |

Max Attachment Size: | |

Total Attachment Size:
Licensing Information Assignment Groups

Mamed User
Mamed Applications:

2. Set the time zone and date format for the adapterin UCMDB.

a.

b.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > serviceDeskConfiguration.xml.

At the bottom of the file, locate the elements “<date_pattern>" and “<time_zone>", and
update the values according to the integration user’s time zone/date format setting in
Service Manager.

The date pattern and time zone are in java format pattern used by
java.text.SimpleDateFormat. Out-of-the-box, the date format and time zone values in
serviceDeskConfiguration.xml are: MM/dd/yy HH:mm:ss, and US/Mountain.

Populating UCMDB with Service Manager ClI

Data

In addition to pushing CI data from UCMDB to Service Manager, this integration also supports the
population of Cl data (including Cls and Cl relationships) from Service Manager to UCMDB. The
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integration can then update the list of Cls in UCMDB if new Cls or new attribute values are found in
Service Manager. The population of data from Service Manager to UCMDB is defined in the
Integration Studio in UCMDB. You can manually run the population jobs, however HP recommends
that you schedule these jobs to keep your Cls and Cl attributes up to date.

This task includes the following steps:

1. Define CI/CI Relationship population jobs in UCMDB.
See "How to Define Population Jobs in UCMDB" below.

2. View the transferred CI/CI Relationship datain UCMDB.
See "View Service Manager Cl Datain UCMDB" on page 37.

3. Schedule CI population jobs to keep Cls and ClI attributes up to date.
See "How to Schedule CI Population Jobs" on page 37.

How to Define Population Jobs in UCMDB

A CI/ClI relationship population job copies certain types of Cls/Cl relationships from Service
Manager to UCMDB.

To define a Cl or Cl relationship population job:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

3. Open an integration point.

4. Click the Population tab, and add a new job as follows.

Note: UCMDB creates several default population and data push jobs when creating an
integration point. The following table lists the default population jobs and their Topology
Query Language (TQL) queries. If needed, you can create, update or remove TQL queries
for each job. For information about tailoring population TQL queries, see "Create a TQL
Query to Populate the Cl Type" on page 183.
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TQL queries for Cl / Cl relationship population
Integration Job  TQL queries for Cl / Cl relationship population

SM Configuration = Out-of-the-box, the following TQL queries are available for this job,
Item Population which populates Cl records from Service Manager to UCMDB:
job
= SM Business Service Population: Populates Cls of the bizservice
type.

= SM RunningSoftware Population: Populates Cls of the
RunningSoftware type.

= SM Computer Population: Populates Cls of the computer type.

SM Relations Out-of-the-box, the following TQL queries are defined for this job, which
Population job populates Cl Relationship records from Service Manager to UCMDB:

= SM Biz To Biz With Containment: Populates ClI relationships in
which a bizservice Cl contains another.

= SM Biz To Biz With Usage: Populates Cl relationships in which a
bizservice Cl uses another.

= SM Biz To Computer With Containment: Populates Cl
relationships in which a bizservice Cl contains a computer CI.

= SM Biz To Computer With Usage: Populates ClI relationships in
which a bizservice Cl uses a computer CI.

= SM Computer To Computer With Connects: Populates ClI
relationships in which a computer Cl connects to another.

a. Click the New Integration Job button

b. Type a Name for the integration job. For example, Cl_Population_Job1.

c. Click the Add Query button * toadd existing TQL queries to the job (see the above
table).

d. Select the Allow Integration Job to delete removed data check box for the query.
e. Click OK to save the job.

5. Runthe job manually to see if the integration job works properly.

-
a. To populate all relevant data for the job, click the [z button.

b. To populate only Cl data changes since the job last ran, click the > button.
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8.

Wait for the job to complete, and click the Refresh button multiple times as needed until the job
is completed.

Note: When the job is completed, the job status becomes one of the following:
Succeeded, Passed with failures, or Failed.

Click the Statistics tab to view the results, and if the job failed, click the Query Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Population Issues" on
page 237.

Click OK.

If the job is completed successfully, you can view the transferred Cl datain UCMDB and schedule
the job so that it can run automatically.

View Service Manager Cl Data in UCMDB

After a population job is successfully completed, you can search for the Service Manager Cl
records in UCMDB, and verify that their attributes are correctly populated.

The Service Manager CI Identifierfield is populated to the Name field on the Configuration Item
Properties pane in UCMDB.

Note: To see the entire attribute mappings of a Cl type, you can open the Cl type’s population
XSLT file (for example, business_service population.xslt) and the root population xslt file
(cmdb_root_attributes_population.xslt), where the UCMDB attribute field names and the
mapped Service Manager web service field caption names are defined. For more information,
see "Tailoring the Integration" on page 110

How to Schedule Cl Population Jobs

You can schedule Cl population jobs to match the discovery/maintenance schedule of your Service
Manager feeders. For example, if your Service Manager feeders send Cl data updates on a daily
schedule, then the population jobs should also run on a daily schedule. By using a matching
schedule you can ensure that your UCMDB system always has the most current Cl data.

This task includes the following steps:

1.

2.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.

Open an integration point.

Click the Population tab, and select a population job from the list.
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8.

9.

Click the Edit Integration Job button.
Select the Scheduler enabled option.

Select the scheduling options you want to use. For example, select Repeat every: Day and
Ends: Never.

Select a Time Zone.

Click OK.

Pushing UCMDB CI Data to Service Manager

The integration requires a one-time transfer of Cls from UCMDB to Service Manager to populate the
Service Manager system with Cls. The integration will then update the list of Cls in Service
Manager when UCMDB discovers new Cls or new attribute values. The integration accomplishes
the push of Cl data using data push jobs in the UCMDB system. HP recommends that you
schedule these jobs to keep your Cls and Cl attributes up to date.

This task includes the following steps:

1.

Define CI/CI Relationship data push jobs.
See "How to Define Data Push Jobs in UCMDB" below.

View the CI/CI Relationship data pushed from UCMDB.
See "How to View UCMDB CI Datain Service Manager" on page 41.

Schedule data push jobs to keep Cl/Cl Relationship data up to date.
See "How to Schedule Data Push Jobs" on page 42.

How to Define Data Push Jobs in UCMDB

Data push jobs copy Cl or Cl Relationship records from your UCMDB system to your Service
Manager system.

To define a Cl or Cl relationship push job:

1.

2.

Log into UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
existing integration points.

Select the Integration Point you created for Service Manager. For example, SM Integration.

Click the Data Push tab.
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5. Add a new data push job as follows.

a. Click the New Integration Job button ™

Note: UCMDB creates a default data push job when creating an integration point. The
following table lists the default data push job and its Topology Query Language (TQL)
queries. If needed, you can create, update or remove TQL queries for the push job. To
access these out-of-the-box TQL queries for push, go to Modeling > Modeling Studio >
Resources, select Queries for Resource Type, and then navigate to Root > Integration
> SM Sync > 9.xx. For information about tailoring data push TQL queries, see "How to
Create a TQL Query to Synchronize the Cl Type" on page 153.

TQL queries for Cl / Cl relationship push

Integration
job TQL queries

Integration = TQL queries
job

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 39 of 256



Universal Discovery Content Guide - Service Manager Integration
Integration Setup

TQL queries for Cl / Cl relationship push , continued

Integration
job TQL queries

SM Push Out-of-the-box, the following TQL queries are available for this job, which
job pushes CI/Cl Relationship records from UCMDB to Service Manager:

= SM Mainframe Push: pushes Cls of the mainframe type.

= SM Network Component Push: pushes Cls of the network component
type.

= SM Running Software Push: pushes Cls of the running software type.
= SM Business Service Push: pushes Cls of the business service type.
= SM Computer Push: pushes Cls of the computer type.

= SM Storage Push: pushes Cls of the storage type.

= SM Switch Push: pushes Cls of the switch type.

= SM Net Printer Push: pushes Cls of the net printer type.

= SM Cluster Push: pushes Cls of the cluster type.

= SM Mobile Device Push: pushes Cls of the mobile device type.

= SM Local Printer Push: pushes Cls of the local printer type.

Out-of-the-box, the following TQL queries are available for this job, which
pushes CI Relationship records from UCMDB to Service Manager:

= SM Layer2 Topology Relations Push: pushes compound ClI
relationships between nodes.

= SM Business Service Relations Push: pushes Cl relationships whose
upstream ClI type is business service.

= SM CRG Relations Push: pushes ClI relationships whose upstream Cl
type is cluster.

= SM Node Relations Push: pushes direct Cl relationships whose
upstream CI type is node.

b. InName, type a unique name for the job. For example, Cl_Push_Job1.

c. Click the Add Query button * toadd existing TQL queries to the job.
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d. Select the Allow Integration Job to delete removed data option for each query.
e. Click OK to save the job.

6. Run the job manually to see if the integration job works properly.

Caution: If you have a huge amount of Cl data in your UCMDB system, and this is your
first time to push CI /CI Relationship data to Service Manager, it is recommended to
select the “Add the record” option instead of “Open a change” or “Open an incident” for
“Action if matching record does not exist” in each Discovery Event Manager Rules
definition. Otherwise unnecessary performance problems might occur. For details, see
"Add Discovery Event Manager Rules" on page 131.

-
a. To push all relevant data for the job, click the = button.

b. To push only changes in the data since the job last ran, click the > button.

Tip: You can stop a running push job by pressing the Stops the selected job button .

7. Wait for the job to complete, and click the Refresh button multiple times as needed until the job
is completed.

Note: When the job is completed, the job status becomes one of the following depending
on the results: Succeeded, Passed with failures, or Failed.

8. Click the Statistics tab to view the results; if any errors occur click the Query Status tab and
Job Errors tab for more information. For details, see "Troubleshooting Data Push Issues" on
page 211.

9. Click OK.

If the job is completed successfully, you can view the UCMDB CI data in Service Manager, and
schedule the job so that it can run automatically.

How to View UCMDB CI Data in Service Manager

After a push job is successfully completed, you can search for and verify the pushed CI/Cl
relationship data in Service Manager.

Cl records pushed from UCMDB contains a View in UCMDB or View in UCMDB Browser
button, which enables you to access UCMDBor the UCMDB Browser to view the Cl information.

Note:
o If you specified the UCMDB Browser URL in the System Information Record in SM, the
View in UCMDB Browser button displays; otherwise the View in UCMDB button

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 41 of 256



Universal Discovery Content Guide - Service Manager Integration
Integration Setup

displays.
e The UCMDB Browser is a lightweight Ul designed for simple access to UCMDB
configuration information. This is a tool for searching, locating and consuming configuration

related data. It is an optional add-on to UCMDB. For more information, refer to the UCMDB
Browser documentation.

Toview UCMDB ClI data in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Navigate to Configuration Management > Search Cls.
3. Open a Cl record pushed from UCMDB.

4. Ifthe View in UCMDB button is available, view the Cl record in UCMDB.
a. Click the View in UCMDB button. The UCMDB login screen opens.

b. Type a UCMDB username and password to log in.

The Cl record opens in UCMDB. You can view its properties.

Note: You can enable Lightweight Single Sign-On (LW-SSO) for the integration so that
Service Manager web client users can bypass the UCMDB login screen. For details, see
"How to Enable Lightweight Single Sign-On (LW-SSQO) Configuration" on page 93.

5. Ifthe View in UCMDB Browser button is available, view the Cl record in the UCMDB
Browser.
a. Click the View in UCMDB Browser button. The UCMDB Browser login screen opens.

b. Type a UCMDB Browser username and password to log in. The Cl record opens in the
UCMDB Browser. You can view its properties and other information.

6. Open the Actual State section.

Service Manager makes a web services request to UCMDB and displays all Cl attributes the
request returns.

Note: The web services request uses the UCMDB webservice URL and account (for
example, admin/admin) defined in the System Information Record in Service Manager.
See "How to Add the UCMDB Connection Information” on page 28.

How to Schedule Data Push Jobs

It is a best practice to schedule the data push jobs to match the discovery schedule of your Service
Manager feeders. For example, if your Service Manager feeders send Cl data updates on a daily
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schedule, the data push jobs should also run on a daily schedule. By using a matching schedule
you can ensure that your Service Manager system always has the most current Cl data.

UCMDB allows you to schedule updates directly from a data push job. This task includes the
following steps:

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Integration Studio. UCMDB displays a list of
integration points.

3. Select the integration point you created for the UCMDB-SM integration. For example, SM
Integration.

4. Click the Data Push tab.

5. Select apush job. For example, SM Configuration Item Push Job.

6. Click the Edit Integration Job button ¢ .

Tip: UCMDB allows you to define two different schedules for two types of data push:
Changes Sync, and All Data Sync. For recommendations on push scheduling, see "Push
Scheduling Recommendations" on page 82.

7. Define a schedule for Changes Sync.
a. Click the Changes Sync tab.

b. Select the Scheduler enabled option.

c. Select the scheduling options you want to use.

l Scheduler Definition

Changes Sync | | All Data Sync

Scheduler enabled

Repeat: Starts: Ends:

' once _
Interval | 1i2nz2 'l | 16:37 "l ®) mever () Until
Day of Morth Repeat on:
Weeldy |
Morthly [Tsun CInen [Tue Tlwed 1o ClFr Sat
Yearly
Cron

Time Zone: Data Flow Probe Time Zone |V| |§| Server Time: 172012 5:04 PM
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8. Click All Data Sync tab, and select the scheduling options you want to use.
9. Click OK to save the data push job.
10. Repeat step 6 to step 9 for the rest of data push jobs of the integration point.

11. Save the integration point.

Federating SM Ticket Data to UCMDB

Federation does not physically copy SM data to UCMDB; it only retrieves SM data for displaying in
UCMDB. Out-of-the-box, the UCMDB-SM integration supports federation for the following external
Cl types in UCMDB: Incident, Problem, and RequestForChange. If you have enabled these CI
types for federation when creating your integration point, in UCMDB you can retrieve the following
types of ticket data from Service Manager: Incident, Problem, and Change.

This sectionincludes:
¢ "Federation TQL queries" below

o "Examples of Using Federation" below

Note: You can tailor the integration to federate more SM ticket attributes to UCMDB. For
details, see "How to Add an Attribute of a Supported CI Type for Federation" on page 205.

Federation TQL queries

Federation uses TQL queries to determine what data to retrieve from Service Manager. To retrieve
specific ticket data from Service Manager, you need to create a TQL query first. Out-of-the-box,
sample federation TQL queries are available from UCMDB: Modeling > Modeling Studio >
Resources > View > Service Desk.

Examples of Using Federation

You can use the federation feature in many different ways. The following are only examples of using
the feature.

This section includes:
o "Example 1: Federate All SM Incident Tickets" on the next page

o "Example 2: Federate SM Incident Tickets that Affect a UCMDB Business Service CI" on page
49

o "Example 3: Federate SM Incident, Change and Problem Ticket Data of UCMDB Cls" on page
54

o "Example 4: Get Related SM Ticket Data of a UCMDB CI" on page 57
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Example 1: Federate All SM Incident Tickets

This example illustrates how you retrieve information of all Incident records that exist in Service
Manager.

1. Loginto UCMDB as an administrator.

2. Navigate to Modeling > Modeling Studio > Resources.
3. ForResource Type, select Queries from the list.

4. Click New > Query.

5. Onthe Cl Types tab, go to ItProcessRecord > Incident, and drag it to the query pane on the

right side.
= New - P =J =
*
Resources | [ CI selector [ CI Types | 5 querv 1* x
Cl Types Query Definition
B B | (E] Tree View - >@ ]j;'_@ B
(%) ActivityLog (U) 3
(@) Asset (1)
(@] Attachment (0}
—(®] Budget ©) &
(@] BudgetLine () - =
— Business Objective (0) = - Iheident
() Corfigurationttem (1189) -

(@] Cortract @)

—(®] Cost Legend: & Cortact Mode ¥ External U Has Conditions @ Has ldertities B Hidden in Query Results ¥ Model Output & Subgraph
(]

7 CostCatzgory (0)

(@] costcenter ()

E]—@ History Change (0) [Aﬂributes ‘Cardinality || Element Type || Element Layout || Data Sources

2] tProcessRecard ()

Change (0)

5 -

] @ There are no items in this view.

Interaction (0}

KnownError (0)

%] problem () 3

I

e [ ] © 6 &

s

6. Specify Service Manager as the data source for the Incident query node.
a. Select the Incident query node, click the Data Sources tab on the lower right pane, and
then click Edit.

b. Select the Select integration points option, and then select your integration point name
(for example, sm_integration). Click OK.
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F —_—
|£| Select Integraticn Peints u

=;j Select Integration Points
= Select the integration points to use for this query.

A integration points
() Local data source (UCMDE only)

® |Select integration poirrt3|

% B &

[ autctest
5 =m_integration
& ucmoe

7. Click the Save button & , and then type a query name and select a location to save the query
(for example, select the Root > Integration > SM Query folder).
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Eﬂ Save Query
Enter the query name and select a folder in which to save it

CQuery Mame | =m_incidents

XK o= A
—— ca cMDB
—=] Data In
—E Service-Mow
—=
I}]—E SM Sync
9
—=] sms sync
—E Sync_8

=P
| Find: |

8. Select the Incident query node, and then click the Calculate Query Result Count button .
UCMDB returns the query result count. For example, the following figure shows that there are

131 Incident records in total in Service Manager.

5 sm incidents <

Cuery Definition

h([EllE x|

[

(2

Incident (131}

ol p

| Legend: & Contact Mode [ External & Has Conditions @ Has Identities B Hidden in Query Results ¥ Model Output & Subgraph ® |
P

sm_integration

Incident | attributes || Cardinaity | % Flement Type || Flement Layout || * Data Sources || Selected Identities || * Details |

Eclit

9. Right-click the Incident query node, and select Show Element Instances. UCMDB displays a
list of all Incident records that exist in Service Manager.
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@J CI Instances

ﬁ Cl Instances
Here you can =ee all of the Tl instances found for the selected query node in the table

Show Clinstances of: | Incident (131) i | | ﬁ | ATl

M:t|a|= 8 -

Display Label

1M1 0001
IN1 0002
1M1 0003
IN1 0004
IM10005
IM10006
IM10007
IM10008
IM10009
IM10010
IM10011
IM10012
IM10014
IM10015
IM10016
IM10017
IM10018
IM10019
IM10020

[@] 110021
[N 1

|2

Total rows: 131 Rows per page: 50 hd
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10. Select an Incident ticket from the list, and click the Properties button =y to view its details.
| £ Configuration Item Properties

@I Configuration Item Properties

External Process Reference

Global Id

Impact Scope user
Incident Status closed
Incidert Type

Iz Candidate For Deletion Falze

Last Access Time

Marme: [M10001 1D =m_integration %0Aincident %041 %0AIncidert|D %30 STRING %3 DIM10001 %04 Cl Type: Incident
FI% i ‘B Export - | Quick filker: Type here to filtter propertie
ActiveProcess A
Actual Deletion Period 40
Alow Cl Update True
| | Category failure
f ClosedTime Sat Sep 1 2007 0913 AM CST
f Completion Code
f Consumer Tenarts )
| Container 3
Create Time Sat Sep 1 2007 04:21 AM CST
| Created By sm_integration
Celetion Candidate Period 20
Description
Display Label IM10001
Enable Aging Falze
Ezcalated Falze

Example 2: Federate SM Incident Tickets that Affect a
UCMDB Business Service CI

The following example illustrates how you federate a list of Service Manager Incident records
whose Affected Service or Affected Cl field contains a UCMDB Business Service ClI.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio > Resources.
3. ForResource Type, select Queries from the list.

4. Click New > Query.
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5. Onthe CI Type tab, go to Configurationltem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

# nNew + B [ 9 =

Resources || Cl selector || CI Types W
Cl Types Query Definition
X Bl | [E] Tree View ~ | » &3 ﬂ*@ﬁg
[L]_O Configurationtern (33) A]
[l]—o BusineszElement (20)

O Business Service View (0) =}

BusinessActivity (0) )

|§| BusinessApplication (1) B

BusinessFunction (0) = = &D

[C] BusinessProcess (0) .

@ BusinessTransaction (0) - Busifessoerice

Q Datacenter (0) -

55 service (19) a
&
55 Infrastructure Service () Legend: & Contact Mode 8 External ©

6. GotoltProcessRecord > Incident, and drag it to the query pane.
4 Mew - E} ] =

Rescurces | | Cl selector | | Cl Tvpes —jl—IE sm_incidents X Ejl Query 1+ xl—

Cl Types CQuery Definition

By B | (B Tres View v | P S ﬁk@ﬁ@

—(®] cost @ «|
— CostCategory (0)

—(®| costcenter (@)

[EI—'@ Hiztory Change (0)

EH#®] tProcessRecord (0
Change (0)

&

Interaction (0}
KnownErrar ()

M| Problem (0)

@ FequestFor Change (D)

1

Iil\

BusinessService

[rcident

“p = p

7. Click the Create Relationship button (I .

8. Select the Incident query node, and drag the arrow from this node to the BusinessService node
to create a regular relationship between the nodes.
a. Select Regular Relationship, and click OK.

b. Select Membership, and optionally enter a relationship name (for example, Membership_
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1). Click OK.

Add Relationship
| U+

Define required relationship between guery nodes

| EE:EE§|Tree\ﬂew*| |
| 2] Managed Relationship ~
Aggregation

| T & ® enbersisl

l— Time BoundMembership
. Connection I

|—. Dwnershlp

Relationship Name: | Membership_1

(4

Relationship Direction: Incident = v Business Service

Relationship RPestrictions: -

s |

=

9. Specify UCMDB as the data source for the BusinessService query node.
a. Select the BusinessService query node.

b. Onthe lower right pane, click the Data Sources tab and then click Edit.

c. Make sure that the Local data source (UCMDB only) option is selected.
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d. Click OK.

:;ii Select Integration Points
L Select the integration points to use for this guery.

() integration poirts
(®) Local data source (UCMDE only)
() Select integration poirts

L—f_l % Iq-_l

) ucMoE

10. Similarly, specify your integration point as the data source for the Incident query node (for

example, sm_integration).
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F —_—
| £:| Select Integration Points u

:;j Select Integration Points
A Select the integration poirts to use for this query.

A integration poirts
() Local data source (UCMDE only)

® |Select integration poirrts|

e B &

[ & autotest
Eﬁ sm_integration
& ucmos

11. Click the Calculate Query Result Count button . The number of SM Incidents and the
number of their affected UCMDB Business Service Cls display.
[ fed incident bizservice x|

Cuery Definition

=B x|

&
@)
Incident ¢

embership_1 (2
)

BusihessSetice

i)

“« p =——f] p

Legend: & Contact Node ™ External Y Has Conditions % Has Idertities @ Hidden in Query Resultz ¥ Model Output & Subgraph

| il
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12. Click the Preview button to view the query result = .

%' fed_incident_bizservice - Result Preview
Pesult preview for fed_incident_bizservice

Cl Selector [E,mws,g \,qgws]_ [\ﬁew Results || Related Cls
8- [Gives] 7o 1, o @

E@y bs1327230487 @ Top Layer

[u}

{8 bse1327232399
138 o004
3] im1on0s

In10005 In10004

Membership Membership

e

@

9 PR

-

GElp—H0p =
@
(&

hs1327232399 bs1327230487

¥

|Legend: #] Added i Candidate for Deletion & Changed B External + Impacted I Impacted and Trigger O MNote + Trigger *®

13. Select each SM Incident record from either the Cl Selector pane or the query pane, and click

the Properties button to view its details =y .
14. Select each UCMDB CI record from either the CI Selector pane or the query pane, and on the
Related Cls tab click Show Related Cls.

|Ej fed_incident_bizservice - Result Preview

Result preview for fed_incident_bizservice

I Selector [Browse Views |__| ‘iew Resuits || Related Cls
B (enl 8 Text | 11 [ x| % ¥ a0k
@; bs1327230487 ua Top Layer
(€0 bs1327232399 Get Related Cls i
2] 10004
%] imnooos a a &
. &
: @ Select scope: O View @ CMDB
: 10005 “Sriow Reltect CIs |
- Wermbership Fitter Related Clz by Cl Type
Q onnectian : 0 By 55| 2 Tree View -
\ @] incident (1)
q| = =y
@ A
beladriziiug Apply Perspectives to Cl
¥ [ cortent only
| Legend: ] Added Tt Candidate for Deletion £ Changed ? % | -
Description:

Example 3: Federate SM Incident, Change and Problem
Ticket Data of UCMDB Cls

The following example illustrates how you retrieve information of SM Incident, Change and Problem
tickets that affect a UCMDB Business Service Cl.

1. Loginto UCMDB as an administrator.

2. Navigate to Modeling > Modeling Studio > Resources.
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10.

For Resource Type, select Queries from the list.
Click New > Query.

On the Cl Type tab, go to Configurationltem > BusinessElement > Service >
BusinessService, and drag it to the query pane on the right side.

Go to ItProcessRecord, and drag Incident, Problem, and RequestForChange to the query
pane.

Click the Create Relationship button Ix to create regular relationships between the
BusinessService node and the other nodes as shown in the following figure.

=) fed incident bizservice *|| 5 Query 1% <

Guery Definition

REEEE
Membership ,___ Membershlp 2
Q »>
- BusinessSenice
: Membership_1
3 @
Q Incident Problem

RequestForChang
2

For the BusinessService node, specify UCMDB as the data source.

For the Incident, Problem, and RequestForChange nodes, specify your integration point as the
data source.

Save the query.
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11. Optionally, edit the BusinessService node properties as needed.
a. Select the BusinessServic node, and click Edit on the lower right pane.

b. Click the Cardinality tab. The default Cardinality setting displays.
24 Query Node Properties IR« SRS W W o TR S

Query Mode Properties

= Enables you to add attributes, cardinalty, qualfiers and Cl specific conditions

Elemert name: Elemert type:

| Business Service | | Business Service Vl Show element in guery results -Em

Atribute || Cardinality || Element T

+ X v @
C Criteria | ) And/or
Membership (Incident, BusinessService) : 1.* AND
{ Membership_1 (PeguestFor Change, Business Service) :1.* AND
Membership_2 (Problem, BusinessService) ;1. )
c. If youwish, change either or both of the AND operators to OR.
d. This will change the filter criteria and therefore the query result.
| £| Query Node Properties g
@ Query Node Properties
- Enables you to add attributes, cardinality, qualiiers and C| specific condtions
Element name: Element type:
'l Show elemert in query results B Query Resutt

|EusinessService | ‘ Business Service

|
Aftribute || Cardinality || Element T
+ ¥ v A

( Criteria | ) AndfOr

Membership (Incidert, BusinessService) :1.* OR

[y Membership_1 (RequestFor Change, BusinessService) @ 1..* OR

Membership_2 (Problem, Business Service) :1..* 1
12. Click the Preview button = |to view the query result.
B

|é| bizservice_incident_problem_rfc - Result Preview

|Ej bizservice_incident_problem_rfc - Result Preview
Result preview for bizservice_incidert_problem_rfc
Cl Selector View Results || Related Cls
B awlE G [ e Ao
(& bs1327230487 @ Top Layer
I@_) bs1327232399 s |
) c1o001 S = ] = =)
%] wnooos Q z D z i
N
ﬁél IM10005 IM10004 10001 PrR10001 IM10005
%] pr10001 - Mermbarshi
_ ernbership
N hWembership Mermberehip
a &
E élfl: hs1327232399
4
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13. Select each SM Incident record from either the Cl Selector pane or the query pane, and click

the Properties button =y to view its details.

14. Select each UCMDB ClI record from either the Cl Selector pane or the query pane, and on the
Related Cls tab click Show Related Cls to view its related Cls in both SM and UCMDB.

Example 4: Get Related SM Ticket Data of a UCMDB ClI

The following example illustrates how you retrieve SM ticket data related to a UCMDB CI by using
the Get Related Cls functionality.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > IT Universe Manager.
3. Onthe Search Cls tab, search fora UCMDB CI that has associated ticket(s) in Service

Manager. For example, enterbs1327232399 in the Cl Name field, click Search, and double-
click the Cl to openit.

Cl Selector Browse Views || Search Cls
B i 8 7o | s [ T
Searches: | x| [ @ Top Layer
Simple Advanced A ]
[
ClName: |bs1327232399 =X Q )]
ClType:  Managed Object; sen E bs] 327232399
Mame = Cl Type E
{_E‘ﬁ bs1327232399 Business Service -
9
PR

4. Click the Show Get Related Cls pane button |_Q*|
The Get Related Cls pane displays.
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Get Pelated Cls

o o llgll 2

Select scope: View (®) CMDEB

Fiter Pelated Clz by Cl Type

b % B

Tree View -

CELTT]

5. Click the Select target Integration Points for related Cls button @

6. Select the Select integration points option, and then select both UCMDB and your
integration point. Click OK.

() All integration points
() Local data source (UCMDE only)
(®) select integration poirts

% G

(5 autotest

O Ej Hiztory DataSource
Ej zm_irtegration

& ucmoe

155 ucMDBEDiscovery
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7. Click Show Related Cls. The ClI’s related SM tickets and UCMDB Cls display.

Retated Cls
e 8 7o | 03 B[ 2 5 [ % |2 % 0 0] 0 R
@ Top Layer
i @ ,@ <] Get Related Cls
@ . 9
Y Cannection PM10001 T 0005 | |
[o3 Tilalu}] Membeldhin Select scope: view @ CMDB
: hip 3
B Connection
: Membership Fiter Related Cls by Cl Type
= nection 0 By 05| (2] Tree View ~
¥ hs1337232389 ]
=1 il | [] e . 1
8. Select each SM ticket record from the query pane, and click the Properties button | =y to view

its details.
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The UCMDB-SM Integration supports a multi-tenancy configuration in which both the Service
Manager and UCMDB systems track Configuration Items (Cls) and Configuration Item
Relationships (CIRs) by company ID. In a multi-tenancy configuration, you can tailor the integration
so that each tenant only sees and works with the Cls and CIRs that match their company ID. Multi-
tenancy is intended for managed service providers (MSPs) who wish to offer Configuration
Management as a service to multiple tenants.

This chapter includes:

o "Multi-Tenancy (Multi-Company) Support" below

o "Multi-Tenancy Requirements" on page 67

¢ "Setting up the Multi-Tenancy Integration in UCMDB" on page 68

¢ "Setting up the Multi-Tenancy Integration in Service Manager" on page 71

Multi-Tenancy (Multi-Company) Support

Multi-tenancy is when a single instance of software runs on a server, serving multiple client
organizations (also referred to as tenants).

Multi-tenancy contrasted with a multi-instance architecture where separate software instances or
hardware systems are set up for different client organizations.

When implementing a multi-tenant architecture, a software application is designed to virtually
partition its data and configuration so that each client organization works with a customized virtual
application instance. The following figure illustrates an example multi-tenant integration
deployment.

UCMDB SM
Customer 1 |
Data Collector '
I
T
s (CTenantz_ )
Data Collector | Tenant 2 |
b Tenant 3 | —_Tenant3
|
Customer 3 | ¥ )
Data Collector
Automatic Tenant
Synchronization
Manual Tenant
Synchronization
Explanation

Every tenant configured in UCMDB works with the relevant tenant in SM. If UCMDB did not
configure tenants, the tenant configuration must be activated in order to transfer the configuration
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from SM to UCMDB automatically. This function is performed once only by the system
administrator.

In the event that UCMDB tenant configuration already exists and the SM configuration does not
exist, SM tenant must be manually configured according to the UCMDB configuration.

Implementing Multi-Tenancy in the UCMDB-SM
Integration

SM stores the company records that describe each tenant in the multi-tenant configuration. The
Service Manager system is the definitive source for company records and pushes all new company
IDs to the UCMDB system creating the equivalent entity in UCMDB.

SM tracks the company ID of each Cl and relationship in a multi-tenant configuration. Cl records
inherit the company ID of the UCMDB feeder that discovered them. Relationship records inherit the
company ID of the parent Cl in the relationship.

Mandanten SM Security Layer

Mandanten is an SM software layer that is used to filter the customer ID from the CI information.
SM uses the Mandanten to ensure that operators only see Cl and relationship records where the
Cl's company ID matches the operator's company ID. If the view is restricted with Mandanten,
then Service Manager also restricts the view to all other related records such as change requests
and incidents.

What Multi-Tenant Information is Stored in UCMDB

Your UCMDB system stores a company ID attribute for each Cl and CIR. The company 1D
determines what adapter and synchronization schedule your UCMDB system uses to update ClI
data. Each Cl and relationship record can only have one company ID. The UCMDB system obtains
a company ID from the Service Manager system.

If more than one tenant (company) shares the same Cl, each tenant has their own unique CI record
describing the ClI. In effect, the UCMDB system creates multiple Cl records to track one managed
asset. Each tenant’s Cl record is unique to that tenant and lists the company's unique company ID.

What Multi-Tenant Information is Stored in Service
Manager

Your Service Manager stores the company records that describe each tenant in the multi-tenant
configuration. The Service Manager system is the definitive source of company IDs and pushes
new and updated information to your UCMDB system.

Service Manager tracks the company ID of each Cl and relationship in a multi-tenant configuration.
Cl records inherit the company ID of the UCMDB feeder that discovered them. Relationship
records inherit the company ID of the parent Cl in the relationship.

In a best practices implementation, Service Manager uses Mandanten to ensure that operators only
see Cl and relationship records where the CI’'s company ID matches the operator's company ID. If
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you restrict the view with Mandanten, then Service Manager also restricts the view to all other
related records such as change requests and incidents.

Unique Logical Names

Service Manager requires that all Cls have unique logical names. If the logical name generation
process produces a duplicate logical name value, Service Manager appends an underscore and a
number to the end of logical name to make it unique. For example, if two Cls would have the logical
name mytesthost, then the second Cl will instead have the name mytesthost_1. A second

duplicate Cl would have the name mytesthost_2.

Synchronization of Company Records

If your system meets all the conditions for multi-tenancy support, Service Manager creates a
schedule record to push the company ID of the company record to your UCMDB system. Service
Manager uses the following rules to determine whether to push the company ID to your UCMDB
system.

Conditions where Service Manager synchronizes company ID with UCMDB

Conditions

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You create a new company record in Service
Manager

UCMDB-SM integration enabled

You update an existing company record that
has not been synchronized with UCMDB

Multi-company mode enabled in Service
Manager

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You disable the option to show a company in
multi-company lists on a company
synchronized with UCMDB

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Tenant
information
synchronized?

Yes

Yes

Yes

Schedule record created
and action taken in
ucmMbDB

Synch Company with
UCMDB - <UCMDB
Company ID>

¢ Add new company ID

Synch Company with
UCMDB - <UCMDB
Company ID>

¢ Add new company ID

Inactivate Company with
UCMDB - <UCMDB
Company ID>

¢ Inactivate existing
company ID
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Conditions where Service Manager synchronizes company ID with UCMDB, continued

Conditions

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You select the option to resynchronize with
UCMDB on an existing company record

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You enable the option to show a company in
multi-company lists for an inactivated
company

UCMDB-SM integration disabled

Multi-company mode enabled in Service
Manager

You update an existing company record that

has already been synchronized with UCMDB

UCMDB-SM integration disabled

Multi-company mode enabled in Service
Manager

You create a new company record in Service
Manager

UCMDB-SM integration enabled

Multi-company mode enabled in Service
Manager

You disable the option to show a company in
multi-company lists on a company not
synchronized with UCMDB

HP Universal CMDB (UCMDB 10.10, CP 13.00)
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Synch Company with
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o Reactivate company
ID

None

None

None
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Conditions where Service Manager synchronizes company ID with UCMDB, continued

Tenant Schedule record created
information and action taken in
Conditions synchronized? UCMDB
o UCMDB-SM integration enabled No None

¢ Multi-company mode disabled in Service
Manager

e You create a new company record in Service
Manager

UCMDB Customer ID

When you enable the multi-tenancy integration, Service Manager displays a new field in each
company record called UCMDB Customer ID. In order to synchronize a company record with
UCMDB, you must first provide a value for this field. After you provide a UCMDB Customer ID
value this field becomes read-only. You cannot change a company's UCMDB Customer ID after
you set it.

This field only accepts numeric data up to ten characters long. Service Manager requires the field
value to be a unique positive whole number. You cannot enter duplicate values or use decimals,
negative numbers, or zero.

Your UCMDB system automatically uses the UCMDB customer ID of 1 when running in single
tenant mode. You can reuse this default value in your multi-tenant implementation by assigning a
Service Manager company to have this UCMDB customer ID value. Out-of-the-box, no Service
Manager company has the UCMDB customer ID of 1.

UCMDB User ID and Password

When you enable the multi-tenancy integration, Service Manager displays two new fields in each
company record called UCMDB Userld and UCMDB Password. These fields allow you to specify
the connection information you want Service Manager to use when requesting information for the
Actual State section. Any user name and password you enter in these fields must be valid for your
UCMDB system.

The user name and password you provide in the Company Information record takes precedence
over the user name and password you provide in the System Information record. This allows
managed service providers to control access to the UCMDB system on a tenant-by-tenant basis. If
you do not provide a company-specific UCMDB user name and password, Service Manager uses
the credentials you provided in the System Information record.

Company Code

The multi-tenancy integration requires that each company record has a unique Company Code
(company field) value. Since Company Code is a required field, your existing company records
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should already have Company Code values. However you should ensure that each company record
has a unique Company Code value.

Caution: You should not change the Company Code value after you have enabled the multi-
tenancy integration because this will cause your Service Manager data to become out of
synch.

Cl Reconciliation Rules

When multi-tenancy is enabled, Service Manager only reconciles the Cls whose company ID
matches the company ID in the data push job. For example, when pushing Cls from company 2, the
reconciliation rules only apply to the Service Manager Cl records that have the company code
corresponding to company number 2.

Company Information Pushed to Cl and CI Relationship
Records

When you enable the multi-tenancy integration, Service Manager inserts the SM Company Code
value in Cl and relationship records during data push. Service Manager uses the UCMDB
Customer ID to look up the matching SM Company Code value.

Company Information Replicated to Incident Records

When you enable the multi-tenancy integration and select the option to create incidents when
UCMDB discovers new, updated, or deleted Cls, Service Manager inserts the SM Company Code
value in the incident record during replication. Service Manager uses the UCMDB Customer ID to
look up the matching SM Company Code value.

Schedule Records

Service Manager uses the problem schedule processor to manage the synchronization of company
IDs to your UCMDB system. You can manually enable the problem schedule processor from the
System Status form.

When the synchronization criteria are met as described in Table "Conditions where Service
Manager synchronizes company 1D with UCMDB" on page 62, Service Manager creates a “Synch
Company with UCMDB - <UCMDB Company ID>" schedule record (for example, “Synch
Company with UCMDB - 1234567890"). If you inactivate a company, Service Manager creates a
“Inactivate Company with UCMDB - <UCMDB Company ID>" schedule record (for example,
“Inactivate Company with UCMDB - 1234567890”). The problem schedule processor processes the
new schedule record on the next background process iteration.

If your Service Manager system cannot connect to your UCMDB system for some reason, it will
reschedule the company synchronization at the next scheduled interval (the out-box interval is 5
minutes). The problem schedule processor updates the schedule record with the status
rescheduled. If the Service Manager system receives any other error message while connecting to
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the UCMDB system, it updates the schedule record with the status “application failed due to error -
check msglog for possible messages.”

Tenant-Specific Discovery Event Manager (DEM)
Rules

You can implement the condition field function in order to create SM DEM rules that are specific to a
particular tenant in a multi-tenancy UCMDB-SM integration.

Tenant rules vary according to SM tenant configuration requirements, for each record information
type pushed from UCMDB to SM different tenants can configure different DEM tenant rules.

Each tenant can have its own set of unique requirements and therefore may implement different
processes via the integration.

One tenant may require the addition of Cls directly to SM while another tenant may require opening
changes for each ClI.

The following table shows a sample set of DEM rules that illustrate how to accomplish this.

Tenant-specific DEM rules

DEM rule ID Action on new CI Condition
ucmdbNode_advantage Add ClI company in $L file="advantage”
ucmdbNode _hp Create change company in $L.file="HP”

Note: DEM Rules

When creating DEM rules make sure to create separate DEM rules for each tenant.

Multi-Tenancy Functional Use Cases

The following table describes the necessary actions to perform in various deployment situations to
address multi-tenancy issues.

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 66 of 256



Universal Discovery Content Guide - Service Manager Integration
Multi-Tenancy (Multi-Company) Setup

Multi-tenancy use cases

Deployment

Integration

Type Description

UCMDB When implementing a UCMDB-SM deployment that has existing multi-tenancy
with multi- rules in UCMDB and does not have multi-tenancy rules configured in SM, the
tenancy user creates multi-tenancy rules in SM manually and according to the rules in
rules UCMDB.

SM without

multi-

tenancy

rules

SM with When implementing a UCMDB-SM deployment that has existing multi-tenancy
multi- rules in configured SM and does not have multi-tenancy rules configured in
tenancy UCMDB, the user creates multi-tenancy rules in UCMDB manually as well as
rules according to the rules previously configured in SM.

UCMDB

without

multi-

tenancy

rules

UCMDB When implementing a UCMDB-SM deployment that does not have multi-tenancy
without rules configured in UCMDB or in SM, the user configures the rules in SM.
multi-

During the configuration process using the SM multi-tenancy wizard the user can
create corresponding tenancy configuration in UCMDB. By creating
corresponding tenancy configurations in SM the user also creates a

SMwithout  corresponding tenant in UCMDB.

multi-

tenancy

rules

tenancy
rules

Multi-Tenancy Requirements

Your system must meet the following requirements in order for the integration to support multi-
tenancy.

e HP Universal CMDB version 8.02 or later system
o HP Service Manager version 9.20 or later system

Integration enabled between UCMDB and Service Manager

Multi-company mode enabled on the Service Manager system

« Problem schedule process running on the Service Manager system
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For additional information about the multi-tenancy integration, you can visit the HP Software
Support Online web site or refer to the Service Manager help.

Setting up the Multi-Tenancy Integration in
UCMDB

You need to perform the following tasks in UCMDB to set up the multi-tenancy integration.

1.

Install a separate data flow probe for each tenant the integration will support.
See "How to Install Separate Data Flow Probes for Each Tenant" below.

Start tenant-specific data flow probes.
See "How to Start Tenant-Specific Data Flow Probes" on page 70.

Configure IP address ranges for tenant-specific data flow probes.
See "How to Configure IP Ranges for Tenant-Specific Data Flow Probes" on page 70.

Configure multi-tenancy for population.
See "How to Configure Multi-Tenancy for Population" on page 70.

How to Install Separate Data Flow Probes for Each
Tenant

If you plan to support a multi-tenant configuration, you must install a separate data probe for each
tenant. Out-of-the-box, the UCMDB installer only installs one data flow probe and service.

To install additional data flow probes and start them from your operating system command prompt:

—_

Log in to the host of your UCMDB system as an administrator.

Insert the HP Universal CMDB Setup Windows DVD into the system disc drive.

Start the Data Flow Probe installer( HPUCMDB_DataFlowProbe_x.xx.exe).

Follow the on-screen instructions to complete the wizard, but use the following values for each
data flow probe you wish to install.

a.

b.

Type a unique path for each installation folder.

Use the same UCMDB application server address for each data flow probe.
Type a valid data flow probe address.

Type a unique name for each data flow probe identifier.

Create a unique customer Data Flow Probe domain for each probe (Clear the Use Default
CMDB Domain option).

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 68 of 256


http://support.openview.hp.com/

Universal Discovery Content Guide - Service Manager Integration
Multi-Tenancy (Multi-Company) Setup

f. Use the same probe gateway and probe manager settings for each probe (for example, use
combined or separate processes).

See the HP Universal CMDB Deployment Guide for complete installation instructions.

5. Repeat step 3 and step 4 for each data flow probe you wish to install.

6. Open the probe’s DiscoveryProbe.properties file in a text editor. By default, this file is
located in the following folder:

<UCMDB installation folder>\<data flow probe installation folder>\conf

For example, C: \hp\UCMDB\DataFlowProbe\conf.

Note: The <data flow probe installation folder> must be unique for each tenant.

7. Edit the following properties in the configuration file.
Discovery Probe properties set for each tenant

Property Value

serverName Verify the name of the UCMDB server

customerld Type the customer ID for the tenant this data flow
probe supports

appilog.collectors.probe.name Verify the probe name is unique such as server +
tenant ID

applilog.collectors.domain Verify the domain name of the data flow probe

appilog.collectors.local.ip Verify the data flow probe gateway name

appilog.collectors.probe.ip Verify the data flow probe manager name

appilog.collectors.rmi.port Type a unique port for each probe

appilog.collectors.rmi.gw.port Type a unique port for each probe

appilog.collectors.probe.html.port Type a unique port for each probe

appilog.collectors.local.html.port Type a unique port for each probe

appilog.collectors.ProbeUseSpecific  Type a unique port for each probe or type 0 to have

the system automatically select it
RMIPortFrom

appilog.collectors.bigBrother.port Type a unique port for each probe

8. Save the configuration file.

9. Repeat step 6 to step 8 for each tenant’s data flow probe.
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How to Start Tenant-Specific Data Flow Probes

To start tenant-specific data flow probes:

1. Open the OS command prompt and navigate to the probe’s bin folder. For example,
C:\hp\UCMDB\DataFlowProbel\bin.

2. Typegateway console.

3. Repeat step 1 to step 2 for each data flow probe you want to start.

How to Configure IP Ranges for Tenant-Specific
Data Flow Probes

To configure IP ranges for tenant-specific data flow probes:

1. Loginto UCMDB as an administrator using the company ID of the tenant whose data flow
probe you want to configure.

2. Navigate to Data Flow Management > Data Flow Probe Setup.

3. Expand the data flow probe domain containing the probe you want to start. For example,
Customer2.

4. Expand the Probe node and select the data flow probe you want to start. For example,
Probe2Customer2.

Comains and Probes Detailz

Q
= Data Flow Probes

. - Name IP Status Last Access time
2% |Domains and Probes

¥ Customer? Probe2Customer2 16178.178.173 Connected 06/ 62010 01:25:34 PM

_ -5 Credentials
43 Probes

L Probe2Customer2

5. Click the Add IP range button ¥ .

6. Type an IP range you want the Data Flow Probe to scan. Optionally, add any IP ranges you
want to exclude.

7. Click OK to save the IP range.

8. Repeat step 1 to step 7 for each data flow probe you want to configure.

How to Configure Multi-Tenancy for Population

To support multi-tenancy for population, you need to configure the basicQueryCondition setting for
each TQL defined in the population configuration file (smPopConfFile.xml).

To configure multi-tenancy for population:
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Log into UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

Click the smPopConfFile.xml file.

For each TQL defined in this file, update the basicQueryCondition setting by adding the
following:

and company= &quot;{customerId}&quot;

For example:

basicQueryCondition="type=&quot;bizservice&quot;and company= &quot;
{customerId}&quot;"

Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Setting up the Multi-Tenancy Integration in
Service Manager

You need to perform the following tasks in Service Manager to set up the multi-tenancy integration.

Multi-tenancy support is an optional feature of the integration intended for Managed Service
Providers (MSPs) who want to offer Configuration Management as a service to their tenants. In a
multi-tenancy configuration, each Cl and CIR record has a corresponding company I1D. Out-of-the-
box, Service Manager allows all operators to view Cl data regardless of the company ID. If you
wish to restrict access to Cl data by company ID, you must enable Mandanten and use the
company ID field as a restricting query. See the Service Manager help for more information about
multi-company mode and Mandanten.

You must complete the following tasks from your Service Manager system to enable multi-tenancy
support for the integration.

1.

Start the process schedule.
See "How to Start the Process Schedule" on the next page.

Configure the Service Manager System Information Record.
See "How to Configure the Service Manager System Information Record" on the next page.

Add tenant-specific UCMDB ID and password values to company records (optional).
See "How to Add Tenant-Specific UCMDB User ID and Password Values" on page 74.

Add UCMDB Customer ID values to existing company records.
See "How to Add UCMDB Customer ID values to Existing Companies" on page 74.
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5. Synchronize existing company records with UCMDB.
See "How to Synchronize Existing Companies from Service Manager to UCMDB" on page 75.

6. Verify that Service Manager synchronized company records with UCMDB (optional).
See "How to View Whether Company Information is in UCMDB" on page 76.

7. Resynchronize existing company records with UCMDB (as needed).
See "How to Resynchronize an Existing Company with UCMDB" on page 76.

8. Inactivate company records you do not want to be part of the integration (as needed).
See "How to Inactivate a Synchronized Company" on page 77.

9. Reactivate inactive company records you want to be part of the integration (as needed).
See "How to Reactivate an Inactive Company" on page 78

10. Add tenant-specific DEM rules.
See "How to Add Tenant-Specific DEM Rules" on page 78.

How to Start the Process Schedule

This integration needs the process schedule to synchronize company records from Service
Manager to UCMDB. You need to make sure it is started before synchronizing company records.

To start the process schedule:
1. Loginto Service Manager as a system administrator.

2. From the System Navigator, click System Status.
A list of the currently started schedules displays.

3. Click the Refresh Display button to refresh the list.

4. |f the problem schedule is not in the list, do the following:
a. Click the Start Scheduler button.

b. Double-click the process schedule.

A message displays that indicates the process schedule is started.

How to Configure the Service Manager System
Information Record

To enable the integration to support multi-tenancy, you must provide additional information in the
Service Manager System Information Record.

Caution: In order to enable multi-tenancy support, you must use HP Universal CMDB version
8.02 or greater. Earlier versions of HP Universal CMDB will produce an error message if you
attempt to run them in multi-tenancy mode.
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To provide additional information in the Service Manager System Information Record:

1.

2.

10.

1.

12.

13.

14.

15.

16.

Log in to Service Manager as a system administrator.

Navigate to System Administration > Base System Configuration > Miscellaneous >
System Information Record.

Click the General tab.
Enable the Run in Multi-Company Mode option.
Click the Active Integrations tab.

Select the HP Universal CMDB option.
The form displays the UCMDB web service URL field.

In the UCMDB web service URL field, type the URL to the synchronize Cls web service API.
The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/ucmdbSMService

Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

In Userld and Password, type the user credentials required to manage Cls on the UCMDB
system. For example, the out-of-the-box administrator credentials are admin/admin.

In the Multi-tenant web service URL field, type the URL to the synchronize company IDs web
service API. The URL has the following format:

http://<UCMDB server name>:<port>/axis2/services/UcmdbManagementService

Replace <UCMDB server name> with the host name of your UCMDB server, and replace
<port> with the communications port your UCMDB server uses.

Type the user name and password required to synchronize company IDs on the UCMDB
system. For example, the out-of-the-box system administrator credentials for UCMDB 9.x are
sysadmin/sysadmin.

Click Save. Service Manager displays the message: Information record updated.
Log out of the Service Manager system, and log in again with an administrator account.
Click System Status > Display Options > All Tasks.

Type k in the Command field next to the problem schedule process and click Execute
Commands. Wait a few minutes for the problem schedule process to close.

Click Start Scheduler.

Double-click the problem schedule process. The system now supports multi-tenancy for
UCMDB.
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How to Add Tenant-Specific UCMDB User ID and
Password Values

You can provide a tenant-specific UCMDB user name and password for Service Manager to use
when requesting information for the Actual State section. If you provide no credentials, Service
Manager uses the credentials in the System Information Record for all tenants.

Note: Any credentials you provide in the company record take precedence over credentials
you provide in the System Information Record. The UCMDB Userld and UCMDB Password
fields are available only when you have enabled the multi-tenancy integration.

To add tenant-specific UCMDB user name and password:
1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Type the user name you want this company to use to connect to UCMDB in the UCMDB
Userld field.

6. Type the password for the UCMDB user name in the UCMDB Password field.
7. Click Save.

8. Repeat step 3 through step 7 for each company you want to provide credentials for.

How to Add UCMDB Customer ID values to Existing
Companies

You can use the following steps to add a UCMDB Customer ID value to your existing Service
Manager company records.

1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Type a numeric value in the UCMDB Customer ID field for this company.
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8.

9.

Click Save.

Service Manager prompts to confirm that you want to synchronize the record with UCMDB.
Click Yes if you want to synchronize the company now, or click No if you want synchronize
the company later.

Click Next to go to the next company in the record list.

Repeat step 5 through step 8 for each company in the record list.

How to Synchronize Existing Companies from
Service Manager to UCMDB

Your Service Manager system may already contain company records that you want to use with the
multi-tenancy integration.

If you update any field in a company record that has not yet been synchronized to UCMDB, Service
Manager prompts whether you want to synchronize the company to UCMDB.

Note: Service Manager will not prompt you to synchronize the company record if you have
disabled the option to show the company in multi-company lists, or if there is a pending
schedule record associated with the company. See "How to Inactivate a Synchronized
Company" on page 77 for more information.

This task includes the following steps:

1.

2.

Log in to Service Manager as a system administrator.
Navigate to System Administration > Base System Configuration > Companies.

Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

Click Search.
Select a company record to update.
Update the company record.

Click Save. Service Manager prompts to confirm that you want to synchronize the record with
UCMDB.

Note: Service Manager saves the company record regardless of your synchronization
choice.
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How to View Whether Company Information is in
UCMDB

When you enable the multi-tenancy integration, Service Manager displays a read-only field in each
company record that lists whether the UCMDB Customer ID has been synchronized with your
UCMDB system.

Note: The UCMDB Customer ID field is visible only when you enable the multi-tenant
UCMDB integration.

To view whether company information is in UCMDB:
1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Review the status of the Synched with UCMDB field.
If the check box is checked, then Service Manager has already synchronized the company ID
with your UCMDB system. If the check box is unchecked, then Service Manager has yet to
add this company to your UCMDB system.

Note: For more information about synchronization failures, see "Schedule Records" on
page 65.

How to Resynchronize an Existing Company with
UCMDB

Service Manager provides you a means to resynchronize company records with your UCMDB
system in case you lose UCMDB data for some reason. For example, you might intentionally
remove UCMDB data during integration testing, or you might need to recover data after a disaster.
You can force Service Manager to synchronize companies with your UCMDB system with the Re-
synch with UCMDB option.

To resynchronize an existing company with UCMDB:
1. Loginto Service Manager as a system administrator.

2. Navigate to System Administration > Base System Configuration > Companies.

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 76 of 256



Universal Discovery Content Guide - Service Manager Integration
Multi-Tenancy (Multi-Company) Setup

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to synchronize.

6. Click the Re-synch button next to the Synched with UCMDB? check box.

Note:

The Re-synch button is available only from company records that have already been
synchronized with UCMDB and have the Synched with UCMDB check box checked.
If your UCMDB system already has a company with this ID value, it will ignore the
resynchronization request. Service Manager will also ignore a resynchronization request if
there is an existing schedule record to resynchronize the company with UCMDB. In this

case, it displays the message “A schedule record has already been added to re-
synch this company with UCMDB”.

How to Inactivate a Synchronized Company

After you have synchronized a company record with UCMDB you can no longer delete the record.
Instead, you can inactivate a company record, which causes the UCMDB system to cease all
further Cl updates for the company. Any existing Cl data for the company remains in the UCMDB
system associated with the inactive UCMDB Customer ID, but both the company and any
associated Cls will no longer be visible from the UCMDB system.

Toinactivate a synchronized company:
1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select acompany record to inactivate.

6. Select No from Show Company in Multi-Company Lists.
7. Click Save.

8. If this company was previously synchronized with UCMDB, Service Manager prompts you to
confirm the inactivation.

9. Click Yes to confirm the inactivation or No to cancel your changes.
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How to Reactivate an Inactive Company

You can reactivate any inactive companies on your Service Manager system to include them in the
multi-tenancy integration. You must also synchronize the company with UCMDB for UCMDB to
process any Cl updates for this company.

To reactivate an inactive company:
1. Loginto Service Manager as a system administrator.
2. Navigate to System Administration > Base System Configuration > Companies.

3. Type the search criteria you want to use to find company records. For example, leave the
search form blank to search all company records.

4. Click Search.

5. Select a company record to reactivate.

6. Select Yes from Show Company in Multi-Company Lists.

7. Click Save. Service Manager prompts you to reactivate the company with UCMDB.

8. Click Yes. Service Manager creates a schedule record to reactivate the company.

How to Add Tenant-Specific DEM Rules

You can use the condition field to create DEM rules that are specific to a particular tenant in a multi-
tenancy UCMDB-SM integration. For example, one tenant may want to add Cls directly to Service
Manager while another tenant may want to open changes for each Cl. The following sample DEM
rules illustrate how to accomplish this.

Tenant-specific DEM rules

DEM rule Id Action on new ClI Condition
ucmdbNode_advantage Add CI company in $L.file="advantage”
ucmdbNode _hp Create change company in $L.file="HP”

Tip: It is a best practice to create a separate DEM rule for each tenant.
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This chapter includes:
+ "UCMDB-SM Configuration Best Practices" below
o "Frequently Asked Questions" on page 93

e "Known Issues and Limitations" on page 106

UCMDB-SM Configuration Best Practices

This section provides best practices and recommendations for successfully implementing this
integration in various environments. This section provides you with valuable understandings and
techniques that will enhance the UCMDB-SM integration as well as solve common problems by
providing solutions and workarounds to these issues. These practices and recommendations may
vary slightly according to each implementation, as the specific system requirements and settings
alter per system environment.

This section includes:

o "Cl Name Mapping Considerations" below

o "Bi-Directional Data Synchronization Recommendations" on page 81
e "Push Scheduling Recommendations" on page 82

e "Pushin Clustered Environments" on page 84

« "Initial Load Configurations" on page 86

¢ "How to Configure Differential/Delta Load DEM Rules" on page 90

o "Fault Detection and Recovery for Push" on page 91

o "How to Enable Lightweight Single Sign-On (LW-SSO) Configuration" on page 93

Cl Name Mapping Considerations

UCMDB allows duplicate Cl names while Service Manager requires unique logical names. Before
pushing UCMDB Cls, you need to define a correct CI name mapping for them. For example, many
UCMDB Cls (such as Cls of the Running Software, CRG, Switch, or Router type) have the same
display label.

To prevent duplicate Cl names from occurring in Service Manager when pushing UCMDB Cls, the
following mappings are provided out-of-the-box:

CRG mapping

Out-of-the-box, UCMDB CRG records are mapped to Service Manager as follows:
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o If aCluster exists fora CRG, the CRG is mapped to this Cl logical name: <Cluster display
label>_<CRG display label>;

o Ifthe CRG does not have a Cluster, but has several IP addresses, the CRG is mapped to the
following (where the IP addresses are sorted alphabetically):
<IpAddress1>_..._<IpAddressN>.<authoritativeDnsName>_<CRG display label> (when

IpAddress.authoritativeDnsName exists)

<IpAddress1>_..._<IpAddressN>_<CRG display label> (when
IpAddress.authoritativeDnsName does not exist)

o If neither a Cluster nor an IP address exists for the CRG, it is mapped directly to <CRG display
label>.

Running Software mapping

Running Software Cls are prefixed with their root container node display label when mapped to a
Service Manager Cl: <Node display label>_<Running Software display label>.

Switch & Router mapping

Switch or Router type Cl records in UCMDB are prefixed with their MAC adresses when mapped to
a Service Manager Cl: <MACAddress1>_... <MACAddressN>_<Switch or Router display label>,
where the MAC addresses are sorted alphabetically.

CRG mapping
Out-of-the-box, UCMDB CRG records are mapped to Service Manager as follows:

o If aCluster exists fora CRG, the CRG is mapped to this Cl logical name: <Cluster display
label>_<CRG display label>;

o |fthe CRG does not have a Cluster, but has several IP addresses, the CRG is mapped to the
following (where the IP addresses are sorted alphabetically):
<IpAddress1>_... <IpAddressN>.<authoritativeDnsName>_<CRG display label> (when
IpAddress.authoritativeDnsName exists)

<IpAddress1>_..._<IpAddressN>_<CRG display label> (when
IpAddress.authoritativeDnsName does not exist)

o If neither a Cluster nor an IP address exists for the CRG, it is mapped directly to <CRG display
label>.

Running Software mapping

Running Software Cls are prefixed with their root container node display label when mapped to a
Service Manager Cl: <Node display label>_<Running Software display label>.
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Switch & Router mapping

Switch or Router type Cl records in UCMDB are prefixed with their MAC adresses when mapped to
a Service Manager Cl: <MACAddress1>_... <MACAddressN>_<Switch or Router display label>,
where the MAC addresses are sorted alphabetically.

Bi-Directional Data Synchronization
Recommendations

The UCMDB-SM integration supports bi-directional data synchronization between UCMDB and
Service Manager (SM). HP recommends that you follow the following best practices to avoid
unnecessary problems due to improper use of the data push and population features:

o For Cls/Cl Relationships that UCMDB can automatically discover, use UCMDB as the data
source. Do not make changes to them in Service Manager, instead always let UCMDB discover
their changes and push the changes to SM.

o For Cls/Cl Relationships that UCMDB cannot automatically discover, use SM as the data
source. Do not make changes to them in UCMDB, instead always make changes to them in SM
and populate the changes to UCMDB.

o For Cls/Cl Relationships that are already created in SM and UCMDB can automatically
discover, run a one-time population to synchronize them to UCMDB, and then use UCMDB as
their data source.

Caution: Problems like the following may occur if you do not follow these best practices:
Problem 1:

[Population Adapter] After Cls/Cl Relationships are pushed from UCMDB, if you directly make
changes in SM to these records without ever populating them back to UCMDB first, the
changes cannot be populated to UCMDB.

Workaround:

Changing these UCMDB records in SM is not recommended; however if you need to do so you
can do the following to solve this issue: After the records are pushed to SM, populate them
back to UCMDB first before making any changes to them in SM. This way the changes can
then be populated to UCMDB.

Problem 2:

[Population Adapter] After a Composition relationship between a Node ClI (node 1) and
Running Software Cl is pushed to SM, if you change the upstream CI of the relationship from
node 1 to node 2 and then run a change population to populate this change, the Running
Software Cl will be removed in UCMDB.

Workaround:
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It is recommended that you remove the running software in UCMDB and create a new one
instead of directly replacing the container of the running software in SM. If you cannot avoid
doing so, do the following:

After you change the upstream CI of the relationship from node 1 to node 2, do not directly run
the change population. Follow these steps to avoid this issue:

1. Update the Running Software Cl in SM (or simply save it to mark it as updated).

2. RunaRunning Software Cl change population. This will create node 2 (if it does not
already exist in UCMDB) and a new Composition relationship between node 2 and this
Running Software ClI.

3. Run a change population to synchronize the relationship change to UCMDB. The
relationship between node 1 and the Running Software Cl| will be removed, and the new
relationship created in step 2 will remain.

If you have run the change population after changing the upstream CI of the relationship from
node 1 to node 2, and as a result the Running Software Cl has been removed in UCMDB,
follow these steps to solve this issue:

1. Update the Running Software Cl in SM (or simply save it to mark it as updated).

2. Run aRunning Software Cl change population. This will create the Running Software Cl,
node 2 (if it does not already exist in UCMDB) and a new Composition relationship
between node 2 and this Running Software CI.

Push Scheduling Recommendations

Push jobs are run using two main methods, the first method is by manually executing the push job
and the second is by scheduling the push job.

All push jobs can potentially produce a strain on the UCMDB and SM systems therefore; HP
recommends that you adhere to the following guidelines:

Scheduler time frames

It is important for you to understand the function of the Scheduler “time frame” concept. Running
push jobs creates an increase in system activity and may affect application responsiveness. In
order to enable users to effectively interact with applications HP recommends the following
guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at a minimum.
Scheduler frequency

It is important to be aware of the business requirements when configuring the schedule frequency.
The scheduler frequency depends on infrastructure environment changes that must be
synchronized between UCMDB and SM.
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Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that
are prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies

UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is
considered a separate task and users cannot define job dependencies. For example, that one job is
dependent on another or upon completion before the next job is run.

It is important that both Cl TQLs and their dependent Relationship TQLs exist in the same Job in
order to avoid relationships not being pushed to Service Manager. UCMDB always pushes the ClI
TQLs before their dependent Relationship TQLs.

Note: Suffix usage

The out-of-the-box job for Cl push uses queries that end with the “Push” suffix, for example,
“SM Computer Push”.

Queries that create relationships between the Cls uses an extra “Relations” suffix, for
example, “SM Node Relations Push”.

Scheduler time frames

It is important for you to understand the function of the Scheduler “time frame” concept. Running
push jobs creates an increase in system activity and may affect application responsiveness. In
order to enable users to effectively interact with applications HP recommends the following
guidelines:

In order to reduce system strain, schedule the UCMDB to SM push to run at non-peak usage hours,
preferably when system usage is at a minimum.

Scheduler frequency

It is important to be aware of the business requirements when configuring the schedule frequency.
The scheduler frequency depends on infrastructure environment changes that must be
synchronized between UCMDB and SM.

Define the scheduling frequency based on the business requirements for consuming up-to-date CI
information. Most implementations require a daily update. When scheduling small IT systems that
are prone to frequent changes, the scheduling frequency may need to be increased.

Push Job dependencies

UCMDB Push Jobs do not support dependencies between each other. Each “Push Job” is
considered a separate task and users cannot define job dependencies. For example, that one job is
dependent on another or upon completion before the next job is run.
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It is important that both Cl TQLs and their dependent Relationship TQLs exist in the same Job in
order to avoid relationships not being pushed to Service Manager. UCMDB always pushes the ClI
TQLs before their dependent Relationship TQLs.

Note: Suffix usage

The out-of-the-box job for Cl push uses queries that end with the “Push” suffix, for example,
“SM Computer Push”.

Queries that create relationships between the Cls uses an extra “Relations” suffix, for
example, “SM Node Relations Push”.

Push in Clustered Environments

A clustered SM environment is comprised of multiple servlets running in parallel with a load
balancer that dispatches user requests to any available servlet. You must configure the UCMDB-
SM integration to point to a specific servlet and not to the SM loadBalancer. In order to perform this,
you must first create a dedicated web service listener.

This section includes:
o "Dedicated Web Services" below
o "Step-by-Step Cluster Configuration Process" below

o "Connecting to Multiple SM Processes" on page 86

Dedicated Web Services

A Service Manager system configured for vertical or horizontal scaling uses a load balancer to
redirect client connection requests to an available SM process. However, most Web Services

clients cannot handle a redirect request and will fail if they use the SM load balancer as the endpoint
URL.

HP recommends creating one or more SM processes dedicated to Web Services requests. The
user must configure the relevant external web service clients to connect directly to the dedicated
Service Manager processes.

Step-by-Step Cluster Configuration Process

How to Configure Web Clients

To configure the relevant external web clients:
1. Stop the Service Manager service.
2. Openthe sm.cfgfile, and create a dedicated SM process to listen for Web Services requests

using the -debugnode parameter.
The following entries create a dedicated process listening on ports 13085 and 13445.
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01 sm -httpPort:13080 -loadbalancer

02 sm -httpPort:13081 -httpsPort:13443

03 sm -httpPort:13083 -httpsPort:13444

04 sm -httpPort:13085 -httpsPort:13445 -debugnode

Explanation

The code excerpt illustrates the various settings for each of the SM process listeners (web
services) that enable SM clients to connect to the SM service.

Line 01 defines the load balancer port (13080).

Lines 02 and 03 define the SM ports to which non-dedicated SM clients are redirected by the
SM load balancer.

Line 04 defines the debugnode port that is utilized by the dedicated SM clients.

Note: Debugnode parameter

The debugnode parameter tells the SM load balancer not to forward any client connection
requests to this Service Manager process. Only clients that directly connect to the process can
access this port.

How to Configure the Debugnode

To configure the debugnode:
1. Start the SM service.

2. Configure any external web service clients to connect directly to the SM processes running in
debugnode. When performing an integration using UCMDB, the UCMDBService Manager
Adapter for SM should be configured to connect to the debugnode port.

For example, for normal connections set the endpoint URL to:
http://<fully qualified host name>:13085/SM/7/<Service Name>
and for SSL-encrypted connections set the URL to:

https://<fully qualified host name>:13445/SM/7/<Service Name>.

These clients may include UCMDB (for push purposes), Connect-It and additional
applications.
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Connecting to Multiple SM Processes

If you want to have better performance, you can connect to multiple Service Manager processes.
The integration supports in both Service Manager vertical or horizontal load balancer environment.

You can create more than one SM processes dedicated to Web Services requests, and configure
the field URL Override of integration point with the dedicated SM processes. This field value (if any)
overrides the Hostname/IP and Port settings.

The following is an example value of this field, which connects two SM processes:

http://<fully qualified host namel>:13080/SM/7/ws;http://<fully qualified host
name2>:13082/SM/7/ws

Initial Load Configurations

Before the configuration process can begin, you must first assess the amount of Cl and
relationships data is to be transferred from UCMDB to SM and ascertain the iteration process that
is required based on the volume.

You must first assess whether all of the data can be pushed in a single iteration. This is ascertained

by the amount of data that is included in the push queries and the amount of time you have to push
this data.

This section includes:

e "Push Performance in a Single-Threaded Environment" below

o "Implementing Multi-Threading" on the next page

e "Push Performance in Multi-Threaded Environments" on page 88

e "Push Performance in Multiple SM Processes Environments" on page 89

o "How to set up SM DEM Rules for Initial Loads" on page 89

Note: The performance data presented in this document is based on tests that were performed
at HP and is provided for reference only. The integration performance may significantly differ in
your environment depending on your hardware configuration.

Push Performance in a Single-Threaded Environment

The Push of 22,500 UCMDB root Cls (roots in TQLs) and/or Relationships in a single-threaded
environment takes about an hour and is performed in a linear fashion. See the following table:
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Performance data in a single-threaded environment

Number of root Cls/Cl Relationships pushed
per hour Multi-threading settings in sm.properties

22,500 number.of.concurent.sending.threads=1
min.objects.for.concurent.sending=50
number.of.chunks.per.thread=3

To view or edit the sm.properties file in UCMDB, navigate to Data Flow Management > Adapter
Management > ServiceManagerAdapter9-x > Configuration Files > sm.properties.

Number of Root Cls and Relationships/22,500

The push time (in hours) in any given environment is calculated as follows:

If the push of a single planned query has the potential of breaching the permitted time frame the data
must be divided into several queries. Each query must be pushed individually.

This query division is performed by creating several queries, each with different node conditions
that enable data filtering. Once all queries are pushed for the first time, the Initial Load process is
complete.

Note: Applying node conditions

When applying node conditions to the various SM Sync Queries, you must make sure that all
of the information is included in the queries, so that all relevant data is copied to SM.

Implementing Multi-Threading

In order to improve performance, the Service Manager Adapter utilizes multiple threads for the push
of Cl and Relationship data to SM. The following section explains these settings and how to
configure them for maximum performance.

The multi-threading configuration is defined in the sm.properties file on the UCMDB server. To view
or edit the file in UCMDB, navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files > sm.properties.

The following are example multi-threading definitions in the sm.properties file:
01 number.ocf.concurent.sending.threads=6
02 min.objects.for.concurent.sending=50

03 number.of.chunks.per.thread=3

Explanation

The code excerpt illustrates the relevant multi threading settings on the UCMDB server.

o Line 01 defines the number of parallel threads UCMDB will open to SM for Cl push. Setting this
parameter to 1 disables multi-threading, while a values of 2 or higher enables multi-threading.
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o Line 02 defines the minimum number of SM objects needed to use multiple threads as opposed
to a single thread.

o Line 03 defines the number of chunks per thread. This number multiplied by the number of
threads gives you the total number of Cl data chunks.

e The total number of chunks = number.of.chunks.per.thread *
number.of.concurent.sending.threads

The integration implements a queue mechanism as follows:

The data passed from UCMDB to SM is divided into equal chunks, and these chunks are placed in
aqueue.

Each available thread pulls the next chunk from the queue until all threads are available. Once this
process has completed, the push is complete.

The mechanism is designed to minimize idle time of each thread. As each thread processes its
chunk in parallel, some threads may finish before others and it is inefficient for them to wait for each
other.

Caution: Defining too many threads

It is ineffective to over-increase the number of threads as this causes the SM server to
overload. In enterprise environments where the SM server processing the push data is very
robust the number of threads can be increased to 10 and in some cases even 20; however, you
must take into account that increasing the number of threads raises CPU usage on the SM
server during push, which may reduce application performance.

Push Performance in Multi-Threaded Environments

The push of 60,000 UCMDB root Cls (roots in TQLs) and/or Relationships in an out-of-the-box
multi-threaded environment takes about an hour and is performed in a linear fashion. See the
following table:

Performance data in an out-of-the-box multi-threaded environment

Number of root Cls/Relationships pushed Multi-threading settings in sm.properties
per hour (default)

60,000 number.of.concurent.sending.threads=6
min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

The push time (in hours) in any given environment is calculated as follows:

Number of Root Cls and Relationships/60,000
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Push Performance in Multiple SM Processes
Environments
The Push of 190,000 UCMDB root Cls (roots in TQLs) and/or Relationships in a multi-threaded

environment with multiple SM processes takes about an hour and is performed in a linear fashion.
See the following table:

Performance data in a multiple SM processes environment

Number of root

Cls/Relationships Multi-threading settings in sm.properties

pushed per hour SM processes (default)

190,000 2 server hosts, with | number.of.concurent.sending.threads=90
each host running 3 . . c .
processes min.objects.for.concurent.sending=50

number.of.chunks.per.thread=3

For more information about defining multiple SM processes for the integration, see "How to Create
an Integration Point in UCMDB" on page 29.

The push time (in hours) in any given environment is calculated as follows:

Number of Root Cls and Relationships/190,000

How to set up SM DEM Rules for Initial Loads

SM Discovered Event Manager Rules (DEM Rules) enable the user to define the appropriate action
to take for each event type that is reported to SM.

Each Cl and relationship record pushed from UCMDB to SM is analyzed against the existing SM
records and open Change requests. SM rules define the appropriate action to be taken for each type
of Cl data update sent to SM.

To view or update the SM Discovered Event Manager Rules:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.
3. Press ENTER or click the Search button.
A list of all the Discovered Event Manager Rules displays. Each rule is usually linked to a Cl
Type or a subset of Cls of the same type.

4. Click on the individual Cl Discovered Event Manager Rule to view its details.

To set up DEM Rules for initial loads:

Tip: When performing “Initial Loads”, HP recommends setting the SM Discovered Event
Manager Rules to add newly reported Cls as described below. This minimizes the “noise” of an
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Initial Load, that could potentially create tens of thousands of Changes/Incidents.

For each of the Discovered Event Manager Rules, perform the following steps:

1.

2.

Select the relevant Discovered Event Manager Rule.
Go to the “Action if matching record does not exist” section, select the Add the record option.

In the “Action if record does not exist but unexpected data discovered” section, select the Log
Results and Update Record option.

In the “Action if record is to be deleted” section, select the Delete Record option.

Save the Discovered Event Manager Rule record.

How to Configure Differential/Delta Load DEM Rules

Tip: Once the “Initial Load” or “Data Load” of the Cl data is completed, HP recommends
applying Differential/Delta Load settings. These settings apply to all data loaded from UCMDB
to SM.

These loads send only updates regarding modifications discovered in the IT infrastructure from
UCMDB to SM.

To set up the SM DEM Rules for Differential/Delta Loads:

1.

2.

Log in to Service Manager as a system administrator.
Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

Press Enter or click the Search button.
A list of all the Discovered Event Manager Rules in SM displays.

For each of the Discovered Event Manager Rules, perform the following steps:
a. Select the relevant Discovered Event Manager Rule.

b. Inthe “Action if matching record does not exist” section, select the appropriate action
required for each newly detected CI. If uncertain, select the Add the record option.

c. Inthe “Action if record does exist but unexpected data discovered” section, select the
appropriate action for each Cl that was modified, resulting in an unexpected or incorrect
result. The recommended best practice is to select the Open a Change option.

d. Inthe “Action if record is to be deleted” section, select the appropriate action required for
each CI that was removed/deleted. The recommended best practice is to select the Delete
Record option for Cl Relationship, and select the Update record to the selected status
option for ClI.

e. Save the Discovered Event Manager Rule record.
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Fault Detection and Recovery for Push

Universal CMDB provides a fault detection and recovery mechanism since version 9.05; individual
Cl failures no longer cause the entire push to fail, and you can review all failed Cls in the Universal
CMDB studio and then re-push them.

Duplicated logical.name issue

A typical fault you may encounter is the duplicated logical name issue because of the different
unique key fields used in Universal CMDB and Service Manager: Cl logical.name in Service
Manager is unique, and it usually maps to Cl display label in Universal CMDB (which is not unique).
HP recommends that you follow the following guidelines (listed from highest to lowest priority) to
resolve this issue:

o Make sure that each display label field value in UCMDB is unique;

o If uncertain of the above, in the adapter mapping configuration (XSLT file) avoid direct mapping
between Universal CMDB display label and SM logical name.

e Map SM logical name to another Universal CMDB field that is unique;

o Add a prefix or suffix to UCMDB display label value;

Note: Out-of-the-box, the SM logical name of Running Software is mapped with a prefix of
DNS name:

<xsl:variable name="fullDNSName" select="nodes/node/@primary_dns_name"/>

<xsl:for-each select="@display_ label">
<CIIdentifier><xsl:value-of select="$fullDNSName"/>_

<xsl:value-of select="."/>

</CIIdentifier>

</xsl:for-each>

¢ If you cannot do any of the above, you can use the UCMDB Fault Detection and Recovery
mechanism together with the “Duplication Rule” setting of DEM rules (see the following).

To set up DEM Rules for duplicated logical names:
1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules > Duplication
Rule tab.

3. Foreach of the Discovered Event Manager Rules, perform the following steps:
a. Gotothe “Action if logical name is duplicated” section, and select the Return Error option.

b. Save the Discovered Event Manager Rule record.
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Note: After you run a push job, Cls with a duplicated logical name are reported as failed
Cls with a duplicated name exception. You can review the failed Cls in the Universal
CMDB studio, fix the errors by either changing the data in Universal CMDB or in the
adapter mapping configuration file (XSLT), and then re-push the failed Cls.

Duplicated logical.name issue

A typical fault you may encounter is the duplicated logical name issue because of the different
unique key fields used in Universal CMDB and Service Manager: Cl logical.name in Service
Manager is unique, and it usually maps to Cl display label in Universal CMDB (which is not unique).
HP recommends that you follow the following guidelines (listed from highest to lowest priority) to
resolve this issue:

o Make sure that each display label field value in UCMDB is unique;

o If uncertain of the above, in the adapter mapping configuration (XSLT file) avoid direct mapping
between Universal CMDB display label and SM logical name.

« Map SM logical name to another Universal CMDB field that is unique;

o Add a prefix or suffix to UCMDB display label value;

Note: Out-of-the-box, the SM logical name of Running Software is mapped with a prefix of
DNS name:
<xsl:variable name="fullDNSName" select="nodes/node/@primary_dns_name"/>

<xsl:for-each select="@display label">
<CIIdentifier><xsl:value-of select="$fullDNSName"/> <xsl:value-of
select="."/>
</CIIdentifier>
</xsl:for-each>

o If you cannot do any of the above, you can use the UCMDB Fault Detection and Recovery
mechanism together with the “Duplication Rule” setting of DEM rules (see the following).

Set up DEM Rules for duplicated logical names:
1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules > Duplication
Rule tab.

3. Foreach of the Discovered Event Manager Rules, perform the following steps:
a. Gotothe “Action if logical name is duplicated” section, and select the Return Error option.

b. Save the Discovered Event Manager Rule record.
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Note: After you run a push job, Cls with a duplicated logical name are reported as failed
Cls with a duplicated name exception. You can review the failed Cls in the Universal
CMDB studio, fix the errors by either changing the data in Universal CMDB or in the
adapter mapping configuration file (XSLT), and then re-push the failed Cls.

How to Enable Lightweight Single Sign-On (LW-
SSO) Configuration

You can enable LW-SSO for the integration so that users can directly view UCMDB CI records
from the Service Manager web client by clicking the View in UCMDB button, without providing a
UCMDB usermname and password.

Note: LW-SSO is not supported for the Service Manager Windows client.

To enable LW-SSO for the integration:

1. Foreach Service Manager user account that needs LW-SSO, create a user account in
UCMDB with the same username. The passwords in the two systems can be different.

2. Enable LW-SSO in the Service Manager Web tier. For details, see the Configure LW-SSQO in
the Service Manager Web tier topic in the Service Manager help.

3. Enable LW-SSO in UCMDB. For details, see the HP Universal CMDB Deployment Guide.

Frequently Asked Questions

This section provides answers to frequently asked questions about the UCMDB-SM integration.

This section includes:

e "Whenis a New CIl Created in HP Service Manager " on the next page

e "Canl Analyze the Reason for a Cl Deletion in SM" on the next page

o "How do | Monitor Relationship Changes Between UCMDB and SM" on page 95
o What Kinds of Relationships are Pushed from UCMDB to SM

e "Whatis a Root Cl Node" on page 96

o "What is a Root Relationship" on page 96

o "What is the “friendly Type” Specified in an XSLT File" on page 96
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e "What is the “Virtual-Compound” Relationship Type Used ina UCMDB-SM Integration Query"
on page 96

e "When do | Need the Population Feature" on page 96

¢ "Can | Populate Physically Deleted Cls from SM to UCMDB" on page 97

o "How do | Keep the Outage Dependency Setting of a Cl Relationship in SM" on page 97
o "How do | Create an XSL Transformation File" on page 99

e "How do | Use the Load Fields Button to Add Multiple Managed Fields" on page 104

o "What is the Purpose of the <container> Element in a Population XSLT File" on page 105
e "Can | Populate Sub-ltem Deletions" on page 106

o "What will Happen if a Population Job Fails or Succeeds with Warnings" on page 106

When is a New Cl Created in HP Service Manager

Cls are created in SM under the following circumstances:
¢ A Clis manually added to SM via the “Configuration Management” module.

 UCMDB reports a newly discovered Cl according to the following:
= When a new Cl is reported and the “Discovered Event Manager Rules” are set to “Add the
Record”.

= When a new Cl is reported, the “Discovered Event Manager Rules” are set to “Open an
Incident” and the Incident has been closed.

= When a new Cl is reported, the “Discovered Event Manager Rules” are set to “Open a
Change” and the Change has been verified.

Can | Analyze the Reason for a Cl Deletion in SM

No.

SM opens a change request on the deleted Cl and includes the following information:
“Delete event for Cl “Cl Name” triggered by discovery”.

Workaround

An SM change request does not contain a description of the reason for deletion, however it is
possible to extract specific information about CI deletions from the UCMDB “History Database”.
UCMDB data provides information about the user or the discovery pattern that initiated the Cl
deletion.

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 94 of 256



Universal Discovery Content Guide - Service Manager Integration
Standards and Best Practices

How do | Monitor Relationship Changes Between
UCMDB and SM

To understand the relationship change in SM, a distinction must be made between the various
types of Relationship Changes:

o The second endpoint of the relationship has Changed, so instead of Cl X being linked to Cl Y via
a relationship, now Cl X is related to Cl Z.

o An attribute of a relationship has changed.

The first type of Relationship change is supported by the UCMDB-SM integration, therefore, such
“Relationship Changes” can either invoke Cl relationship updates, or perform the creation of
Incidents or Changes, which are then reviewed and monitored.

The second is also supported, but it is not covered out-of-the-box; you can configure the Universal
CMDB TQL to expose such attributes of relationship, and configure the Service Manager WSDL to
expose the mapped field, and then configure the adapter mapping configuration in the XSLT.
However such “Relationship Attribute Changes” cannot perform the creation of Incidents or
Changes, and only supports invoking Cl relationship updates directly.

What kinds of relationships are pushed from UCMDB
to SM?

Any kinds of “Relationships” are pushed from UCMDB to SM under the following conditions:

o The relationship appears in a “Push TQL” located in the “SM Sync” folder in the UCMDB Query
Manager.

o The relationship is named “Root” in the Push TQL.

¢ The relationship is mapped to an appropriate target in SM in the UCMDB configuration files
(XML and XSLT files).

The out-of-the-box relationships that are pushed from UCMDB to SM are relationships between two
Cls such as:

o Between Business Services and Applications;

Between Business Service and Host;

Between an Application and a Network Component; or

o Between Host, Network Components and Printers.

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 95 of 256



Universal Discovery Content Guide - Service Manager Integration
Standards and Best Practices

What is a Root Cl Node

A “Root” Node is a TQL Node that represents the Cl type that is created via push to SM from the
TQL structure. The rest of the TQL structure contains information that can be incorporated within
the “Root” Cl type and is used to enrich the record in SM with additional information and or
attributes.

What is a Root Relationship

A “Root” Relationship is a Relationship within a TQL and created in SM via push. It represents a
Relationship between two Root Cls. Only the relationships marked with “Root” are pushed to SM.

What is the “friendlyType” Specified in an XSLT File

friendly Type is another name for the UCMDB “CI Type”. These “friendly-types” are usually pushed
into the SM Device subtype field/attribute.

What is the “Virtual-Compound” Relationship Type
Used in a UCMDB-SM Integration Query

When more than two UCMDB CI entities are connected in series, the “Virtual-Compound”
represents the relationship between the first and last entities. This is a virtual relationship, as no
physical representation exists.

The “Virtual-Compound” relationship type is a relationship that links two CI type entities that have a
logical relationship. See the following figure:

Host ) Application } Business Service

Virtual-Compound

Explanation

The illustration shows an example of a Virtual-Compound relationship. The relationship in SM is
created directly between the “Host” and the “Business Service”.

When do | Need the Population Feature

You need the population feature under any of the following circumstances:

o You have done modeling in SM, especially when you are in the planning and design phases, and
you want your models to be reflected in UCMDB;

o You want to implement the UCMDB-SM integration, however you have already invested in your
SM CMDB and do not want to lose that investment;
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e You want to continue to maintain some parts of the SM CMDB while maturing your
UCMDB/Discovery implementation.

Can | Populate Physically Deleted Cls from SM to
UCMDB

No.

Physical deletions of Cls are allowed in SM, but SM cannot get such “deletion changes” and the
population feature will not synchronize such changes to UCMDB.

Physical deletions of Cls can be considered as exceptions, which only occur after you create Cls
by mistake. Normally, you delete a Cl by setting its status to something like “Disposed/Retired”. In
case such Cls have been populated to UCMDB, it is your responsibility to remove them manually
from UCMDB.

How do | Keep the Outage Dependency Setting of a
Cl Relationship in SM

Out-of-the-box, Cl relationships that are pushed from UCMDB to SM do not have outage
dependency information by default. If you need such information, you can set the DEM rule of the
Cl Relationship WSDL as follows:

1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

3. Open the ucmdbRelationship record.

4. Onthe Rules tab, select Add the record, and set dependency as true.

Id: |uu'ndbReIationshi|:u |
Table Mame: |cirelah'onshi|:l |

Condition: |

& Rules | % Managed Fields | < Incdent Customization | & Change Customization

r Action if matching record does not exist

O Add the record

() iAdd the record, and set dependency as true
) Open a Change

O Open an Incident

This will set the Outage Dependency of each Cl Relationship to true, and set the number of
dependent downstream Cls to 1 (because UCMDB only supports one-to-one relationships).
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If you want to set outage dependency only for some relationships, for example, if you want to
configure outage dependency for relationships that starts from Business Service, you can configure
the adapter configuration file (XSLT) and WSDL definition; you can also configure outage
dependency per relationship type (UCMDB TQL).

1. Inthe WSDL definition, expose fields outage.dependency and outage.threshold.

External Access Definition

Service Mame: ucmdbIntegration O released
Marne: cirelationship | hd O peprecated
Object Name: |Re|ah'onshi|3 |

g Allowed Actions | < Expressions | & Fields |

Field | Caption | Type
relationship.name RelationshipName
logical.name ParentCL
related. ds ChildCIs
relationship. type RelationshipType
relationshi i inSubtype
utage.dependency COutageDependenc
< outage. threshold CutageThreadhold

s T

2. Inthe XSLT file, set the exposed outage fields. For example, if you want to set the outage
dependency to true and threshold to 1 for Business Service relationships, you simply need to
change the mapping of TQL and XSLT in the smSyncConfFile.xml file:

<tgl name="applicationRelationsData" xslFile="bizservice_relations.xslt">
<request type="Create" name="CreateRelationship"/>
<request type="Update" name="UpdateRelationship"/>
<request type="Delete" name="DeleteRelationship"/>

</tql>

3. Inthebizservice relations.xslt file, use the following OutageDependency and
OutageThreadhold settings:

<xsl:stylesheet version="'1.0"' xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m'>

<xsl:template match="/relation">
<model>
<keys/>
<instance>
<ParentCI><xsl:value-of select="@parentID"/></ParentCI>
<ChildCIs>

<ChildCIs><xsl:value-of select="@childID"/></ChildCIs>
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</ChildCIs>
<RelationshipType>Logical</RelationshipType>

<RelationshipSubtype><xsl:value-of select="@friendlyType"/
></RelationshipSubtype>

<OutageDependency>true</OutageDependency>
<OutageThreadhold>1</OutageThreadhold>
</instance>
</model>
</xsl:template>

</xsl:stylesheet>

How do | Create an XSL Transformation File

You create an XSL transformation file in Adapter Management. You can copy the content of an
existing XSL transformation file to the new file and then make necessary edits.

To create an XSL transformation file:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management. ServiceManagerAdapter9-x
> Configuration Files.

3. Click the Create new resource button
4. Select New Configuration File.

5. Enter a name for the file. The file name should use this format: <AdapterlD>/<filename>. For
example: ServiceManagerAdapter9-x/test_relation_population.xsit.

6. Inthe Package field, select the adapter name. For example, ServiceManagerAdapter9-x.
7. Click OK. A file extension warning dialog displays.
8. Click Yes to continue.

UCMDB creates the new XSL transformation file in the Configuration Files folder of the

adapter. For example, ServiceManagerAdapter9-x > Configuration Files >
ServiceManagerAdapter9-x/test_relation_population.xsit.

9. Copy the content of an existing XSL transformation file to the new file. For example, for
population you can copy the content of an out-of-the-box population XSL transformation file.

10. Make necessary edits to the new file.
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Caution: Invalid XML

When removing XSL elements from an XSLT file, keep in mind that the remaining XML should
be a valid XML file, which will be used to translate the UCMDB Query Definition. See the
following for an example.

Out-of-the-box, the businessservice to computer_containment_population.xslt file is
as the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m">

<xsl:template match="/RetrievecirelationshipltolListResponse">
<topology>

<xsl:for-each select="instance">

<xsl:choose>
<xsl:when test="upstreamci.subtype="Infrastructure Servic
TN
<ci class="infrastructure_service">
<attribute name="name" type="String"><xsl:value-of s
elect=

"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>
</1link>
</ci>
</xsl:when>

<xsl:when test="upstreamci.subtype="'Application Service'">

<ci class="business_application">
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<attribute name="name" type="String"><xsl:value-of s
elect=
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>

</attribute>
</ci>
</1link>
</ci>
</xsl:when>
<xsl:otherwise>
<ci class="business_service">
<attribute name="name" type="String"><xsl:value-of s
elect=

"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:v
alue-of select="downstreamci.id"/>
</attribute>

</ci>
</link>
</ci>

</xsl:otherwise>
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</xsl:choose>
</xsl:for-each>
</topology>
</xsl:template>
</xsl:stylesheet>
The file becomes an invalid XML file if you change it to the following:

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m">

<xsl:template match="/RetrievecirelationshipltolListResponse">
<topology>

<xsl:for-each select="instance">

<xsl:choose>
<xsl:when test="upstreamci.subtype="'Infrastructure Service'">
<ci class="infrastructure_service">
</xsl:when>
<xsl:when test="upstreamci.subtype="'Application Service'">
<ci class="business_application">
</xsl:when>
<xsl:otherwise>
<ci class="business_service">
</xsl:otherwise>
</xsl:choose>

<attribute name="name" type="String"><xsl:value-of sele
ct="upstreamci.logical.name"/>
</attribute>

<attribute name="sm_id" type="String"><xsl:value-of sel
ect="upstreamci.id"/></attribute>

<link direction="outgoing" linkType="containment">
<ci class="node">

<attribute name="name" type="String"><xsl:va
lue-of select=
"downstreamci.logical.name"/></attribute>
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<attribute name="sm_id" type="String"><xsl:v
alue-of select=
"downstreamci.id"/></attribute>

</ci>
</link>
</ci>
</xsl:for-each>
</topology>
</xsl:template>

</xsl:stylesheet>

Sample usages of XSLT

For your reference, the following are some samples of using XSLT functionalities in this
integration.

Using choose to set Cl subtypes:
<Type>switch</Type>
<xsl:variable name="prefix" select=""'Value&gt;'"/>
<xsl:variable name="suffix" select="'&lt;/Value'"/>
<Subtype>

<xsl:choose>

<xsl:when test="contains(@node_role,concat($prefix, 'atm_switch',$suffix))">A
TM Switch</xsl:when>

<xsl:when test="contains(@node_role,concat($prefix, 'frame_relay_ switch',$suf
fix))">Frame Relay Switch</xsl:when>

<xsl:when test="contains(@node_role,concat($prefix, 'lan_switch',$suffix))">L
an Switch</xsl:when>

<xsl:otherwise><xsl:value-of select="@friendlyType"/></xsl:otherwise>
</xsl:choose>
</Subtype>
Getting the substrings from a string:
<xsl:variable name="calculatedLocation" select="@calculated_location"/>

<Building>
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<xsl:value-of select="substring-after($calculatedLocation,' Building:')"/>
</Building>
<Floor>

<xsl:value-of select="substring-before(substring-after($calculatedLocation, 'F1
oor:'),"' Building:"')"/>

</Floor>
<Room>

<xsl:value-of select="substring-before(substring-after($calculatedLocation, 'Ro
om:")," Floor:')"/>

</Room>
Reading the value mappings from an XML file:
The SM_CIT_Subtype_ list.xml file defines the value mappings for subtypes:
<lists>
<list name="CIType_bizservice">
<entry ucmdb="BusinessApplication" sm="Application Service"/>
<entry ucmdb="BusinessService" sm="Business Service"/>
<entry ucmdb="InfrastructureService" sm="Infrastructure Service"/>
</list>
</lists>
The business_service_push.xslt file uses this mapping definition XML file:

<xsl:variable name="CIlists" select="document('SM_CIT_Subtype list.xml')/list
s"/>

<xsl:variable name="CIT" select="@bdmType"/>
<xsl:for-each select="$CIlists/list[@name="CIType_bizservice']">
<Subtype><xsl:value-of select="entry[@ucmdb=$CIT]/@sm"/></Subtype>

</xsl:for-each>

Tip: For more information about XSL transformations, visit the following site:
http://www.w3schools.com/xsl/

How do | Use the Load Fields Button to Add Multiple
Managed Fields

Service Manager stores the list of managed fields in the ucmdblintegration web service, which
consists of a number of web services objects. You can add more managed fields to DEM Rules so
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that Service Manager can monitor changes in more Cl attributes in UCMDB and trigger the actions
defined in relevant DEM Rules.

You can manually add managed fields that are exposed in associated WSDL definitions to DEM
Rules; however, you can use the Load Fields button to automatically (and therefore correctly) add
managed fields to DEM Rules.

1. Click the Managed Fields tab of the DEM Rule.
2. Click the Load Fields button.

3. If the table (in the Table Name field) of the DEM rule record has only one WSDL definition
associated to it, all fields exposed in the WSDL definition are immediately added to the
Managed Fields list.

A message displays: <XX> new fields loaded.

4. |If the table has more than one WSDL definition associated to it, the Managed Fields Importing
wizard opens, and a list of WSDL definitions (ucmdblntegration web service objects) displays.
a. Select one or more objects, and click Next.

b. All new fields that can be added from the selected web service objects display.

c. If youwant to add all of the fields, click Finish; if you want to ignore some of them, change
their Action value from Add to Ignore, and then click Finish.
A message displays: <XX> new fields loaded.

5. Save the DEM Rule record.

What is the Purpose of the <container> Element in a
Population XSLT File

Out-of-the-box, in the runningsoftware_population.xslt file, there is a container element:
<link direction="incomming" linkType="composition">
<ci class="node">
<container tql="SM Computer Population" keyFields="CIIdentifier">
<1inkTql>SM Computer To Software With Composition</linkTql>

<linkRetrieveCondition>downstreamci.logical.name=&quot;<xsl:value-o
f select="CIIdentifier"/>
&quot;</linkRetrieveCondition>

<linkValueFields>upstreamci.logical.name</linkValueFields>
</container>
</ci>

</1link>
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« In UCMDB, RunningSoftware Cls must exist together with a Root Container (Node), however
Service Manager allows RunningSoftware Cls without a Node.

o The current integration adapter synchronizes Cls and Relationships separately; when populating
a RunningSoftware Cl, the integration has no chance to check if a relationship exists between
the Cl and a Node.

With the <container> element, the integration populates RunningSoftware Cls together with a
container.

Can | Populate Sub-ltem Deletions

Yes.

Service Manager and UCMDB store Cl information in different data structures, and therefore one
SM CI may be synchronized to UCMDB as several Cls. For example, during population, an SM
computer Cl record is synchronized to a Node Cl in UCMDB, and the computer CI’s attributes to
Cls such as IP, Interface, Location, etc (which are referred to as sub-items of the Node CI.). In this
case, the Node Cl is the root Cl.

The integration allows you to populate sub-item deletions to UCMDB (for example, if you delete the
IP Address attribute value of a computer, the corresponding IP Cl record in UCMDB will be deleted
too). To do so, you need to specify a root in the Cl type’s population xslt file, using parameter
isRoot="true". For example, for Computer Cls, the “node” should be specifed as the root.

Out-of-the-box, only the computer_population.xslt file requires the “node” Cl be specified as the
root, as shown below:

<ci class="node" isRoot="true">

What will Happen if a Population Job Fails or
Succeeds with Warnings

When a population job fails:

The failure prevents the remaining population tasks from running. The next job run will start from the
last Success time. If pagination occurs (that is, the tasks are divided into multiple pages), the tasks
will run again and again within the first page from the last “Success” time (once the end of the first
page is reached, no new tasks will be executed).

When a population job succeeds with warnings:

A warning does not prevent the remaining population tasks from running. The next job run will run all
tasks again starting from the last Success time. If pagination occurs (the tasks are divided into
multiple pages), the tasks on all pages will be re-run (including those that were successfully
completed last time).

Known Issues and Limitations

The following table lists the known issues and limitations of this integration.
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Known Issues and Limitations

Global ID

QCCR1E7224
6

QCCR1ET7222
2

Known Issue/Limitation

[Population Adapter] Cannot
populate deleted Cls in a full
population.

While you run a full population, if
there are Cls that have been
deleted since the last job runin
Service Manager, the deleted Cls in
Service Manager will not be
populated to UCMDB.

However, the data push feature first
pushes deleted Cls while running a
full push.

NodeRole is case-sensitive when
mapping Node's NodeRole in
UCMDB to Node's Subtype in SM.

Steps to reproduce this issue:
1. Create a Node in UCMDB.

2. Setthe Node's NodeRole
property to "Printer".

3. Runadatapushin UCMDB to
push Node Cls.

4. Check the Cl's attributes in
SM.

Result: The Cl's subtype is
"Node", which should be "Net
Printer".

When the NodeRole is "printer", the
result is correct.

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Workaround

In UCMDB, manually delete all Cls that

were populated from SM by using
appropriate filter criteria and then run a
full population.

Warning: You must be very careful
when using this workaround.

Use lower-case names for NodeRole
(printer).
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Known Issues and Limitations, continued

Global ID Known Issue/Limitation Workaround

QCCR1E7232 When you run a full population for Not available at this time.

7 the first time to synchronize a large
amount of Cls, if some of the Cls
have an invalid attribute value (for
example, IP address), the
population job will ignore such Cls
and run to completion with a Failed
status and with errors logged on the
Job Errors tab; In addition, the last
job execution time will not be
logged because the job is run for the
first time but fails.

As aresult, after fixing the invalid
attribute values in Service
Manager, you will not have a
chance to re-populate the failed Cls
through a change (delta) population.
This is because when youruna
change population, a full population
will be executed instead (because
the last job execution time is null).

QCCR1E8436 When “Run in Multi-Company To solve this issue, manually update a
4 Mode” is enabled in the System JavaScript:
Information Record in Service
Manager (SM), the UCMDB 1. Loginto Service Manager as a
integration fails to create changes system administrator.

orincidents in SM because the o . )
configuration item data modification =~ 2. Goto Tailoring > Script Library,

event fails. The following error and open the discoveryEvent

occurs: script.

ERROR TypeError: 3. Inthis file, replace all instances of

lib.uCMDBConfiguration.isEnab string

le is not a function at char lib.uCMDBConfiguration.isEnab

1 le with
lib.uCMDBConfiguration.isEnab
led.

Note: You can find the string in lines
43, 86 and 405.

4. Click Compile to make sure the
code is correct, and then click Save.

5. Log off and log back in.
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Known Issues and Limitations, continued

Global ID Known Issue/Limitation

QCCR1E7251 If you set the use.global.id

1 parameter in the adapter's
sm.properties file to True, the
federation feature does not work.

QCCR1E7257 The data length of Cl relationship

8 name in Service Manager is 40
characters, which is not sufficient
for the integration. Installing this
content pack does not
automatically increase this data
length in Service Manager.

If a Cl relationship name exceeds
the data length, either the
relationship name is truncated after
push or the relationship cannot be
pushed to Service Manager due to a
duplicate key error.

QCCR1E7300 Double quotes in UCMDB ClI

4 names (for example: "laptop - 003")
are removed when the Cls are
synchronized to SM.
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Workaround

Set the parameter to False to solve this
issue.

o When you deploy the adapter on the
UCMDB standalone server (which is
defined as a global-id generator by
default), globalld and ucmdbld are the
same thing. For this reason, setting
this parameter to false can meet all of
your needs satisfied by setting the
parameter to true.

o When you deploy the adapteron a
non-standalone UCMDB (for
example, BSM's RTSM), setting this
parameter to true is not supported. In
addition, HP does not recommend
integrating the non-standalone CMDB
(for example, BSM's RTSM) with
Service Manager.

Manually increase the data length in
Service Manager:

Open the cirelationship table in Database
Dictionary, and increase the data length
of the relationship.name field from 40 to
an appropriate value (recommended
value: 300).

Not available at this time.
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You can tailor the HP Universal CMDB integration to meet your business needs by adding or
removing managed ClI types, attributes, and relationship types. This chapter describes the
integration architecture and tailoring options for data push, population, and federation.

This section includes:
o "Integration Architecture" below

o "Integration Tailoring Options" on page 123

Integration Architecture

Before you tailor the integration, you should understand how the following components of the out-of-
the-box integration work.

o "Integration Class Model" below

o "Integration TQL Queries" below

e "Service Manager Web Services" on page 115

e "Service Manager Reconciliation Rules" on page 119

e "Service Manager Discovery Event Manager Rules" on page 121

Integration Class Model

UCMDB 9.x or later no longer uses a private class model of Cl types to manage integration Cls, as
was required in prior versions. Instead, the integration uses the standard UCMDB managed objects
and maps them to Service Manager Cl types and attributes with queries and transformation files.

Integration TQL Queries

This section describes out-of-the-box Topology Query Language (TQL) queries used for data push,
Actual State, and population.

This section includes:
o "TQL Queries for Push" on the next page
o "TQL Queries for Actual State" on page 113

o "TQL Queries for Population" on page 113

"TQL Query Requirements" on page 114
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TQL Queries for Push

For the push feature, the integration uses a collection of TQL queries to gather Cl attribute
information from Universal CMDB and send it to the Service Manager system.

To access the out-of-the-box data push queries, navigate to Modeling > Modeling Studio, select
Queries for Resource Type, and then navigate to the Root > Integration > SM Sync > 9.xx folder.

If you want to change what Cl/Relationship types or attributes are part of the integration, you must
also edit the integration queries to support your updated CI/CI Relationship types and attributes.

Out-of-the-box TQL queries for data push

Query
name

SM
Running
Software
Push

SM
Business
Service
Push

SM
Business
Service
Relations
Push

SM
Computer
Push

SM Switch
Push

Description

This query gathers Cl attributes from Running Software Cls.

This query gathers Cl attributes from business service Cls.

This query gathers relationships between the following components:
o Business service and Running Software Cls

o Business service and node Cls

e Two or more business services

The query includes compound relationships because the relationships can extend
through a group.

This query gathers Cl attributes from the node CI type with NodeRole containing

LT o,

“desktop”, “server”, “virtualized_system” or not set.

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

This query gathers Cl attributes from the node CI type with NodeRole containing
“atm_switch”, “frame_relay_switch”, or “lan_switch”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.
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Out-of-the-box TQL queries for data push, continued

Query

name Description

SM This query gathers ClI attributes from the node CI type with NodeRole containing
Storage “san_switch”, “san_gateway”, “san_router” or exact Cl type equal to “storage
Push Array”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Net This query gathers ClI attributes from the node CI type with NodeRole containing
Printer “printer”.

Push
It also gathers related Cl attributes from the following CI types through containers

and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM This query gathers ClI attributes from the node CI type with exact Cl type equal to
Mainframe @ “Mainframe Logical Partition”, or “Mainframe CPC”.
Push

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Mobile = This query gathers Cl attributes from the node ClI type with NodeRole containing
Device “pda_handheld”.

Push
It also gathers related Cl attributes from the following Cl types through containers

and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM This query gathers ClI attributes from the node CI type with NodeRole containing
Network “router”, “adsl_modem”, “appletalk_gateway”, “bandwith_manager”, “cable_model”,
Component = “csu_dsu”, “ethermnet”, “fddi”, “firewall”, “hub”, “kvm_switch”, “load_balancer”,

Push “‘multicast_enabled_router”, “nat_router”, “token_ring”, “undefined_network_

component”, “voice_gateway”, “voice_switch”, or “vpn_gateway”.

It also gathers related CI attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, and Location.

SM Cluster = This query gathers CI attributes from the node ClI type with exact Cl type equal to
Push “ClusterResourceGroup”.

It also gathers related Cl attributes from the following Cl types through containers
and links: IPAddress, Interface, CPU, FileSystem, DiskDevice, Location, and
Cluster.

SM Node This query gathers relationships between the following components:
Relations
Push ¢ Node and Printer Cls

¢ Node and RunningSoftware Cls

The root class of the relationship is composition.
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Out-of-the-box TQL queries for data push, continued

Query
name

SMCRG
Relations
Push

SM Layer2
Topology
Relations
Push

SM Local
Printer
Push

Description

This query gathers relationships between the following components: Node and
Cluster Resource Group Cls.

The query includes compound relationships because the relationships can extend
through a group.

This query gathers relationships between the following components: Two or more
nodes.

The query includes compound relationships because the relationships can extend
through a group.

This query gathers ClI attributes from printer Cls.
It also gathers related ClI attributes from the Node Cl type.

TQL Queries for Actual State

Out-of-the-box, the following TQL queries (see the table below) are used for retrieving Cl
information from UCMDB to the Actual State section of the Service Manager Configuration Item
(Cl) form. Service Manager retrieves Cl Actual State information by callinga UCMDB web service
that retrieves Cl data according to these queries.

The queries are located in the Integration > SM Query folder in the UCMDB Modeling Studio.

Out-of-the-box TQL queries for Actual State

Query name Description

localPrinterExtendedData This query gathers real-time extended information from Printer
Clsin UCMDB.

applicationExtendedData This query gathers real-time extended information from

RunningSoftware Cls in UCMDB.

businessServiceExtendedData = This query gathers real-time extended information from

business service Cls in UCMDB.

hostExtendedData This query gathers real-time extended information (such as

Asset, Party, Location, LogicalVolume, WindowsService,
Printer, InstalledSoftware, FileSystem, IPAddress, Interface,
DiskDevice, and Cpu) from the node Cl type in UCMDB.

TQL Queries for Population

For C1/CI Relationship population, the integration does not need TQL queries to save CI/Cl
Relationship attribute information to Universal CMDB; however in the population configuration file
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the following TQL query names are mapped to relevant population XSL transformation files (see the

following table).

TQL queries for population

Query name

SM Business Service
Population

SM Computer To
Computer With
ConnectM Running
Software Population

SM Computer Population

SM Biz To Biz With
Containment

SM Biz To Biz With
Usage

SM Biz To Computer
With Containment

SM Biz To Computer
With Usage

SM Biz To Software With
Containment

SM Biz To Software With
Usage

SM Computer To
Computer With Connects

SM Computer To
Software With
Composition

CLIP Down Time
Population

Cl To Down Time Cl With
Connection

Description

This query defines the Cl store structure of business service Cls.

This query defines the Cl store structure of running software Cls.

This query defines the CI store structure of computer Cls.

This query defines the Cl store structure of Cl relationships in which
a bizservice CI contains another.

This query defines the Cl store structure of Cl relationships in which
a bizservice Cl uses another.

This query defines the Cl store structure of Cl relationships in which
a bizservice Cl contains a computer Cl.

This query defines the Cl store structure of Cl relationships in which
a bizservice Cl uses a computer ClI.

This query defines Cl store structure of Cl relationships in which a
bizservice Cl contains a RunningSoftware CI.

This query defines Cl store structure of Cl relationships in which a
bizservice Cl uses a RunningSoftware ClI.

This query defines the Cl store structure of Cl relationships in which
a computer Cl connects to another.

This query defines the Cl store structure of Cl relationships in which
a RunningSoftware Cl is contained within a computer Cl and the
RunningSoftware Cl cannot exist without the container.

This query defines the Cl store structure of ScheduledDowntime
Cls.

This query defines the Cl store structure of Cl relationships in which
a ScheduledDowntime Cl connects to an affected CI.

TQL Query Requirements

The integration requires that any custom TQL queries you create meet certain formatting
conditions. Any TQL queries that you want to include in the integration must meet these conditions:
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o Toquery Cls, aquery must contain one CI type labeled Root. The Root node is the main Cl that
the UCMDB synchronizes. All other Cls are contained Cls of the Root CI.

o Toquery relations, a query must contain one or more relationships labeled Root.

o A query must contain only the Root Cl and Cls that are directly connected to it. The Root Cl is
always the top node of the TQL hierarchy.

¢ ATQL graph cannot have cycles.

o If a query synchronizing relationships has cardinality, it must be cardinality 1...*. Additional
cardinality entries must have an OR condition between them.

« If you only want the integration to synchronize specific Cls, you must configure the condition on
the TQL query to filter such Cls.

Service Manager Web Services

Service Manager uses web services messages to get and receive Cl information from your
UCMDB system. Out-of-the-box, UCMDB sends more CI attribute information than the Service
Manager system actually manages. Service Manager users can view all of the Cl attribute
information the UCMDB system sends from the Actual State section of the Cl record.

Service Manager publishes several web services for use by the UCMDB-SM integration. The
UCMDB system uses the web services to map UCMDB ClI types and Cl attributes to web services
objects the Service Manager system recognizes. If you add UCMDB CI types or Cl attributes that
you want Service Manager to manage, then you must update one or more of these web services to
define them as web services objects. See the Service Manager Web Services Guide for more
information about publishing web services.

Managed Fields

Note: Managed fields are used only for the data push feature.

A Service Manager managed field is a field where the system compares the Cl attribute value in the
incoming UCMDB web services message to the value in a Service Manager Cl record. If the values
in the web services message do not match those in the Cl record, Service Manager runs a
Discovery Event Manager (DEM) rule to determine what action to take. The DEM rule determines
which of the fields that are published as web services objects are fields managed by the integration.
Only value changes in managed fields trigger the DEM rule.

Service Manager stores the list of managed fields in the ucmdblintegration web service. The
ucmdblintegration web service consists of a set of web services objects. Out-of-the-box, the
integration uses only part of them (see the Mappings between Service Manager web service
objects, tables, and DEM rules table), some of them (along with their relevant DEM Rules) have
been deprecated (see the Deprecated ucmdblintegration web service objects for data push table),
and some are used for population or federation (see the ucmdblintegration web service objects used
for population or federation table).
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Mappings between Service Manager web service objects, tables, and DEM rules

This web service object Publishes fields from this table = And uses this DEM rule ID

Relationship cirelationship ucmdbRelationship
ucmdbRunningSoftware device ucmdbRunningSoftware
ucmdbBusinessService joinbizservice ucmdbBusinessService
ucmdbNode joinnode ucmdbNode

Deprecated ucmdblintegration web service objects for data push

This web service Publishes fields from this Recommended replacement
object table (object)

ucmdbApplication device ucmdbRunningSoftware
ucmdbComputer ucmdbComputer ucmdbNode

UcmdbDevice device ucmdbRunningSoftware
ucmdbNetwork joinnetworkcomponents ucmdbNode

ucmdbPrinter joinofficeelectronics ucmdbNode

ucmdblintegration web service objects used for population or federation

This web service Publishes fields from this  And is used Requires a DEM
object table for Rule?
cirelationship1to1 cirelationship1to1 Population No
ucmdblDPushBack device Population No
UcmdbChange cma3r Federation No
UcmdbChangeTask cm3t Federation No
Ucmdblincident probsummary Federation No
UcmdbProblem rootcause Federation No

The following sections list the fields published as web services objects used for data push (see the
Mappings between Service Manager web service objects, tables, and DEM rules table) and
indicate whether they are managed fields in an out-of-the-box Service Manager system. You can
use this reference to determine if you need to publish afield as a web service object, and also if you
need to create a DEM rule for the object.

Object Name: Relationship

Service Manager publishes the following fields from the cirelationship table:
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Web service and managed fields of the Relationship object

Field published as web Caption used in web service Is the field a managed
service object messages field?
relationship.name RelationshipName

logical.name ParentCl

related.cis ChildCls Yes
relationship.subtype RelationshipSubtype

Object Name: ucmdbRunningSoftware
Service Manager publishes the following fields from the device table:

Web service and managed fields of the ucmdbRunningSoftware object

Field published as web Caption used in web service Is the field a managed
service object messages field?
ucmdb.id UCMDBId

ci.name ApplicationName Yes
type Type

subtype Subtype

company Companyld

logical.name Clldentifier Yes
product.version ProductVersion

vendor Vendor

version Version

id! CIName

Object Name: ucmdbBusinessService
Service Manager publishes the following fields from the joinbizservice table:

Web service and managed fields of the ucmdbBusinessService object

Field published as web Caption used in web service Is the field a managed
service object messages field?

ucmdb.id UCMDBId

ci.name ServiceName Yes

1This attribute is used only for the population feature.
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Web service and managed fields of the ucmdbBusinessService object, continued

Field published as web

service object
type

subtype
company
logical.name
vendor

i

Object Name: ucmdbNode

Service Manager publishes the following fields from the joinnode table:

Caption used in web service
messages

Type

Subtype
Customerld
Clldentifier
ServiceProvider

CIName

Web service and managed fields of the ucmdbNode object

Field published as web

service object
ucmdb.id

type

subtype
company
logical.name
default.gateway
network.name
building

room

floor

location

Caption used in web service
messages

UCMDBId

Type

Subtype
Customerld
Clldentifier
DefaultGateway
DNSName
Building

Room

Floor

Location

addlIPAddr{addIIPAddress] AddlIPAddress

addlIPAddr[addISubnet] AddISubnet

addIMacAddress AddIMacAddress

1This attribute is used only for the population feature.
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Is the field a managed

field?

Yes

Is the field a managed

field?

Yes
Yes
Yes
Yes
Yes

Yes

Yes
Yes

Yes
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Web service and managed fields of the ucmdbNode object, continued

Field published as web
service object

bios.id

operating.system
os.version
physical.mem.total
serial.no.

vendor

cpu[cpu.id]
cpu[cpu.name]
cpu[cpu.clock.speed]
file.system[mount.point]
file.system[disk.type]
file.system([file.system.type]
file.system[disk.size]
asset.tag

machine.name
disk.device[model.name]
disk.device[disk.vendor]
disk.device[disk.name]
id’

isVisualization

istatus

Service Manager Reconciliation Rules

Caption used in web service

messages
BIOSId

0s

OSVersion
PhysicalMemory
SerialNo
Vendor

CpulD
CpuName
CpuClockSpeed
MountPoint
DiskType
FilesystemType
DiskSize
AssetTag
HostName
ModelName
DiskVendor
DiskName
CIName
IsVisualization

AssetStatus

Is the field a managed

field?
Yes
Yes
Yes

Yes

Yes

Service Manager reconciliation rules allow the integration to identify Cl records in your Service
Manager system that match Cls in your UCMDB system. Service Manager attempts to reconcile
Cl records with every push of Cl attributes from your UCMDB system. The integration uses the

following workflow to match UCMDB Cls with Service Manager Cls.

1This attribute is used only for the population feature.

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Page 119 of 256



Universal Discovery Content Guide - Service Manager Integration
Tailoring the Integration

1. The UCMDB system sends a web service message to Service Manager containing the latest
Cl attribute data.

2. Service Manager scans the web service message for the Cl ucmdb.id value.

Note: Out-of-the-box, Service Manager does not display the ucmdb.id field on Cl record
forms to prevent users from changing the value. If you want to add this value to your
forms, you can find the ucmdb.id field defined in the device table. HP recommends that
you make this a read-only field.

3. Service Manager searches for an existing Cl record that has the same ucmdb.id value.

4. If Service Manager finds a Cl with a matching ucmdb.id value, no reconciliation is needed.
Service Manager compares the UCMDB ClI attributes to the Service Manager managed fields
and runs the appropriate Discovery Event Manager (DEM) rules as needed.

5. If Service Manager cannot find a Cl with a matching ucmdb.id value, it runs the reconciliation
rules.

6. Service Manager searches for an existing Cl record with the same reconciliation field values.

7. If Service Manager finds a Cl with a matching reconciliation field value, it updates the Cl record
with the ucmdb.id value of matching UCMDB CI. Service Manager compares the UCMDB ClI
attributes to the Service Manager managed fields and runs the appropriate DEM rule as
needed.

8. If Service Manager cannot find a Cl with a matching reconciliation field value, it runs the DEM
rule for “Action if matching record does not exist.” Out-of-the-box, the DEM rule has Service
Manager create a new Cl record. Service Manager creates the Cl record using the ucmdb.id
value of incoming UCMDB ClI.

Performance Implications

Because Service Manager attempts to reconcile Cls with every push, the number of reconciliation
fields you have will affect the integration’s performance. The more reconciliation rules you have, the
more searches Service Manager must perform to match Cls. To improve the performance of
reconciliation searches, you should choose reconciliation fields that are unique keys of the
underlying Service Manager table. For example, if you want to reconcile Cl records in the device
table, use the logical.name field as a reconciliation field because it is a unique key. See "How to
Add DEM Reconciliation Rules" on page 128 to create a reconciliation rule.

Dependence on DEM Rules

Service Manager uses the “Action if matching record does not exist” DEM rule whenever it cannot
reconcile Cls. You should review the DEM settings and decide if they meet your business
standards prior to the initial push of Cls from UCMDB to Service Manager. For example, you can
have Service Manager create a change request for every Cl in the initial Cl push by selecting the
“Open a change” option.
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Service Manager Discovery Event Manager Rules

You only need to create Discovery Event Manager (DEM) rules if you want to accomplish any of the
following custom actions:

¢ "Change the Conditions Under Which a DEM Rule Runs" below
¢ "Change the Action the DEM Rule Takes" below
o "Update the List of Managed Fields for a Cl Type" on the next page

o "Create Custom JavaScript to Open Change or Incident Records" on the next page

Change the Conditions Under Which a DEM Rule Runs

Service Manager will run a DEM rule only if the condition field evaluates to true. Out-of-the-box, no
DEM rule has a condition statement that restricts when the rule runs, and all the integration DEM
rules will always run by default.

You can update a DEM rule's condition statements if you want to restrict when Service Manager
runs your DEM rules. For example, adding the following condition to the ucmdbNode DEM rule
restricts the rule to desktop Cls.

subtype in $L.file="Desktop”

You can also use the condition field to create multiple DEM rules that apply to the same table name.
For example, the following DEM rules both apply to the joinnode table.

DEM rules using different conditions to affect the same table

DEM rule Id Table Name Condition
ucmdbNode joinnode subtype in $L.file!="Desktop”
ucmdbDesktop joinnode subtype in $L.file="Desktop”

Typically, you will only need to add conditions if your business processes require the integration to
take different actions with certain Cl types or SLAs.

Change the Action the DEM Rule Takes

Out-of-the-box, the integration DEM rules take the following actions:
¢ Add a Cl record when the UCMDB data does not match an existing Service Manager ClI record

o Open a Change or log results and update a Cl record when the UCMDB Cl attribute data does
not match the Cl attribute data in the Service Manager Cl record

o Delete a Cl record when the UCMDB data specifies that the Cl has been deleted
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You can change the integration DEM rules to meet your business processes. For example, you
could use the ucmdbNode DEM rule to open a change when the integration finds a non-desktop Cl
with unexpected data, and use the ucmdbDesktop DEM rule to log results and update the record
when the integration finds a desktop Cl with unexpected data.

Caution: If you want to use the Change Management verification and Change Management
validation features of the integration, your DEM rules must use the Open a Change option for
the “Action if record exists but unexpected data discovered” event.

Update the List of Managed Fields for a Cl Type

If you add ClI attributes to your UCMDB system that you want to include in the integration, you
must also create matching managed fields in Service Manager. Each managed field must have a
corresponding web services object definition in order to receive Cl attribute updates from your
UCMDB system. See "How to Add a CI Attribute to the Integration for Data Push" on page 135 and
"How to Add a Cl Type to the Integration for Data Push" on page 149 for information on how to add
managed fields.

Create Custom JavaScript to Open Change or Incident
Records

Service Manager uses the discoveryEvent JavaScript to create Cl names and to set the values of
required fields when opening change or incident records. Out-of-the-box, the script uses the
following default values.

Default values to create a new CI

You can update the createCIName and populateNewCI functions to set the following Cl values.

Default values used to create a new ClI

Cl attribute Default value defined in discoveryEvent
record.logical_name System generated ID number
record.assignment AUTO

record.istatus Installed

record.os_name Value in record.operating_system

Default values to create a new change

You can update the populateChange function to set the following change values.
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Default values used to create a new change

Cl attribute
change.category
change.reason
change.initial_impact
change.severity
change.coordinator
change.requested by

change.status

Default value defined in discoveryEvent
Unplanned Change

Value in reason

3

3

Change.Coordinator

discovery

initial

Default values to create a new incident

You can update the populatelncident function to set the following incident values.

Default values used to create a new incident

Cl attribute
incident.category
incident.subcategory
incident.product_type
incident.assignment
incident.initial_impact
incident.severity
incident.logical.name
incident.site_cateogry
incident.contact_name

incident.affected_item

Default value defined in discoveryEvent
incident

hardware

missing or stolen

Hardware

3

3

Value of id

C

ANALYST, INCIDENT

MyDevices

Integration Tailoring Options

The integration offers the following tailoring options:

o "How to Update the Integration Adapter Configuration File (sm.properties)" on the next page

o "How to Add DEM Reconciliation Rules" on page 128
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"Add Discovery Event Manager Rules" on page 131

"How to Add a CI Attribute to the Integration for Data Push" on page 135

"How to Add a CI Type to the Integration for Data Push" on page 149

"How to Add a Cl Type’s Relationship Types to the Integration for Data Push" on page 172
"How to Add Custom TQL Queries to Data Push Jobs" on page 178

"How to Add a ClI Attribute to the Integration for Population" on page 179

"How to Add a CI Type to the Integration for Population" on page 182

"How to Add a CI Type’s Relationship Types to the Integration for Population" on page 198
"How to Customize UCMDB ID Pushback fora Cl Type" on page 202

"How to Add Custom TQL Queries to Integration Population Jobs" on page 204

"How to Add an Attribute of a Supported CI Type for Federation" on page 205

How to Update the Integration Adapter Configuration
File (sm.properties)

The integration uses a properties file (sm.properties) as a configuration file of the adapter. Out-of-
the-box, this file has been set up based on best practices, so usually you can keep the default
parameter values. Optionally, you can update the parameter values to better suit your needs.

To update the sm.properties file:

1.

2.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

Click the properties configuration file: sm.properties.

Update the parameter values as needed. For a list of the parameters, see the following table.
Parameters in the sm.properties file
Parameter Default value Comment

timeout.minutes 10 The integration connection
timeout value (in minutes).
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Parameters in the sm.properties file, continued

Parameter Default value Comment
number.of.concurent.sending.threads = 6 The number of concurrent
threads used for the data push
feature.
= 1: Disabled

= 2 or higher: Enabled

Note: If you are
connecting to multiple
Service Manager
instances to improve the
CI data push performance
(see the URL Override
configuration in "How to
Create an Integration
Point in UCMDB" on page
29), you are
recommended to increase
this value for optimized
performance. For
example, set it to 12 if you
are connecting to two
Service Manager
instances.

min.objects.for.concurent.sending 50 The minimum number of
Service Manager objects that
is required to use concurrent
sending instead of single
thread sending.

Note: It is used for the
push feature.

number.of.chunks.per.thread 3 The number of chunks per
thread used for the push
feature.
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Parameters in the sm.properties file, continued

Parameter Default value
number.of.cis.per.request 1000
use.global.id false
type.of.expand.enum 2

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Comment

The maximum number of
objects retrieved from Service
Manager by ID.

Note: It is used for the
population and federation
features. Do not set it to
a number greater than
1000 in case the request
has a 64K limit.

If set to true, globalld instead
of ucmdbld is used in the
integration. For more
information about the
differences between UcmdbID
and GloballD, see the
UCMDB documentation.

It configures the value
mapping rule for the UCMDB
enum type.

s 0O: The feature will be
disabled

= 1: The enum type will
expand to “{value}’

= 2: The enum type will
expand to “{index}-{value}”’

Note: It is used for the
push feature.
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Parameters in the sm.properties file, continued

Parameter Default value Comment

use.type.label true It configures whether the
generated source XML uses
the real Cl/Relationship type
directly or uses the label that
is defined in the TQL.

If set to false, the real type is
used directly instead of the
label.

op.pagination.switch on It indicates if pagination (client
driven) is enabled.

= on: Enabled.
= Off: Disabled.

Note: It is used for the
population feature.

pop.pagination.recordcount 1000 The maximum number of
records displayed on each
page when pagination is
enabled.

Note: It is used for the
population feature.

pop.createci.key sm_id The UCMDB field of a Cl
record that stores the Service
Manager CI ID.

Note: It is used for the
population feature.
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Parameters in the sm.properties file, continued

Parameter Default value

ucmdbid.pushback.request UpdateucmdblD
PushBackRequest

ucmdbid.pushback.xslt ucmdbid_

pushback.xslt

check.sm.connections false

Comment

The web service request for
pushing the UCMDB ID back
to Service Manager.

Note: It is used for the
population feature.

The xslt configuration file for
pushing the UCMDB ID back
to Service Manager.

Note: It is used for the
population feature.

It indicates whehter to check
the SOAP connections to
Service Manager instances
before running a job.

You can enable it under any of
the following circumstances:

= Your Service Manager is
running in High Availability
mode (with load balancing),
and you want to connect
UCMBDB to multiple Service
Manager instances.

= Youwant UCMDB to not
run a job when no
integration connections are
available, rather than run
the job and then report a
failure.

How to Add DEM Reconciliation Rules

It is possible that your Service Manager system already contains Cl records that match Cls in your
UCMDB system. Rather than add duplicate ClI records to your Service Manager system, you can
configure Service Manager to reconcile Cl records between the two systems based on the values

of specific fields.
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Service Manager always attempts to reconcile Cl records based on the unique key field of the
Service Manager table and the ucmdb.id field. You can specify additional fields to reconcile on
from the DEM Reconciliation Rules form. If Service Manager finds a matching value in any one of
these fields, it updates the Service Manager Cl record with the attributes from the incoming
UCMDB record.

When multi-tenancy is enabled, Service Manager only reconciles the Cls whose company ID
matches the company ID in the data push job. For example, when pushing Cls from company 2, the
reconciliation rules only apply to the Service Manager Cl records that have the company code
corresponding to company number 2.

In order to specify reconciliation fields, you will need to be familiar with the table and field names in
both your Service Manager and UCMDB systems. If you want to reconcile on a particular attribute
from the UCMDB system, you should verify that there is a corresponding Service Manager
managed field for the attribute. Without such a mapping, Service Manager will not know to search
for matching values in the Cl record.

Note: Not all UCMDB attributes have a corresponding field in Service Manager. You may need
to tailor your Service Manager system to add a matching field if one does not already exist.

Using join tables for reconciliation

When setting reconciliation rules, if the device type you are reconciling has a joindef definition (as
defined in the devtype table), use the join table name instead of the device table. For example, if
you want to reconcile computer Cls, use the joincomputer table instead of the device table.

Sequence of reconciliation

A reconciliation rule specifies what Service Manager table and field you want to search for matching
Clvalues. It also specifies the sequence in which you want Service Manager to process
reconciliation rules. By default, Service Manager processes rules in alphabetical order by field
name. For example, Service Manager will reconcile Cls against the asset.tag field before
reconciling Cls on the ci.name field.

To change the order in which Service Manager reconciles Cls, you can add a numeric value to the
sequence field. For example, the following reconciliation rules ensure that Service Manager
processes Cls by the ci.name field prior to reconciling them against the asset.tag field.

Sample reconciliation rules ordered by sequence

Table Name Field Name Sequence
joincomputer ci.name 1
joincomputer asset.tag 2

A Discovery Event Manager (DEM) reconciliation rule allows you to specify which Service Manager
fields you want to use to determine if an existing Cl record matches a Cl ina UCMDB system. An
administrator typically specifies reconciliation rules prior to starting UCMDB data push jobs so that
Service Manager will not create duplicate Cl records.

To create a DEM reconciliation rule:
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1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > DEM Reconciliation Rules. Service Manager
displays the DEM Reconcile Record form.

3. InTable Name, type the name of the Service Manager table containing the field you want to
reconcile on.

4. InField Name, type the name of the Service Manager field containing the values you want to
reconcile on.

5. InSequence, type a number to specify what order you want Service Manager to run this rule.

Note: If you do not specify a sequence value, Service Manager will process field names
alphabetically.

6. Click New. Service Manager creates the reconciliation rule.

Using join tables for reconciliation

When setting reconciliation rules, if the device type you are reconciling has a joindef definition (as
defined in the devtype table), use the join table name instead of the device table. For example, if
you want to reconcile computer Cls, use the joincomputer table instead of the device table.

Sequence of reconciliation

A reconciliation rule specifies what Service Manager table and field you want to search for matching
Cl values. It also specifies the sequence in which you want Service Manager to process
reconciliation rules. By default, Service Manager processes rules in alphabetical order by field
name. For example, Service Manager will reconcile Cls against the asset.tag field before
reconciling Cls on the ci.name field.

To change the order in which Service Manager reconciles Cls, you can add a numeric value to the
sequence field. For example, the following reconciliation rules ensure that Service Manager
processes Cls by the ci.name field prior to reconciling them against the asset.tag field.

Sample reconciliation rules ordered by sequence

Table Name Field Name Sequence
joincomputer ci.name 1
joincomputer asset.tag 2

A Discovery Event Manager (DEM) reconciliation rule allows you to specify which Service Manager
fields you want to use to determine if an existing Cl record matches a Cl ina UCMDB system. An
administrator typically specifies reconciliation rules prior to starting UCMDB data push jobs so that
Service Manager will not create duplicate Cl records.

To create a DEM reconciliation rule:
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1. Loginto Service Manager as a system administrator.

2. Navigate to Tailoring > Web Services > DEM Reconciliation Rules. Service Manager
displays the DEM Reconcile Record form.

3. InTable Name, type the name of the Service Manager table containing the field you want to
reconcile on.

4. InField Name, type the name of the Service Manager field containing the values you want to
reconcile on.

5. InSequence, type a number to specify what order you want Service Manager to run this rule.

Note: If you do not specify a sequence value, Service Manager will process field names
alphabetically.

6. Click New. Service Manager creates the reconciliation rule.

Add Discovery Event Manager Rules

Service Manager uses the Discovery Event Manager (DEM) to define which actions the system
should perform when the actual state of an incoming configuration item (CI) record differs from the
managed state of a Cl record in HP Service Manager. The DEM rules allow you to define whether

the Service Manager system adds, updates, or deletes Cl records based on incoming UCMDB
data.

For Cl records only, the DEM rules also allow you to define how Service Manager should handle
duplicated logical names.

This section includes:

¢ "DEM Rules" below

e "Duplication Rules" on page 134

o "ClI Attributes Displayed in Change and Incident Records" on page 135

o "Searching for Change and Incident Records Opened by the Integration" on page 135

DEM Rules

Service Manager offers the following rules options:

Action if matching record does not exist

This is the action you want Service Manager to take if it cannot find a matching Cl record.
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o Add the record:(Default) Service Manager will add a Cl record when it cannot find a matching
record. See "How to Add DEM Reconciliation Rules" on page 128 to define what fields Service
Manager uses to match ClI records.

« Add the record, and set dependency as true: This option is available only for synchronization
of Cl relationship data. Service Manager adds the CI relationship record and enables outage
dependency for the record by doing the following:
= Checks the Outage Dependency check box;

= Sets the number of dependent downstream Cls to 1. This is because UCMDB only supports
one-to-one ClI relationships.

Configuration Item Relationship

Upstrearn CI: |'E—mai| / WWebmail (ELrope) | = |Q |
Relationship Narme: |'E—mai| / Wehmail (Europe) Service |
Relationship Type: Contains |v | e |
Dowenstream Cls: adv-eur-server-rmail

Microsoft Outlook

Outage Dependency

Outage Dependency

This Configuration Iterm will be considered down if

= or more of the supporting configuration items are down

« Open an Incident:Service Manager opens an incident for someone to review the new ClI record.
The incident enables someone to investigate whether the new CI record is compliant with your
business practices.

« Open a Change:Service Manager opens an unplanned change for someone to review the new
Cl record. The change allows you to investigate whether the new CI record is compliant with
your business practices. If the Cl record is compliant, the change can be approved. If the ClI
record is not compliant, then the change can be denied and the CI record removed. The change
record lists both the current and proposed attribute values.

Action if record exists but unexpected data discovered

This is the action you want Service Manager to perform if it does not find a matching CI attribute
value.
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« Open a Change: (Default) Service Manager opens an unplanned change to review the actual
state of the Cl record. The change allows someone to investigate whether the new attribute
value is compliant with your business practices. If the value is compliant, the change can be
approved. If the value is not compliant, then the change can be denied and the CI attribute value
reverted to its managed state.

¢ Log Results and update record:Service Manager logs the results of the actual state of the ClI
record, and then updates the Cl record.

« Open an Incident:Service Manager opens an Incident to investigate the actual state of a Cl
record and determines what actions must be performed or initiated to bring the record into
compliance with Service Manager.

Action if record is to be deleted

This is the action you want Service Manager to perform if an external event specifies that the record
needs to be deleted.

o Delete record: (Default for Cl Relationship records) This option is available for synchronization
of both Cl and CI Relationship records. Service Manager automatically deletes the CI/CI
Relationship record.

« Open an Incident: This option is available only for synchronization of Cl Relationship records.
Service Manager opens an incident to investigate the deleted record and determines which
actions must be performed or initiated to bring the record into compliance with Service Manager.

« Open a Change: This option is available only for synchronization of Cl Relationship records.
Service Manager opens an unplanned change to review the deleted record. The change allows
someone to investigate whether the deleted record is compliant with your business practices. If
the record is compliant, the change can be approved. If the record is not compliant, then the
change can be denied and the record added back to the system.

« Update record to the selected status: (Default for Cl records) This option is available only for
synchronization of Cl records. Service Manager updates the status of the Cl record to a value
selected from the drop-down list (for example, Retired/Consumed), rather than delete the
record permanently.

Note: Values available from the drop-down list are defined in the ICM Status global list.

« Open a Change to update record to the selected status: This option is available only for
synchronization of Cl records. Service Manager opens an unplanned change to update the Cl
record’s status to a value selected from the drop-down list (for example, Retired/Consumed).
The change allows someone to investigate whether the requested status change is compliant
with your business practices. Once the change has been approved and closed, Service Manager
automatically changes the Cl record to the selected status. If the change has been denied,
Service Manager makes no changes to the Cl record.
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« Open an Incident to update record to the selected status: This option is available only for
synchronization of Cl records. Service Manager opens an incident to update the record’s status
to a value selected from the drop-down list (for example, Retired/Consumed). Once the
incident has been closed, Service Manager automatically updates the ClI record to the selected
status.

Duplication Rules

UCMDB may create two completely separate yet legit Cl records that happen to have the same
“name”. The UCMDB name field is mapped to the logical.name field (which must be unique) in
Service Manager. Pushing the two CI records to Service Manager would cause a duplicate logical
name problem. You have several ways to avoid this problem. See the following table.

Solutions to the duplicate logical name problem

Product
side Solution

UCMDB ' Change the names directly in UCMDB or change the UCMDB reconciliation rule to
make sure the names are not the same.

This is highly recommended.

In the integration adapter mapping configuration (xslt) file, avoid mapping the UCMDB
name field to the SM logical name field directly in either of these ways:

e Map another UCMDB unique attribute to the SM logical.name field, and map the
UCMDB name field to another SM field;

o Add a prefix to the name. The following are examples.
= UCMDB switches or routers are simply named as “Router” or “Switch” and
identified by their underlying MACs. You can configure their “SM logical name”
to be “<MAC> + <name>".

= UCMDB databases often have the same name (due to the implementation of
clusters and Oracle RACs). You can configure their “SM logic name” to be “<full
DNS name> + <name>".

Service | Use the duplication rule options in DEM Rules in Service Manager.
Manager

Service Manager offers the following duplication rule options on the Duplication Rule tab in each
DEM rule with a Table Name other than “cirelationship”:

« Action if logical name is duplicated (Cl with different uCMDB ID): This is the action you
want Service Manager to perform if the logical name is already used by another Cl record when a
Cl record is added or updated.
= Rename to <name>_[RENAMED]_1/2/3: (Default) Service Manager changes the logical

name by adding a suffix.

= Return Error: Service Manager returns a duplicate key error to UCMDB.
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Cl Attributes Displayed in Change and Incident Records

Service Manager displays a Change Details section on the corresponding change ora CMDB
Changes section on the corresponding incident when you configure DEM to open either change
records or incident records when it discovers Cl attribute changes through the UCMDB-SM
integration. Service Manager only displays a tab for Cl attributes when the UCMDB-SM integration
is enabled and you have defined a rule in the Discovery Event Manager to create a change or
incident record when a Cl is added, updated, or deleted.

Both the Change Details and CMDB Changes sections display the current Cl attribute values
alongside the actual attribute values discovered by UCMDB. You can use this information to
approve or deny a change or escalate an incident to the proper assignment group.

Searching for Change and Incident Records Opened by
the Integration

You can use the following search criteria to find change and incident records opened by the
UCMDB-SM integration.

Search options available for change and incident records

Record type Search option available
Change Search for records with the category unplanned change.

Incident Search for records using the generated by the UCMDB integration option.

How to Add a Cl Attribute to the Integration for Data
Push

You can use the following steps to add a Cl attribute to the integration.

1. Does the Cl attribute already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.

2. Add the ClI attribute to the UCMDB class model.
See "How to Add the CI Attribute to the UCMDB Class Model" on the next page.

3. Add the Cl attribute to the TQL layout.
See "How to Add the CI Attribute to the TQL Layout" on page 137.

4. Add the CI attribute to the Service Manager table.
See "How to Add the CI Attribute to the Service Manager Table" on page 139.
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5. Create aweb service field to support the Cl attribute.

See "How to Create a Web Service Field to Support the Cl Attribute" on page 140.

6. Add a managed field to monitor changes in the CI attribute.
See "How to Add a Managed Field to Support the CI Attribute" on page 142.

7. Map the ClI attribute to a web service field.
See "How to Map the CI Attribute to a Web Service Field" on page 144.

How to Add the CI Attribute to the UCMDB Class Model

The integration only uses a subset of the CI attributes available from your UCMDB system. Out-of-
the-box, the integration consists of Cl attributes that are typically managed from a Service Manager
system such as host name and host DNS name. Before creating a new UCMDB CI attribute, you
should determine if there are any existing Cl attributes in your UCMDB system that provide the
data you want. In most cases, there is an existing attribute tracking the data you want to add to the
integration. For example, if you review the attributes of the Node ClI type, you see that there are
many attributes available to be added to the integration.

Dependencies || Details || Attributes | Gualifiers

Cl Types
»»
Cl Types x| o P #1 This page enables you to edit the attributes of the Cltype.

5 Managed Chject (318)

(=] Activity Log (1)

(@] ssset @)

— Attachmert (0)

—[®] Budaet 1)

—[®] BudgetLine (0)

— Business Okjective (0)

=) Configurationttem (316)

I:I—'C;| BuszineszElement (103}
E-[d] CiCollection (0)

[&9] InfrastructureElement (713)
Application Resource (0)
ApplicationSystem (0)
CommunicationEndpoint (0)
': Datacenter Resource (0)
MetworkEntity (16)

& Mode (696)

Mode Element (1)

'u' Purning Software (0)
UDDI Registry (0
—O Location {0)

E]— Wonitor (0)

() Party (0)

-

wa

+ & %X O|R

= Display Name Mame Type | Description | Default Walus Wisible Editable
ack_cleared_time ack_cleared_time lang W
ack_jd ack_jd string W
Actual Delete Time roct_actualdelstetime | date When will ...
Actual Deletion Period  root_actualdeletionp...  integer What is the... 40 W v
Admin State data_adminstate adminstate...  Admin State | Managed
Alow Cl Update data_allow_awuto_dis... boolean true W v
BiosAzsetTag bios_aszet_tag string Assettagn... v v
Bios SerialMumber bios_serial_number string A manufact. .. v v
Bios Uuid bios_Luid =tring A System .. W W
BODY_ICON BODY_ICON string host v
Calculated 1D calculated _id bytes Calculated ... L'
Calculated Location calculated_location string v v
Candidate For Deleti...  root_candidstefordel... | date When will ...
Change Corr State data_changecorrstate  changestat...  Change 5t..  No Change
Change Is New data_changeiznew boolean Change 5t... false
Change State data_changestate changestat... Change 5t.. No Change

4

The following steps illustrate how to add a new CI attribute to an existing CI type. This scenario is
not the expected typical case. Typically, you would add an existing CI attribute to the integration.

Note: The integration does not require any special steps to add a Cl attribute to the UCMDB
class model. You can use the standard ClI attribute creation procedures to add a Cl attribute.
For more information on ClI attribute creation, see the HP Universal CMDB CI Attribute

Customization Guide.

To add a ClI attribute to the UCMDB class model:
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10.

11.

12.

13.

Log into UCMDB as an administrator.
Navigate to Modeling > Cl Type Manager.

Select the Cl type to which you want to add a new CI attribute from the CI Types navigation
tree. For example, Configurationltem > InfrastructureElement > RunningSoftware >
Database.

Click the Attributes tab.

Click the Add button. *
The Add Attribute window opens.

In Attribute Name, type the unique name you want to use for the new CI attribute. For example,
database owner.

Caution: The name cannot include any of the following characters: ¥ / \ [ 1 : | <

>+ =g , 7 W
In Display Name, type the name you want UCMDB to display in the interface. For example,
Database Owner.

In Description, type a description of the new CI attribute. This is an optional field. For example,
System user who owns the database.

In Attribute Type, select either Primitive or Enumeration/List. For example, select Primitive
and select string.

In Value Size, type the maximum character length the attribute can have. For example, 300.

In Default Value, type the value to be used when no other value is available. For example,
leave the default value blank.

Click OK to save the attribute.

Click the Save button to save attribute changes to the Cl type.

How to Add the CI Attribute to the TQL Layout

To add a Cl attribute to the integration, you must add this attribute to the layout setting from the TQL
query that synchronizes the Cl type. You must know what Cl type contains the CI attributes you
want to add to the integration.

Keep a list of the attributes that you enable, because you will need to create a matching XSL
transformation for each attribute you enable.

To add a Cl attribute to the TQL layout:
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Log into UCMDB as an administrator.

Navigate to Modeling > Modeling Studio.

For Resource Type, select Queries.

From the Queries navigation tree, click Integration > SM Sync > 9.xx.

Select the query that manages the Cl type whose attributes you want to add to the integration.

For example, SM Computer Push. UCMDB displays the TQL for the integration query.

6. Select the node from the TQL layout that contains the CI attribute you want to add to the
integration. For example, Root.

7. Right-click the node and select Query Node Properties. The Query Node Properties window

opens.

8. Click Element layout tab. The Layout Settings tab opens.

9. Select the Cl attribute you want to include in the integration from the Available Attributes list,
and click the Add button to add it to Specific Attributes list. For example, OsVendor.

Attnibute || Cardinality || Element Type || Element Layvout || Identity

() No attributes
(®) Select attributes for layout

Cl Types

Conditions

Here you can define which attributes will be returned in the query result for this guery node.
You can choose to keep the default behavior, where sttributes are not returned inthe guery resutts or you can define the layout t

By BD @Treemew ~ @
EI—% Node %

% Cluster Resource Group
% Computer

—% HP Comple:x

—% HP MonStop

—% IBEM Frame

—% iSeries

—% LDOM Server
—E& Mainframe CPC
—% Mairframe Logical Partition
—% Terminal Server
—@ Unix

—E] vax

—% Wiware ESX Server
—@ Windows

—H zos

EI—% Met Device

& ATM Switch
L warconi ATM Switch

D Chassis
|—F|:TI Frirlmzire

|Legend: @ Al @ Specific Atributes

AftribLtes condition | Specific Attributes

Attributes with the following qualifiers:

Available Atributes

Specific Atributes

MNodeModel

Mote

Operation Corr Stat
Operation |5 Mew
Operation State
Qrigin
OsDescription
Os\Vendor

Owner Tenarnt
Reference to the cre
root_iconproperties
Snmp Sys Mame
State

Store KPI History Fe

- |

A m [x]

DizcoveredVendor =
Dizcovered DsMame
Dizplay Label
Global Id
Frimary Dz MName
Memaory Size
Default Gateway |pay «

Excluded Attributes
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10. Click OK to save the node properties.

11. Click the Save button to save the TQL query.

How to Add the CI Attribute to the Service Manager Table

The integration uses only a subset of the Cl attributes available from your Service Manager system.
Before creating a new Service Manager Cl attribute, you should determine if there are any existing
Cl attributes in your Service Manager system that provide the data you want. In most cases, there
is an existing attribute tracking the data you want to add to the integration. For example, if you
review the attributes of the Computer ClI type, you see that there are many attributes available to be
added to the integration.

Join Table Mame: |j|:|in|'||:||:|E |

Comman Mame: joinnode

| Edit Common Mame |

4 File Mames | < Field Names and Captions
Table Name I Field Names I Field Captions -
node node, addIPAddr Addl I P Addr
node node, addMacAddress Addl Mac Address
node node, bios.id Bios Id
node node, cpu Cpu
node node, disk.device Disk Device g
node node, file.system File System
node node, logical.name Logical Mame
node node,machine . name Machine Mame
node node, os.manufacturer Os Manufacturer
node node, os. version Os Version
node node, physical.mem. total Physical Mem Total
device device,ac.category Ac Category
device device,addl Addl
device device,admin.id Admin Id
device device,admin.password Admin Password
device device,admin.urlport Admin Urlport
device device, allow.subscription Allow Subscription
device device,asset. tag Asset Tag
device device,assignment Assignment
device device,auditDate Audit Date
device device,auditDescrepency Audit Discrepancy
device device,auditPolicy Audit Policy
device device,auditStatus Audit Status
device device,auditedBy Audited by

The following steps illustrate how to add a new CI attribute to an existing ClI type.

The integration does not require any special steps to add a Cl attribute to the Service Manager
table. You can use the standard table attribute creation procedures to add a Cl attribute. For more
information on table attribute creation, see the Service Manager help and Service Manager Tailoring
Best Practices Guide.
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To add a Cl attribute to the Service Manager table:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Database Dictionary.
3. InFile Name, type the name of the table where you want to add the new ClI attribute. For
example, node.
4. Click the Search button @
The node dbdict record opens.

5. Click the Fields tab.

6. Click the New Field/Key button.
The Add Attribute window opens.

7. InName, type the name you want to use for the new ClI attribute. For example,
os.manufacturer.

Caution: The name cannot include any of the following characters: ' / \ [ ] : | <
>+ =3 , 7 %

8. InType, select a type from the list. For example, select character.
9. Click the Add Field button to save the attribute.

10. Click the OK button to save attribute changes to the table.

How to Create a Web Service Field to Support the CI
Attribute

UCMDB uses the Service Manager ucmdblntegration web service to send Cl data. This web
service publishes the objects that match the out-of-the-box Cl types and Cl attributes provided by
the UCMDB-SM integration. For a list of the out-of-the-box web service fields and their mappings to
Service Manager tables, see "Managed Fields" on page 115.

If you add a Cl attribute to the integration on your UCMDB system, you must create a
corresponding web service field on your Service Manager system to receive the incoming Cl data
from UCMDB. Each web service field must map to a valid Service Manager table and column.

To create a web service field for the OSVendor attribute described in previous sections:
1. Loginto Service Manager with an administrator account.

2. Navigate to Tailoring > Web Services > WSDL Configuration. The External Access
Definition form opens.

3. For Service Name, type ucmdblintegration.
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4. Click Search. Service Manager displays a record list of the objects that make up the
ucmdblntegration web service.

5. Select an existing web service object to which you want to add the Cl attribute. For example,
select uemdbNode.

6. Click the Fields tab. Service Manager displays the fields published as web service fields.
7. Select an empty row in the Fields list.

8. ForField, select the Service Manager column name where you want to store the incoming Cl
attribute values. For example, os.manufacturer.

Note: Service Manager displays the fields from all join tables associated with the table
listed in the Name field. For example, for joinnode Service Manager displays the fields
from the device and node tables.

9. For Caption, type the name you want Service Manager to use when publishing the field as a
web service field. For example, OSVendor.

Caution: The Caption name must match the object name you listed in the XSL
transformation file in Universal CMDB, or Service Manager will not receive any Cl updates
from your Universal CMDB system.

10. Click Save.
The new web service field is available immediately; you do not need to restart the Service
Manager system.
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External Access Definition

Service Name: |'umdb1ntegraﬁon | [ released
Name: ﬁoinnode |v| O peprecated
Object Mame: |ucmdeode |
& Allowed Actions | & Expressions | & Fields |

Field | Caption | Type | :I

physical.mem. total PhysicalMemory

serial.no. SerialNo

wendor Vendor

cpu[cpu.id] CpulD

cpu[cpu.name] Cpulame

cpu[cpu. dock.speed] CpuClockSpeed

file.system[mount. point] MountPoint

file.system[disk. type] DiskType

file.system[file.system. type] FilesystemType

file.system[disk. size] DiskSize

asset.tag AssetTag

machine. name HostMame

id CIName

disk. device[model.name] ModelName

disk. device [disk. vendor] DiskVendor

disk. device [disk.name] DiskMName

o5 manufacturer 0sVendor

=

How to Add a Managed Field to Support the Cl Attribute

In order for a Cl attribute you add to the integration to trigger the automated Change Management
validation and verification processes, you must add a managed field for the ClI attribute. Service
Manager managed fields are part of the Discovery Event Manager Rules. For alist of fields that
trigger Change Management validation and verification, see "Service Manager Discovery Event
Manager Rules" on page 121.

To add a managed field to the integration:
1. Loginto Service Manager with an administrator account.

2. Navigate to Tailoring > Web Services > Discovered Event Manager Rules. Service
Manager displays a record search/creation form.

3. Click Search to display a list of all Discovery Event Manager rules.
4. Selectthe rule ID that matches the web services object where you mapped the

incoming Cl attribute. For example, ucmdbNode. See "How to Create a Web Service Field
to Support the CI Attribute" on page 140.
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Service Manager displays the rules for this web service object.

5. Click the Managed Fields tab. Service Manager displays the list of fields that trigger Change
Management validation and verification.

6. Select an empty row in the Managed Fields list.

7. ForField Name, select the caption name of the Service Manager column that you previously
selected to store the incoming ClI attribute values. For example, Os Manufacturer.

Note: Service Manager displays the fields from all join tables associated with the table
listed in the Table Name field. For example, joinnode displays fields from the device and
computer tables.

Tip: If you want to add all fields that are exposed in the WSDL definition, you can click the
Load Fields button. For more information, see "How do | Use the Load Fields Button to
Add Multiple Managed Fields" on page 104.

8. If thefield you use to store the incoming Cl attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Os Manufacturer is a primitive character field and therefore does not need to identify an array
of structure name.

9. If the field you use to store the incoming Cl attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example, Os
Manufacturer is a primitive character field and therefore does not need to identify an array of
structure index.

10. Click Save.
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Discovery Event Manager Rules

Id: [uemdbode |
Table Mame: |joir1nnde |

Condition: |

& Rules | < Managed Figlds | & Inddent Customization | & Change Customization | < Duplication Rule

Load fields

Field Name | Structure | Index | Condition |i|
Serial Mo

Vendor

cpu.id cpu 1
CpU. name cpu 2
cpu.dock.speed cpu 3
mount.paint file.system 4
disk. type file.system 2
file.system. type file.system 1
disk.size file.system 3
Asset Tag

Machine Name

CI Name

model.name disk.device
disk.vendor disk.device 2
disk.name disk.device 3

Os Manufacturer

How to Map the CI Attribute to a Web Service Field

The integration uses an adapter to transform UCMDB CI attributes to web services objects
recognized by Service Manager. The adapter in turn specifies what XSL transformation files the
integration should use to convert UCMDB TQL queries into properly formatted Service Manager
web services messages.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular Cl type in UCMDB. In addition, each attribute for which you enabled calculation requires
its own entry in the XSL transformation file. Without an XSL transformation entry, Service Manager
cannot receive any Cl attribute updates from your UCMDB system.

If you want to add a new attribute to the integration, you must edit the XSL transformation file for the
parent Cl type and add an entry for the CI attribute. For information about which Cl types each
query manages, see "TQL Queries for Push" on page 111. In order to create a proper XSL mapping,
you must be familiar with the service and object names Service Manager publishes as web
services. For information on publishing tables and columns as web service objects, see the Service
Manager Web Services Guide available from the Service Manager help.
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The following steps illustrate how to map a UCMDB CI attribute called host_vendor to a Service
Manager web service object called OSVendor.

To map a ClI attribute to a web service field:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Double-lick the XSL transformation file that manages the parent Cl type of your Cl attribute.
For example, open computer_push.xslt to add an attribute to the SM Computer Push TQL

query.

4. Find the element that defines the Service Manager table name where the integration will store
Cl attribute values. For example, the element <file.device> will store Cl attributes in the
Service Manager device table.

5. Within the table naming element (<file.device>), you will see an element of the following format
that defines how to transform each UCMDB CI attribute into a web service object:

<xsl:for-each select="@CI_attribute_name">
<SMAttributeName><xsl:value-of select="."/></SMAttributeName>
</xsl:for-each>

@CI_attribute_name is the name of attribute in the UCMDB system.

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

Caution: The web service attribute name is case-sensitive.

Cl attributes in the computer_push.xslt XSL transformation file are illustrated in the following
screenshot:
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Q @E

51

[

1 <xsl:stylesheet versicn="1.0" xmlns:xsl="http://www.w3.o0rg/1999/X5L/Tranaform™>
<xsz]l:template match="/node">

<model>
<keys/>

<instance>
<file.device>

</file.device>
<file.node>

</file.node> _|
</instance>

</model>
</xsl:templates

Ik

<!-——import:cmdb root attributes.xsli-->
<Type>computer</Type>
<xzl:variable name="prefix" select=""Valuesgt:"'"/>
<xsl:variable name="suffix" select=""szlt;/Value'"/>
<Subtypes
<xzl:choose>
<xsl:when test="contains(@node role,concat ($prefix, "deskt
<xsl:when teat="foa_family™>
<xsl:value-of select="fos_family"/>
</xsl when=>
<usl:otherwise>Server</xsl:otherwise>
</xsl:choose>
</ Subtype>
<!--import:sm device common attributes.xslt-->
<!--import:asset mapping.xslt-—->
<!--import:location attribute mapping.xslt-->

i hirele e slele A e =T A |
1ng.xs5lt-->

ce mapping.Xsli-->
:filesystem map

<l--import:interfaces mapping push.xslt--»

[

il [r]

Geone

8] Cancel

Cl attributes in the sm_node_attributes.xslt XSL transformation file are illustrated in the
following screenshot:
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Q®EECE| o

1 <xsl:for-each select="fEname">

2 <HostHame>

3 <xsl:value-of zelect="."/ >
4 </HostHame>

5</xsl:for-each>

G <xzl:for-each select="[d:

7 <O5Versiomn»
g <xsl:ivalue-of zelect="."/>
9 </O05Version>

10 </x=s]l: for-each>

12 <PhysicalMemory>

13 <xsl:value-of zelect="."/ >
14 </PhysicalMemory>

15 </xs]l: for-each>

17 <BIOSId>

18 <xsl:ivalue-of zelect="."/>
19 </BIOSId>

20 </x=l: for-each>

11 «xsl:for-each select="Ememocry size™>

l6<xsl:for-each select="(Fbios_serial number":>

Matching CI attributes in the ucmdbNode web service are illustrated in the following screenshot:
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External Access Definition

Service Mame: [uemdbIntegration | O released
Mame: ﬁoinnnde |v| O peprecated
CObject Mame: ||_|m.j|;.N.;.de |
s Allowed Actions | “» Expressions | & Fields |

Field | Caption | Type |:|

location Location

addlPAddr [addIPAddress] AddIPAddress

addlIPAddr[addISubnet] AddiSubnet

addiMacAddress AddIMacAddress

bios.id BIOSId

operating.system 05

oS, version OSVersion

physical . mem, total PhysicalMemory

serial.na. SerialMo

wendaor Vendor

cpulcpu.id] CpulD

cpulcpu.name] CpuMame

cpulcpu.dock. speed] CpuClockSpeed

file.system[mount. point] MountPoint | |

file.system[disk. type] DiskType

file.system[file.system. type] FilesystemType

file.system[disk.size] DiskSize

asset. tag AssetTag

6. Copy an existing XSL transformation element to use it as a template to create a new
transformation entry.

7. Paste the new XSL transformation element within the proper table naming element. For
example, <file.node>.

8. Update the CI attribute name and web service object name within the new element to match
the attribute you want to add to the integration. For example, create the following XSL
transformation element to add an attribute to the integration.

<xsl:for-each select="@os_vendor">
<0SVendor»><xsl:value-of select="."/></0SVendor>
</xsl:for-each>

New attribute in the computer_push.xslt XSL transformation file is illustrated in the following
screenshot:
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QED E| &
& <file.device> A]
T <!--1mport:cmdb root attributes.xslt-->
il <Typercomputer</Type>
9 <xsl:variable name="prefix™ select=""Valuezgt;"'"/>
14 <xzl:variable name="suffix" select=""slt;/Value'"/>
11 <Subtype>
12 <xs3]1:choose>
13 <xsl:when test="contains(@fnode_role,concat ($prefix,’
14 <xsl:when test="Eos_Ifamily™>
15 <xsl:value-of zelect="@os family"/>
1la </x=s1:when>
17 <xsl:otherwise>3erver</xsl:cthervise>
g </x31:choose>
19 </ Subtype>
20 ri
21
22
23
24 </file.device>
23 <file.node> =
26 ="@os_
27 ey 1 1 4 = o=
B y I
29| <! —-1mport
30 «f-
3n <l-
32 <l-
33 «f-
34 <l--1
35 <ffile.node>
38 </instance>
37 </model>
38 </xsl:template>
39 </xsl:stylesheet>
-
4 ] [k

9. Save the XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a Cl Type to the Integration for Data
Push

You can use the following steps to add a Cl type to the integration.

1. Does the Cl type already exist in the UCMDB class model?
Yes. Go to Step 3.

No. Go to Step 2.
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2. Addthe Cl type to the UCMDB class model.
See "How to Add the CI Type to the UCMDB Class Model" below.

3. Add Cl attributes to the ClI type as needed.
See "How to Add a CI Attribute to the Integration for Data Push" on page 135.

4. Create a TQL query to synchronize the Cl type.
See "How to Create a TQL Query to Synchronize the Cl Type" on page 153.

5. Addthe Cl type’s attributes to the TQL layout.
See "How to Add the CI Type’s Attributes to the TQL Layout" on page 156.

6. Add the Cl type to Service ManagerService Manager.
See "How to Add the CI Type in Service Manager" on page 158.

7. Create web service fields to support the Cl type.
See "How to Create Web Service Fields to Support the Cl Type" on page 161.

8. Add managed fields to support the Cl type.
See "How to Add Managed Fields to Support the Cl Type" on page 163.

9. Map the Cl type’s TQL query to an XSL transformation file.
See "How to Map the Cl Type’s TQL Query to an XSL Transformation File" on page 165.

10. Map the Cl type’s attributes to web service fields.
See "How to Map the CI Type’s Attributes to Web Service Fields" on page 167.

11. Add custom TQL queries to integration data push jobs.
See "How to Add Custom TQL Queries to Data Push Jobs" on page 178.

How to Add the CI Type to the UCMDB Class Model

Before creating a new UCMDB CI type, you should determine if there are any existing Cl types in
your UCMDB system that provide the Cl attributes you want. In most cases, you can create links
to one or more existing Cl types to create a new logical Cl type for use by the integration.

The following steps illustrate how to create a new Cl type called SM RDBMS based on an existing
Cl type called database.

Note: The integration does not require any special steps to add a Cl type to the UCMDB class
model. You can use the standard CI type creation procedures to add a Cl type. For more
information on Cl type creation, see the HP Universal CMDB CI Attribute Customization
Guide.

To add a Cl type to the UCMDB class model:
1. Loginto UCMDB as an administrator.

2. Navigate to Modeling > Cl Type Manager.
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10.

1.

12.

13.

14.

15.

Select the base ClI type you want to use for your new CI type from the Cl Types navigation
tree: Managed Object > Configurationltem > Infrastructure Element > Running Software
> Database.

Click the New button
The Create Configuration Item Type window opens.

In Name, type the unique name you want to use for the new Cl type. For example, sm rdbms.

Caution: The name cannot include any of the following characters: * / \ [ ] : | <
> 4+ =92 , P ¥

In Display Name, type the name you want UCMDB to display in the interface. For example, SM
RDBMS.

In Description, type a description of the new Cl type. This is an optional field. For example,
Hosts running relational databases.

In Base Cl Type, verify that the proper base Cl type is selected. Your new Cl type will inherit
the attributes of the base Cl type you select here. For example, Database.

Click Next. The wizard displays a list of Cl attributes from the base Cl type.

Add, edit, or remove CI attributes as needed for the new ClI type. For example, accept the
default attributes inherited from Database.

Click Next. The wizard displays a list of qualifiers from the base ClI type.

Add or remove qualifiers as needed for the new CI type. For example, accept the default
qualifiers.

Click Next. The wizard displays a list of icons associated with the Cl type.

Select the icons associated with this Cl type. For example, accept the default abstract class
icon.

Click Next to add any menu item properties or label definitions as needed. For example, accept
the default settings from the base ClI type.
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16. Click Finish to create the Cl type.
=% PunningSoftware ()

2 Agent (0)

'a,,_,x ApplicationServer (0)

u Cluster Software (0)

a,,x Communication Server (0)
= Database (0)

— pB2 ()

—& MysaL @

—E=d MonStop SQLMX ()
— Oracle (0)

—[&] saL server (@)
—Q Sybaze (0)

17. Select your new Cl type from the tree. For example, SM RDBMS.

18. Browse to an existing Cl type you want to link to, and control-click it to add it to your selection.
For example, Node.

Note: Choose an existing Cl type that has the attributes that you want to be part of your
new logical Cl type.

19. Right-click one of the selected Cl types, and click Add/Remove Relationship. The
Relationships window opens.

20. Create an SM Link relationship from the existing CI type to the new CI type. For example, from
Node to SM RDBMS.

Note: You need to create a new SM Link relationship if it does not exist.
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AddIRemcwe Relationship x|

Relationships

Relationship...| Node — SM RDBMS | SM RDBMS —> ...
Responsibility
RFC Connecti...
Foute

SM LIME
Socket

System Links
Systern Monit..
Talk

TCP

100000rIcodd
1oo0oOoOogodnd

4

|
i

21. Click OK to create the relationship.

22. Click the Save button to save the Cl type.

How to Create a TQL Query to Synchronize the CI Type

The integration uses Topology Query Language (TQL) queries to gather Cl attribute values and
pass them to your Service Manager system. You must create a TQL query for any Cl type you add
to the integration. Any TQL query you create must conform to the "TQL Query Requirements"” on
page 114.

The following steps illustrate how to create a new TQL query called rdbmsData for the SM RDBMS
Cl type described in previous sections.

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.
3. From the Queries navigation tree, click Integration > SM Sync.

4. Right-click SM Sync, and select the New > Query.
The Query Definition window opens.

5. Find the ClI type that will be the root node of your query from the Cl Type Selector. This Cl type
is typically the one that provides the most attributes for the Cl. For example, Managed Object
> Configurationltem > InfrastructureElement > RunningSoftware > Database > SM
RDBMS.
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6. Drag the root Cl type from the Cl Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the Cl type.

Cluery Definition

NEEREIEAE

S

Shi RDEM=

eE]e Tl e '

7. Select the Cl type, and click Edit from the Information Pane. The Node properties window
opens.

8. Change the Element name to Root.

9. Click OK to save the node properties.
Query Definition

NEIEEIEIE

Foot

FleEle Tl e ®
(@
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10. Find any additional CI types you want to add to the query from the Cl Type Selector. These Cl
types typically provide additional Cl attributes. For example, Managed Object >
Configurationltem > Infrastructure Element > Node.

11. Drag the additional CI type from the Cl Type Selector and drop it into the empty Editing pane.
UCMDB displays the icon of the additional CI type.

Cuery Definition

Tn =

Fle Tl e =
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Mode
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e @

12. Create relationships between the Root Cl type and the additional Cl types as needed. For
example, create an SM Link between Root and Node.

a.

b.

e.

Select Root and control-click the additional Cl type. For example, Node.

Right-click one of the selected items, and click Add Relationship. The Add Relationship
window opens.

Select SM Link.
Type a Relationship Name. For example SM Link.

Click OK to add the relationship.

13. Repeat step 10 to step 12 for each additional Cl type you want to add to the TQL. For example,
SM RDBMS does not need any additional Cl types.
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Query Definition
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14. Click the Save button to save the TQL query.

15. In Query Name, type the unique name you want to use for the new query. For example,
rdbmsData.

16. In Description, type a description of the new query. This is an optional field. For example,
Query for hosts running relational databases.

17. Inthe folder tree, select the folder in which you want to save the TQL. For example, Root >
Integration > SM Sync.

18. Click OK. UCMDB adds your new query to the Queries list.

How to Add the CI Type’s Attributes to the TQL Layout

To add a Cl attribute to the integration, you must enable the calculation layout setting from the TQL
query that synchronizes the Cl type. Because you must enable calculation for each attribute you
want to add to the integration, you should be familiar with the integration Cl types and the CI

attributes they contain.

Tip: Keep a list of the attributes you enable, because you will need to create a matching XSL
transformation for each one.

The following steps illustrate how to enable calculation for attributes of the SM RDBMS Cl type
described in previous sections.

To add a Cl type’s attributes to the TQL layout:
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1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.
3. From the Queries navigation tree, click Integration > SM Sync.

4. Select the query that manages the Cl type whose attributes you want to add to the integration.
For example, rdbmsData. UCMDB displays the TQL for the integration query.

5. Select the Root node from the TQL layout, and then click the Edit button from the Information
Pane. The Node properties window opens.

Caution: Your integration query must contain a node called Root. See "TQL Query
Requirements" on page 114 for more information.

6. Click the Element Layout tab, and select the option Select attributes for layout.

7. Select Specific Attributes from the Attributes condition list, and from the Available
Attributes list select each Cl attribute you want to add to the Specific Attributes list. For
example, select the Product Name, Application Version Description, Vendor, Version,
Description, The Database Instance Name, and Port attributes.

B Query Node Properties x|

Query Mode Properties

Enables you to add attributes, cardinality, qualifiers and Cl specific conditions

Elemenrt name: Element type;
Root | | SM RDBMS v| Show elemert in query resutts 'Em

Aftnbute || Element Type || Element Lavout || |dentity

Here you can define which attributes will be returned in the query result for this guery node.
You can choose to keep the default behavior, where attributes are not returned in the query results or you can define the layout to include or exclude attributes int

O No attributes
@' Select attributes for layout

Cl Types Conditions

oy BS | [E) Tree View - @
—(J sM ROBMS G

Aftributes condtion | Specfic Aftributes [=]

Atributes with the following qualifiers:

Available Atributes Specific Attributes
ack_cleared_time — |§| Display Label
ack_id — ProductMame
Actual Delete Time = |£| Wersion
Actual Celetion Period ‘Wendor
Admin State Part
Allow C| Update |§| The Database instance name
lication Categor =
|Legend: @ al ﬁ% Specific Attributes “pp gory fa=l v]
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10.

11.

12.

13.

14.

15.

Click OK to save the query node properties.

Select any additional nodes that contain ClI attributes you want to add to the integration. For
example, Node.

Click the Edit button from the Information Pane. The Node properties window opens.
Click Element Layout tab, and select the option Select attributes for layout.

Select Specific Attributes in Attributes condition, and from the Available Attributes list select
each ClI attribute you want to add to the Specific Attributes list. For example, select attributes
for the OS Vendor, and name attributes.

Click OK to save the query node properties.

Repeat step 9 to step 13 for each additional node that contains CI attributes that you want to
add to the integration.

Click the Save button to save the TQL query .

How to Add the CI Type in Service Manager

Before creating a new Service Manager Cl type, you should determine if there are any existing Cl
types in your Service Manager system that provide the CI attributes you want. In most cases, you
can reuse the existing Cl types for the integration.

The integration does not require any special steps to add a Cl type to Service Manager. You can
use the standard CI type creation procedures to add a Cl type. For more information on Cl type
creation, see the HP Service Manager online help.

To add a new ClI type in Service Manager:

1.

2.

3.

4.

5.

Create a table for storing the specific attributes of this new ClI type.

Create a join definition to join the device table.

Create an erddef definition that defines a relationship between the two tables.
Create a view form and a bulk update form for the new CI type.

Add the Cl type.

The following steps illustrate how to create a new Cl type called RDBMS.

Note: This example is provided only as an illustration of the steps. The best practice is to
reuse the existing Service Manager Cl| type RunningSoftware to map with UCMDB ClI type
SM RDBMS.

To create a table in Service Manager:
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1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Database Dictionary.

3. InFile Name, type the table name you want to add. For example, rdbms.

g L

4. Click the New button B=_H
5. Click the Fields tab.
6. Click the New Field/Key button. The Add Field window opens.

7. InName, type a field name you want to add. For example, 1ogical.name, whichis
mandatory for joining the device table.

Caution: The name cannot include any of the following characters: ' / \ [ 1 : | <
>4+ =2 , P %

8. InType, select a type from the list. For example, select character.

[
9. Click the Add Field button to save the attribute.

10. Repeat step 7 to step 9 for each attribute you wish to add. For example, dbinstance and
port.

11. Click the Keys tab.

12. Place the cursor on the first line of the structure, and click the New Field/Key button. The Add
Key window opens.

13. InType, select unique from the list.

14. In Fields list, type the name of a field that you want to use as the unique key. For example,
logical.name.

-
15. Click Add Key button to save the key.
16. Click the OKbutton to save attribute changes to the table.
To create ajoin definition in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Database Manager.

3. InTable, type the table name joindefs.
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4. Click the Search button @
5. InJoin Table Name, type a name for the join definition. For example, §oinRDBMS.
6. InFile Names, select the names of the tables to join. For example, device and rdbms.
7. Click Add to save the join definition.
To create an ERD definition in Service Manager:
1. Loginto Service Manager as a system administrator.
2. Navigate to Tailoring > Database Manager.

3. InTable, type the table name erddef.

4. Click the Search button @
5. InFirst Filename, type the name of the first table of the join definition. For example, device.

6. In Second Filename, type the name of the second table of the join definition. For example,
rdbms.

7. InRelationship type, select a value from the list. For example, One to One.

8. InField Names from First Filename, add the unique field name of first table. For example,
logical.name.

9. InField Names from Second Filename, add the unique field name of the second table. For
example, logical.name.

10. Click the Add button to save the ERD definition.

To create forms for view and bulk update in Service Manager:

Create a view form named configurationltemRDBMS, and a bulk update form named
device.rdbms.bulkupdate.

You can create them in Forms Designer based on existing view forms and bulk update forms. To
view the form names of an existing Cl type in Service Manager, click Configuration Management
> Resources > Device Types > Search, and then open the CI type record.

To access Forms Designer in Service Manager, type £d in the command line or go to Tailoring >
Forms Designer.

For more information about creating forms in Service Manager, see the Service Manager 9.31 online
help and the Tailoring Best Practices Guide.

To add a Cl type to Service Manager:
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1. Loginto Service Manager as a system administrator.

2. Navigate to Configuration Management > Administration > Add New Device Type, and
click Next.

3. InDevice Type Name, type a descriptive name for the new CI type. For example, RDBMS.
4. InDevice Type, type a name for the new ClI type. For example, rdbms.
5. Click Next.

6. InView Form, type the name of the view form you created for the new ClI type. For example,
configurationItemRDBMS.

7. InBulk Update Form, type the name of the bulk update form you created for the new Cl type.
Forexample, device.rdbms.bulkupdate.

8. Click Next.

9. In Attribute File, select the table you created for the ClI type. For example, rdbms.
10. Click Next.
11. Click Next to keep the default setting for Fields Specific to the Attribute File.

12. InJoin Def Record, select the join definition you created for this Cl type. For example,
joinRDBMS.

13. Click Next.

14. In Subtypes, add necessary subtypes for the Cl type. For example, Oracle and SQL
Server.

15. Click Next.
16. Check the Activate Device Type check box.

17. Click Next to save the new Cl type.

How to Create Web Service Fields to Support the CI Type

In order to add a Cl type to the integration, you must create a Service Manager web service object
for each Cl attribute for which you created an XSL transformation on the UCMDB system. Service
Manager uses the web service object to determine which Service Manager table and column to
store the incoming ClI attribute values.

The following steps illustrate how to create a web service object necessary to support the SM
RDBMS CI type described in previous sections.
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Note: This example of creating a new web service object (ucmdbRDBMS) is provided only as
anillustration of the steps. The best practice is to reuse the existing Service Manager web
service object ucmdbRunningSoftware to map with Universal CMDB CI type SM RDBMS.

To create web service fields to support your new Cl type:
1. Loginto Service Manager with an administrator account.
2. Navigate to Tailoring > Web Services > WSDL Configuration.
3. InService Name, type ucmdbIntegration.

4. In Name, select the name of the join file you have created for the new Cl type. For example,
joinRDBMS.

5. In Object Name, type a name. For example, ucmdbRDBMS.

6. Click the Allowed Actions tab, and specify the actions as shown in the following figure.

Service Name: {ucmdblntegration | [ Released
MName: ininRDBMS | u [ Deprecated
Object Name: uemdbRDBMS

@ Allowed Actions | ¥ Expressions | % Fields

Allowed Actions Action Names Action Type Custom Action To Perform
save Update Create anly Discavery Event Manager
delete Delete Application Pass Through Discovery Event Manager
add Create Create only Discavery Event Manager

Caution: For UCMDB integration WSDL configurations, be sure to use the “Create only”
action type for the “add” and “save” actions, and “Application Pass Through” for the “delete”
action. For more information about the action types, see the Service Manager 9.31 Web
Services Guide.

7. Click Add to create the WSDL configuration.

8. Click the Fields tab, select fields from the list and type a caption for each of them, as shown in
the following figure.
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9.

External Access Definition

Service Name: F.lu‘ndb.iduu‘ndblnhegraﬁnn | O released
Name: fioinRDBMS [+] [ Deprecated
Object Mame: |ucmdbRDBM5 |

i Allowed Actions | “ Ewpressions | g Fields |

Field | Caption | Type
ucrndb.id UCMDEId

ci.name Applicationiame

type Type

subtype SubType

company CustomerId

logical.name Clldentifier

product.version = ProductVersion

wendor Vendor
Version Version
id CIMame
dbinstance DBInstance

port Part

B

EdESEI’iptiDI’I

Click Save to save WSDL configuration changes.
The new web service fields are now available to the integration.

How to Add Managed Fields to Support the CI Type

In order for your custom CI type to trigger the automated Change Management validation and
verification processes, you must add a managed field for each Cl attribute within your Cl type.
Service Manager managed fields are part of the Discovery Event Manager Rules. For a list of fields
that trigger Change Management validation and verification, see "Service Manager Discovery
Event Manager Rules" on page 121.

The following steps illustrate how to add the managed fields for the SM RDBMS ClI type described
in the previous sections.

To add managed field to support your Cl type:

1.

2.
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Log in to Service Manager as a system administrator.
Navigate to Tailoring > Web Services > Discovered Event Manager Rules.

InID, type the ID you want to create for the new Discovered Event Manager Rule. For
example, ucmdbRDBMS.

In Table Name, select the table or join definition you want to associate to the new Discovered
Event Manager Rule. For example, joinRDBMS.
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5. Click New.
6. Click Next.

7. Click the Managed Fields tab.

Note: The list of fields you will add here will trigger Change Management validation and
verification.

8. Select an empty row in the Managed Fields list.

9. For Field Name, select the caption names of the Service Manager fields that you previously
selected to store the incoming ClI attribute values. See "How to Create Web Service Fields to
Support the CI Type" on page 161.

Note: Service Manager displays the fields from all join tables associated with the table
specified in the Table Name field. For example, for the joinRDBMS table, the fields from
the device and rdbms tables are available from the Field Name list.

Tip: If you want to add all fields that are exposed in the WSDL definition, you can click the
Load Fields button. For more information, see "How do | Use the Load Fields Button to
Add Multiple Managed Fields" on page 104.

10. If the field you use to store the incoming CI attribute is an array of structure, use the Structure
field to select the name of the array of structure where the column can be found. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure
name.

11. If the field you use to store the incoming Cl attribute is an array of structure, use the Index field
to select the index number that identifies the column in the array of structure. For example,
Vendor is a primitive character field and therefore does not need to identify an array of structure
index.
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12. Click Save.

Discovery Event Manager Rules

Id: [uemdbRDEMS |
Table Mame: |joir1RDBMS |

Condition: |

& Rules | ¢ Managed Fields | < Incdent Customization | % Change Customization | < Duplication F

Load fields

Field Mame | Structure | Index

CI Identifier
Service Mame
Product Version
Vendor

Version
Dbinstance
Port

How to Map the CI Type’s TQL Query to an XSL

Transformation File

The integration uses a configuration file called smSyncConfFile.xml to map each Universal CMDB
TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, you must add a mapping entry for each TQL query in the configuration file.

The following steps illustrate mapping the TQL query rdbmsData described in previous sections to

the Service ManagerucmdbRDBMS web service.

Tip: Wildcard support for TQL names in smSyncConfFile.xml

When adding a TQL name in the smSyncConfFile.xml file, you can use a wildcard (an
asterisk) in the TQL name. This is helpful in the debugging phase when you may have updated
an out-of-the-box TQL query and saved it as several TQL names. For example, if you have
saved the <TQL_name> query to <TQL_name>_1, and <TQL_name>_2, you can specify the
TQL name as <TQL name>* in the configuration file, and the integration will automatically use

this mapping entry on all of the three TQLs.

Note: Out-of-the-box, all TQL names in the smSyncConfFile.xml file are suffixed with a

wildcard (an asterisk).

To map a TQL query to an XSL transformation file:
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1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Click the smSyncConfFile.xml file.

4. Add a TQL mapping element to the file by copying an existing one. A TQL mapping element
uses the following format:

<tql name="TQL_query" xslFile="XSL File">

<!-- Description of mapping -->

<request type="Create" name="Create web_service"/>
<request type="Update" name="Update web_service"/>
<request type="Delete" name="Delete web_service"/>
</tql>

TQL_query is the name of the UCMDB TQL query you created.

XSL_F1ileis the name of the XSL transformation file the integration will use to map Universal
CMDB attributes to Service Manager web service fields.

Create_web_service is the name of the Service Manager web service you want to the
integration to use to create Cls from this TQL query.

Update_web_service is the name of the Service Manager web service you want to the
integration to use to update Cls in this TQL query.

Delete web_service is the name of the Service Manager web service you want to the
integration to use to delete Cls from this TQL query.

See the following screenshot for an excerpt of smSynchConfFile.xml:
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Rezourcedizscovery Config FileziService Manager Adapter9-xizmSync ConfFile.xml

QEDE| &

<tgl 1:T=—"SF Runnlng Sc tware Fush*" ‘Sl*llﬁ—"EUHHIHQSE ftware push.x3lt™»

[N s ]

e= reateucmdbRunnlngSc ftwareRequest™ />
e="TpdateucndbRunningSoftwareRequest™ />
e="DeleteucndbRunningSoftwareRequest™ />

e

<request Lype= Create"” na
<request type="Update™ nam
<request type="Delete™ nam
</tgl>
{tql J‘Tﬁ—"SF Bu31ness Service Push*" ‘Sl‘llﬁ—"bUSIHESS _aervice_push.xslt">

L Pl Pd Pd P3RS RS RS R R
DD D0 -] B O s L R

<request u;pﬂ—"“reate" 1=T=—"”reatEucmdeu31nessSEercERequest"!b
<request type="Update” name="UpdateucmdbBusinessServiceRequest™/>
<request type="Delete™ name="DeleteucmdbBusinessServiceRegquest™/>
</ tgl>
31 <tgl name="35M _cmputer Push*" x31lFile=" ccmputer_push x3lt">

32 «l-- this is host->ip,interface,sm server tgl --»

33 <request type="Create" nams=" ureateucmdecdeRequest "=
34 <request type="Update”™ name="UpdateucmdbNodeRequest™/ >
35 <request type="Delete” name="DeleteucmdbNodeRequest™ /=
36 </ tgl>

37 «<tgl name="S5M Switch Push*" x3lFile="switch_push. xslt">

kT:] <l-- this is netprinter-»ip,interface,sm printer tgl -->

39 <regquest v;pn—"Create" 1=Te—"CreateucmdecdERequest"f>

an OSSPSR SIS || o P PRRTRPE | JSISESSI | | u (P PRRPSRENESE  , | NPT PR, o PRSSSpR |R L,

5. Add or update TQL mapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates a mapping between the rdbmsData TQL query and the
rdbms_push.xslt file.

<tgql name="rdbmsData" xslFile="rdbms push.xslt">

<!-- this is database tql -->

<request type="Create" name="CreateucmdbRDBMSRequest"/>
<request type="Update" name="UpdateucmdbRDBMSRequest"/>
<request type="Delete" name="DeleteucmdbRDBMSRequest"/>
</tql>

6. Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the Cl Type’s Attributes to Web Service
Fields

The integration uses the Service Manager Adapter to transform UCMDB ClI attributes to web
services objects recognized by Service Manager. The Service Manager Adapter Service Manager
Adapter uses XSL transformation files to convert UCMDB TQL queries into a properly formatted
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Service Manager web services messages. Out-of-the-box, each integration query has a
corresponding XSL transformation file. In addition, each attribute you enable for synchronization
from Advanced layout settings requires its own entry in the XSL transformation file.

If you want to add a Cl type to the integration, you must create a matching XSL transformation file
that defines how the Service Manager Adapter transforms each Cl type into a Service Manager web
service object. See "Integration TQL Queries" on page 110 for information about which CI types
each query manages. In order to create a proper XSL mapping, you must be familiar with the
service and object names Service Manager publishes as Web services. See the Service Manager
help for information on publishing tables and columns as Web service objects.

The following steps illustrate creating an XSL transformation file for the rdbmsData TQL query
described in previous sections.

Tomap a Cl type’s attributes to web service fields:
1. Loginto UCMDB with an administrator account.

2. Navigate to Data Flow Management > Adapter Management.

3. Click the Create New Resource button
4. Select New Configuration File.
5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms push.xslt

7. Copy the content of an existing XSL transformation file (for example, runningsoftware_
push.xslt)to the new XSL transformation file.

8. Find the CI type definition element in the new file. The CI type definition element uses the
following format:

<xsl:template match="/CI_type name">

CI_type_ name is the name of Cl type in the UCMDB system.
The following is an example from the runningsoftware_push.xslt file:
<xsl:template match="/running_software">

9. Update the CI type name to match the CI type you want to add to the integration. For example,
create the following CI type definition element to add the database CI type to the integration.

<xsl:template match="/sm_rdbms">

10. Add or update table naming elements as needed. By default, UCMDB sends ClI attribute data
to the Service Manager device table. If you want to send Cl attributes to one of the join tables
of device, you must add an element to specify the table name using the format <file.table
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11.

name>. For example, you do not need to specify an additional jointable to define a database CI
type since Service Manager does not use a separate jointable to manage database ClI types.

Find the elements that transform UCMDB CI attributes into Service Manager web service
fields. The ClI attribute transformation elements use the following format:

<xsl:for-each select="@CI_attribute_name">

<WSFieldName><xsl:value-of select="."/></WSFieldName>

</xsl:for-each>

@CI_attribute_name is the name of attribute in the UCMDB system.
WSFieldName is the name of a web service field published by the Service Manager system.

The following figures show an example. Cl attributes in runningsoftware_push.xslt shows one
Cl attribute named product_name is mapped to a web service field with a caption of
ApplicationName; Mapping Cl attributes in the ucmdbRunningSoftware web service object
shows the web service field name and caption defined in the ucmdbRunningSoftware web
service object; Mapping CI attributes in the UCMDB RunningSoftware Cl type shows how the
product_name attribute is mapped in the RunningSoftware ClI type in UCMDB.

See the following screenshot for Cl attributes in runningsoftware_push.xslt:

{t--import:cmdb_root_attributes.xslt-->
<Typerrunning_software{/Type>
<xsl:variable name="CIT" select="@bdmType'"/>
<{Subtype><xsl:value—of select="5CIT"/><{/Subtype>
<{xsl:For—-each select="5$CIlists/list[@name="CIType runningsoftware']">
{Subtype><xsl:value—of select="entry[Rucmdb=5CIT]/@sm"/><{/Subtype>
{/%sl:for-each>
<xs5l:variable name="fullDHSHame" select="nodes/node/@primary dns_name' />
{xs5l:for-each select="@display label">
{CIldentifier><{xsl:value-of select="5fullDHSHame"/> <{xsl:value—of sele
ct=""."/></CIldentifier>
{/%sl:for-each>
{xsl:For—each select="0Eproduct name'>
LapplicationHame>{xs] zvalue—of select="_"/>{/fpplicationMame>
{/%sl:for-each>
<xs5l:for-each select="Rapplication_version">
{ProductVersion><{xsl:value-of select=""_"/><{/ProductVersion>
{/%sl:for-each>
{#sl:for-each select="Euendor">
{Uendor><xsl:value—of select="."/>{/Vendor>
{/%sl:for-each>
<{¥sl:for-each select="GOversion">
{Version><{xsl:value—of select="_"/>{fUersion>
{/%sl:for-each>
<{/instance>
</modelf
</f#sl:template>

Refer to the following screenshot to map Cl attributes in the ucmdbRunningSoftware web
service object:
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External Access Definition

Service Mame:
Mame:

Object Name:

|'u|:mdb1ntegration |

FjE'u'iCE | - |

|uu‘nde‘.unning5c:ftu\'are |

i Allowed Actions | & Expressions | < Fields |

[ released
[ ceprecated

Field | Caption | Type
ucmdb.id LICMDBId

type Type

subtype Subtype
company CustomerId
logical.name ClIdentifier
product.version | ProductVersion
vendor Vendor

Version Version

id CIMame
description Description

Refer to the following screenshot to map Cl attributes in the UCMDBRunningSoftware Cl

type:
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Cl Types Dependencies || Detalls || Aftributes | Gualfiers | lcon || Attached Menu L
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12. Add or update ClI attribute transformation elements for each ClI attribute you want to add to the

integration. For example, create the following XSL transformation elements for the database Cl

type.

Sample XSL transformation elements for database Cls

UCMDBattribute

port

Sample transformation elements

<xsl:for-each select="@port">

<Port><xsl:value-of select="."/></Port>

</xsl:for-each>

database_dbsid

<xsl:for-each select="@database_dbsid">

<DBInstance><xsl:value-of select="."/></DBInstance>

</xsl:for-each>

description <xsl:for-each select="@description">
<Description><xsl:value-of select="."/>
</Description>

</xsl:for-each>

New attribute mappings in rdbms_push. xs1t are illustrated in the following screenshot:
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{xs5l:stylesheet version="1.0" xmlns:xs1=""http://uwuww. w3 _ org/1999/8SL/Transform >
<xsl:template match=""/sm_rdbms''>
<modelX
<keys/>
{instance>
{t——import:cmdb_root_attributes_xslt-->
{Type>rdbms</Type>
{xsl:variable name="CIT" select="BEbdmType"/>
<xs5l:for-each select="EbdmType*'>
<3ubtype><{xsl:value—-of select=""_"/>{/Subtype>
<fxs]l:for—each>
{xsl:for-each select="Rdisplay_label>
<CIlIdentifier><xsl:value—of select="_"/><{/Clldentifier>
</xsl:fFor—each?
<xsl:for-each select="G@product_name™>
{ApplicationName><{xsl:value-of select="_"/><{/ApplicationHame>
<fxsl:for-each?
{¥sl:for-each select="Eapplication_wersion">
¢ProductVersion><{xsl:value—of select="_"/></ProductUersion’
{fxsl:For—-each
{xsl:for-each select="Guendor">
<Uendor><xsl :value—-of select="_""/>{/Uendor>
<fxsl:For—-each
{xs5l:Ffor-each select="@version'>
<Uersion><{xsl:value—of select="_"/>{/Uersion>
{fxsl:For—each
{xsl:for-each select="Eport":
<Port><{¥sl:value-of select="_"/><{/Port>
<fRsl:for-each
{xs5l:for-each select="@database_dbsid">
<DBInstance><xsl:value-of select=""_"/><{/DBInstance’
£fRsl:zfor-each>
{xs5l:for-each select="Edescription">
{Description><{xsl:value-of select=""_"/><{/Description>
</xsl:for-each)]
{finstance>
</model>
{/xsl:template:
</fxslistylesheet:
— SELECT — 9 35,32

13. Save the new XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Add a Cl Type’s Relationship Types to the
Integration for Data Push

Once you have added a new ClI type to the integration and have created relationships between it
and other Cl types in UCMDB, for each of these relationship types you need to perform the
following tasks so that UCMDB can push the relationships to Service Manager.
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As an example, the following steps illustrate how you add a relationship type named Ownership
(between the Cost and CostCategory Cl types) to the integration for data push. These steps
assume that you have already added the Cost and CostCategory ClI types to the integration and
have created an Ownership relationship between them in UCMDB.

1. Add a mapping entry for each relationship type in the push relationship mapping definition file.
See "How to Add a Push Mapping Entry for Each Relationship Type of the CI Type" below.

2. Create a TQL query to push relationships of the CI type.
See "How to Create a TQL Query to Push Each Relationship Type of the Cl Type" on the next

page.

3. Map the relationship TQL to an XSL transformation file in the push configuration file.
See "How to Map Each Relationship Type TQL to an XSL Transformation File" on page 176.

How to Add a Push Mapping Entry for Each Relationship
Type of the CI Type

For data push, the SM_CIT Subtype_list.xml file defines how UCMDB relationship types are
mapped to SM ones.

Note: This XML file can be found from Adapter Management > ServiceManagerAdapter9-x
> Configuration Files.

If this file does not contain a mapping entry for a new relationship type, you need to add an entry for
it.

To add a push mapping entry for the Ownership relationship type:
1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

3. Double-click the SM_CIT Subtype list.xml file.

4. Gotothe RelationshipType list section, and add a mapping entry for Ownership.
<list name="RelationshipType">

<!--ucmdb is link display lable, ucmdbType is link type, sm is the relations
hip type.
compound link will use root_* as the lable -->

<entry ucmdb="Aggregation" ucmdbType="aggregation" sm="Aggregation" />

<entry ucmdb="Ownership” ucmdbType="ownership"” sm="Ownership" />
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</list>
Where:

ucmdb: the display name of the UCMDB relationship type (see Name and Display Name of
Ownership).

ucmdbType: the name of the UCMDB relationship type (see Name and Display Name of
Ownership).

sm: the name of the relationship type in Service Manager.

Name and Display Name of Ownership are illustrated in the following screenshot:

Cl Types
[ Relationships | Xo ml Bl General Details
E Managed Felationship () Mame:
[l]— Aggregation (0)
Membership (D) Display Name: | Ownership|
l— TimeBoundMembership (0) Scope:
Responsibility (0) '
I:—]— Buzinezz Links (0) Created By:
l— Prowider ©f () Description:
— Composition (1)
[—]— Connection (0)
Ownerzhip (0)
- Time Bound Connection (0) 4

5. Click OK to save thefile.
How to Create a TQL Query to Push Each Relationship
Type of the CI Type

Once you have created Cl Relationship types for the new Cl type, you must create a TQL query for
each relationship type to push it to Service Manager.

Note: Any TQL query you create must conform to the "TQL Query Requirements" on page 114.

To create a new TQL query called cost_costcategory_ownership_relation_push for Ownership
relationships between the Cost and CostCategory Cl types:

1. Loginto UCMDB as an administrator.
2. Navigate to Modeling > Modeling Studio.

3. Click New > Query. The Query Definition pane displays.
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4. From the Cl Type Selector, drag the Cost and CostCategory Cl types to the query pane.
5 Query 1* x

Query Defintion

tEE & X[

CosiCategory

pH =0 p
28
B

£

5. Create an Ownership relationship from Cost to CostCategory.
a. Click the Create Relationship button.

b. Click the Cost node, and drag the arrow from it to the CostCategory node.
c. Select Regular Relationship, and click OK.

d. Select Connection > Ownership, and click OK. An Ownership relationship is created
between the Cl types.
'Eﬁ Query 1* x]

Query Definition

NEERE £

' Cwnership T m

Cost
CostCategory

“« p =] @

6. Right-click the relationship arrow, and select Relationship Properties.

7. Change the element name from Ownership to Root (or a name starting with “Root_"), and then
click OK.
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— T W - - -

|£ Relationship Properties. u
@ Relationship Properties
= Enables you to add attributes, cardinality, qualifiers and Cl specific conditions
Element name: Element type:
| Roct| | | Ownership V‘ Show element in query resutts B Query Resut
[attribute || Element Tyoe || Element Lavout
+
NOT ( Criteria ) | andror

8. Click the Save button, and save the query as described in the following.

a. Enteraquery name. Forexample, cost costcategory ownership relation

push.

b. Select the Integration > SM Sync > 9.xx folder.

c. Click OK.

Ezl Save Query

Erter the query name and select a folder in which to save it

Cluery Mame | cost_costcategory _ownership_relation_push |

> s 1
ELJ—E Integration
Atriurn
CACMDB
Diata In
Service-Mow
SM Cuery
SM Sync

[

CRAT T

The TQL query is now created. You are ready to map this TQL to an XSL transformation file.

How to Map Each Relationship Type TQL to an XSL
Transformation File

Once you have created a TQL query for a relationship type, you need to map the TQL to an XSL
transformation file as described in the following steps.

Tip: Out-of-the-box, there is a common XSL transformation file (common_relations.xslt),
which is used for pushing all types of Cl relationships. For this reason, you do not need to
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create a new XSL transformation file; instead, you only need to map the new relationship TQL
query to this existing XSLT file.

1. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files.

2. Click the smSyncConfFile.xml file

3. Add an TQL mapping entry by copying an existing one for relationship push. For example, copy
the following TQL mapping entry.

<tql name="SM Layer2 Topology Relations Push*" xslFile="common_relations.xsl

t">
<request type="Create" name="CreateRelationship"/>
<request type="Update" name="UpdateRelationship"/>
<request type="Delete" name="DeleteRelationship"/>
</tql>

4. Change the TQL name to the name of the query you created for the relationship type. For
example, cost_costcategory _ownership_relation_push.

<tgql name="cost_costcategory_ownership_relation_push" xslFile="common_relati
ons.xslt">

<request type="Create" name="CreateRelationship"/>
<request type="Update" name="UpdateRelationship"/>
<request type="Delete" name="DeleteRelationship"/>

</tql>
5. Click OK to save the configuration file.

Now, you have added the new relationship type to the integration. Next, you need to add the new
relationship TQL query to a data push job (see the following figure and "How to Add Custom TQL
Queries to Data Push Jobs" on the next page).

Refer to the following screenshot to add a new relationship TQL query to a data push job:
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(&) Edit Integration Job M. EEX

ﬁ Edit Integration Job

Define the Integration Job detailz and scheduling information

Mame

Job Definition

+ X

Query Name | Allow Celetion

SM Storage Push

SM Switch Push

SM Met Printer Push

SM Cluster Push

SM Mobile Device Push
SM CRG Relations Push
5SM Local Printer Push
SM Mode Relations Push

| cost_costeategory _ownership_relation_push |

EREREEEEE

A

How to Add Custom TQL Queries to Data Push Jobs

In order for the integration to send your custom CI types and attributes to your Service Manager
system, you must add your custom TQL queries to the data push job between your Changes data
store and your Service Manager data store. The following steps illustrate how to add an custom
TQL query named rdbmsData, which is described in the previous sections.

To add custom TQL queries to a data push job:

1.

2.

10.

11.

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio.

Click the name of your Service Manager integration point. For example, SM Integration.
Click the Data Push tab.

Click the name of your data push job. For example, SM Configuration Item Push job.

Click the Edit button <.

Click the Add button. ¥

Click Integration > SM Sync > rdbmsData.

Click OK to add the custom query.

Enable the Allow Integration Job to delete removed data option for the query.

Click OK to close the Update Job Definition window.
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How to Add a Cl Attribute to the Integration for
Population

To add a Cl attribute to the integration for population, perform the following tasks:

1. Create aweb service field to support the Cl attribute.
See "Create a Web Service Field to Support the CI Attribute" below.

2. Map the ClI attribute to the web service field.
See "How to Map the CI Attribute to the Web Service Field" below.

Create a Web Service Field to Support the CI Attribute

UCMDB uses the Service Manager ucmdblntegration web service to retrieve Cl data from Service
Manager. This web service publishes the objects that match the out-of-the-box Cl types and ClI
attributes provided by the UCMDB integration.

If you want to populate an additional Cl attribute from Service Manager to your Universal CMDB
system, you must create a corresponding web service field on your Service Manager system to
provide the Cl data from Service Manager. Each web service field must map to a valid Service
Manager table and column.

For the steps of creating a web service field, see "How to Create a Web Service Field to Support
the CI Attribute" on page 140.

How to Map the CI Attribute to the Web Service Field

The integration uses an adapter to transform Service Manager web service fields to Universal
CMDB Cl attributes. The adapter in turn specifies what XSL transformation files the integration
should use to convert Service Manager web services messages into a properly formatted Universal
CMDB ClI and/or relationship.

Out-of-the-box, each integration query has a corresponding XSL transformation file that maps to a
particular Cl type in Universal CMDB. Without an XSL transformation entry, Universal CMDB
cannot receive any Cl attribute updates from your Service Manager system.

Unlike for the Push feature, you do not need to create real Topology Query Language (TQL) queries
for Population on the UCMDB server.

If you want to add a new attribute to the integration, you must edit the XSL transformation file for the
parent Cl type and add an entry for the Cl attribute. For information about which Cl types each
population query manages, see "Integration TQL Queries" on page 110. In order to create a proper
XSL mapping, you must be familiar with the service and object names that Service Manager
publishes as Web services. For information on publishing tables and columns as Web service
fields, see the Service Manager help.

The following steps illustrate how to map a UCMDB CI attribute called host_vendor to a Service
Manager web service field called OSVendor.

To map a Cl attribute to a web service field:
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1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Adapter Management.

3. Navigate to the Service Manager Adapter configuration files path: ServiceManagerAdapter9-
x > Configuration Files

4. Click the XSL transformation file that manages the parent ClI type of your CI attribute. For
example, open computer_population.xslt to add an attribute to the SM Computer Population
TQL query.

5. Find the element that defines the name of the Universal CMDB CI Type where the integration
will store Cl attribute values. For example, the element <ci class="node" > will store CI
attributes in the Universal CMDB Node CI Type.

6. Within the ci naming element (<ci class="node">), you will see an element of the following
format that defines how to transform each web service field into an Universal CMDB Cl
attribute:

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of attribute in the Universal CMDB system.

UCMDB_CI_attribute_type is the type of attribute of the Universal CMDB system which this
integration supports. Currently the following types are supported: String, StringList, Integer,
Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the Cl during
population if this attribute has an empty value (true: ignore; false: not ignore).

Note:
» A StringList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.
An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.

= Forinformation about time zone and date format configuration of the Date type, see

"How to Update the Time Zone and Date Format for the Integration Adapter" on page
28

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

Cl attributes in the computer_population.xslt file are illustrated in the following screenshot:
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1 «x=]l:stylesheet version="1.0" xmlns:xsl="http://wwWwW.Ww3.o0rg/1999/X5L/Transform™>

2 <xsl:template ch="/RetrieveucmdblodelListResponse™>

3 <topology>

4 <xsl:for-each select="instance">»

5 <xzl:variable n building™ ==l file.dewvice/Building™/>
L <xsl:variable n floor™ sel ile.device/Flocz"/>

7 <xsl:variable nam room” sele

a

9 <ci clazz="node™

10 <!- r T E but lation.xslt-->

11 <attribute
12 <attribute

"String"><x=sl:value-of selesct
"ItringT><xsl:value-of s=l

14 <attribute
15 <attribute
14a <attribute

17 <l-
8 <l
13 </cix
20 </xs=l:for-each>
21 </topology>
22 </xsl:templates>
23 =/xsl:stylesheet>
24

Refer to the following screenshot to match Cl attributes in the ucmdbNode web service object:

13 <attribute e="discovered o5 _name" type="String"»<xsl:value-of sslect=

External Access Definition

Service Name: LcmdbIntegration O released
Name: Joinnode |v O eprecated
Object Mame: |ucrndeode |
& Allowed Actions | 4 Expressions | & Fields |

Field | caption | Type [

location Location

addlIPAddr [addIIPAddress] AddiIPAddress

addlIPAddr[addISubnet] AddlSubnet

addiMacaddress AddMacAddress

bios.id BIOSId

operating.system a5

05, VErsian QsVersion

physical.mem. total PhysicalMemaory

serial.no. SerialNo

wendor Vendaor

cpulcpu.id] CpulD

cpucpu.name] CpuName

cpucpu.dock. speed] CpuClockSpeed

file. system[mount. point] MauntPoint | |

file.system[disk. type] DiskType

file.system[file system. type] FilesystemType

file.system[disk.size] DiskSize

asset.tag AszsetTag

7. Copy an existing XSL transformation element to use it as a template to create a new
transformation entry.
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8. Paste the new XSL transformation element within the proper table naming element. For
example, <ci class="node">.
9. Update the CI attribute name and web service field name within the new element to match the
attribute you want to add to the integration. For example, create the following XSL
transformation element to add the os_vendor attribute to the integration.
<attribute name="os_vendor" type="String"><xsl:value-of select="file.node/0S
Vendor"/></attribute>
New attribute in the computer_population.xslt file is illustrated in the following screenshot:
1 <xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/K5L/Transform">
2 <xsl:template match="/RetrieveucmdbNodelistResponse™>
3 <topology>
4 <xsl:for-each sslect="instance">
S <xsl:variable "building™ select="file.device/Building"/>
[ <xsl:variable e="floor" selec
T <xsl:variable name="room" select="file.device/Room"/>
; <ci class="node">
10
11 "file.device/DNSName"/></attribute>
12 <attribute n "concat ('Building:", &$building,
13 <attribute n discovered os_name" type="5tring"»<xsl:value-of select="file.device/053"/></attribute>
14 <attribute n default_gateway_ip address™ type="3tring"»<xsl:value-of = ="file.device/DefaultGatew:
15 <attribute n discovered_os_wversion" type="String"»<xsl:value-of sslect="file.node/05Version"/></attril
16 <attribute n memory size" type="Integer"><xsl:value-of select="file.node/PhysicalMemory"/></attribute:
17 }(attrj_bute n pe="3tring"><xsl:value-of select="£il jef0Sendor" /></fattribute>
18 <
15 <l --
20 <fcix
2 </usl: for-each>
22 </topology>
23 </xsl:template>
24 </x=sl:stylesheet>
25
10. Save the XSL transformation file.

When you create/edit and then save a configuration file in Adapter Management, UCMDB

automatically restarts the adapter with the new configuration file.

How to Add a CI Type to the Integration for
Population

You can use the following steps to add a Cl type to the integration for population.

1. Create a TQL query to populate the Cl type.
See "Create a TQL Query to Populate the Cl Type" on the next page.

2. Mapthe Cl type's TQL query to an XSL transformation file.

See "How to Map the Cl type's TQL Query to an XSL Transformation File" on the next page.

3. Mapthe Cl type's attributes to web service fields.
See "How to Map the CI Type's Attributes to Web Service Fields" on page 188.

HP Universal CMDB (UCMDB 10.10, CP 13.00)

Page 182 of 256



Universal Discovery Content Guide - Service Manager Integration
Tailoring the Integration

Create a TQL Query to Populate the Cl Type
Unlike for push, for population the integration does not require you to create custom Topology Query
Language (TQL) queries in Universal CMDB to save Cl attribute values.

The population feature only needs the smPopConfFile.xml file and population XSL transformation
files to synchronize CI/CI Relationship types and attributes; however for each CI/Cl Relationship
type you still need to define a TQL mapping in the smPopConfFile.xml file, and the TQL query does
not necessarily have to existin UCMDB. It is simply a query name, which will appear in the query
list when you add queries to a population job.

HP still recommends you to create TQL queries to help you better understand what Cl types or
attributes are part of population. For information on how to create a TQL query in UCMDB, see
"How to Create a TQL Query to Synchronize the Cl Type" on page 153.

How to Map the Cl type's TQL Query to an XSL
Transformation File
The integration uses a configuration file called smPopConfFile.xml to map each Universal CMDB

TQL query to an XSL transformation file. In order for custom TQL queries to be part of the
integration, you must add a mapping entry for each TQL query in the configuration file.

To map the TQL query rdbmsData described in previous sections to the Service
ManagerucmdbRDBMS web service:

Tomap a TQL query to an XSL transformation file:
1. Loginto UCMDB with an administrator account.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. Add a TQL mapping element by copying an existing one. A TQL mapping element uses the
following format:

<tql name="TQL_query" xslFile="XSL_File">
<request type="Retrieve"
dataType="Data_Type"
retrieveFileList="Retrieve SM Tables"
retrieveKeysQueryName="Retrieve_keys_web_service"
retrievelistQueryName="Retrieve Objects_web_service"
ballQueryCondition="Full Query_ Condition"
changedUpdateQueryCondition="Changed_Update_Condition"

changedDeletionQueryCondition="Changed_Deletion_Condition"/>
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</tql>

TQL_query is a TQL query name. The TQL query does not have to exist in UCMDB.

XSL_Fileis the name of the XSL transformation file that the integration will use to map Service
Manager web service fields to Universal CMDB attributes.

Data_Type is the type of the object retrieved from Service Manager. The possible values are

ci” and “relationship”.

Retrieve SM Tables is the table name list in the Service Manager web service configuration;
if you define the WSDL on a join definition, you need to list all the table names of the join
definition to which the fields of XSLT mapping belongs; if you define the WSDL on a simple
table, simply leave Retrieve_SM_Tables empty. You can also check this by opening the
WSDL URL: http://<SM server>:<port>/SM/7/<object name>.wsdl. Forexample, out-
of-the-box, the instance type of ucmdbNode is as shown in the following figure, so the
Retrieve_SM_Tables value is file.device, file.node.

SM tables of the ucmdbNode instance type in the ucmdbNode WSDL are illustrated in the
following screenshot:
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- <xs:complexType name=

- «<¥5:5equencez

- =xs:element name="{il

e.aevice >

- «<xs:complexType:=
- <xs:complexContent=
- <xs:extension base="cmn:StructureType"=
- <X5:sequence:

<XS5

<XS5

<XS5

<XS5

<XS

relement minOccurs="0"
<XS:
relement minOccurs="0"
<XS:
relement minOccurs="0"
<XS:
relement minOccurs="0"
<XS:
relement minOccurs="0"
<XS:
<XS:
<HS:
<HS:
<XS:
<XS:
<XS:

element minOccurs="0"

element minOccurs="0"

element minOccurs="0"

element minOccurs="0"

element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"
element minOccurs="0"

<{xs:sequence:>
</%xs:extension=
</x¥s:complexContent=
<fxs:complexType=
</%xs5:element=
- =xs:element name="f= noda">
- «<xs:complexType=>
- «<xs:complexContent>
- «xs:extension base="cmn:StructureType">
- «<xs:sequence:

- «<xs:element minOccurs="0" name

- <xs:complexType=
- «xs:complexContent=

||.l

name="CIIdentifier" nillable="true" type="cmn:StringType" |
name="Vendor" nillable="true" type="cmn:StringType" /=
name="DNSName" nillable="true" type="cmn:StringType" |
name="SerialNo" nillable="true" type="cmn:StringType" />
name="Location" nillable="true" type="cmn:StringType" ;’:»
name="Type" nillable="true" type="cmn:StringType" />
name="CIName" nillable="true" type—"cmn'StringType" =
name="Subtype" nillable="true" type="cmn: StrlngType” =
name="Building" nillable="true" type="cmn:StringType" /
name="Floor" nillable="true" type—"cmn'StringType" =
name="Room" nillable="true" type="cmn: StrlngType"’
name="AssetTag" nillable="true" type="cmn:StringType" />
name="08" nillable="true" type="cmn:StringType" />
name="CustomerId" nillable="true" type="cmn:StringType" /=
name="DefaultGateway" nillable="true" type="cmn:StringType" />
name="UCMDBId" nillable="true" type="cmn:StringType" /=

||.l

="addlIPAddr"=

- «<xs:extension base="cmn:ArrayType">

Retrieve keys web_service is the name of the Service Manager web service that you want
the integration to use to retrieve a Cl Key list from Service Manager.

Retrieve_Objects_web_service is the name of the Service Manager web service that you
want the integration to use to retrieve a Cl Object list from Service Manager.

Basic_Query_Conditionis aninternal Query Condition of Service Manager that you want the
integration to use to retrieve a Cl list from Service Manager for a Cl type; it is used as the basic
condition for a full or changes population.

Full Query_Condition is an additional internal Query Condition of Service Manager. Along
with the Basic_Query_Condition, it is used to retrieve a list of all Cls from Service Manager for

a full population.
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Changed_Update_Condition is an additional internal Query Condition of Service Manager;
along with the Basic_Query_Condition, it is used to retrieve a list of updated Cls from Service
Manager since the last job execution; it includes both updated Cls and newly created Cls. Itis
used for a changes population.

Changed_Deletion_Condition is an additional internal Query Condition of Service Manager;
along with the Basic_Query_Condition, it is used to retrieve a list of deleted Cls from Service
Manager since the last job execution. It is used for a changes population.

The following figure shows an excerpt of the smPopConfFile.xml:

Resourcediscovery ConfigFiles/Service Manager Adapter8-x/smPop ConfFile xml

QXD E &

1 <rom Figs

2 <global-confige

3 <request type="Retriewve" cmdb-id-only="false"/> |

4 </glebal-configs

5 <mapping>

[ <tgl name="3M Business Service Population" xslFile="business_service_population.xslt™>
7 <request type="Retrieve" datalype="ci™

i FileList="file.device"”
KeyzlueryName="RetrieveucmdbBusinessServiceKeyslistRegquest™

10 Lizt{ueryName="RetrieveucmdbBusinessServicelistRequest™

11 ="type=&quot;bizservicesquoc; ™

12 on="1lstatus~=sguot;Retired/Consumedsquot;"”

13 cndition="crcatcd.by.dotcegt; " {fromDate} " and istatus-=—sguo
14 dUpdatefue dition="created.by.dateslt;="{fromDate}"' and devicemcdtimes
135 dleleticnfueryCondition="devicemodtimesgt; ' [fromDate]l' and istatus=zquot;R
16 </tgl>

17 <tgl name="3M Computer Population" xslFile="computer population.xslt”=>

4 1l k

4. Add or update TQL mapping elements for each TQL query you want to add to the integration.
For example, the following TQL creates a mapping between the rdbmsData TQL query and the
rdbms_population.xslt file.

<tql name="rdbmsData" xslFile="rdbms_population.xslt">
<request type="Retrieve" dataType="ci"
retrieveFilelList="file.device,file.rdbms"
retrieveKeysQueryName="RetrieveucmdbRDBMSKeysListRequest"
retrievelListQueryName="RetrieveucmdbRDBMSListRequest"
basicQueryCondition="type#&quot;rdbms&quot;"
fullQueryCondition="istatus~=&quot;Disposed/Retired&quot;"

changedUpdateQueryCondition="(devicemodtime>'{fromDate}' or (devicem
odtime=NULL and created.by.date>'{fromDate}')) and istatus~=&quot;Disposed/R
etired&quot;"
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changedDeletionQueryCondition="devicemodtime>'{fromDate}"' and istatu
s=&quot;Disposed/Retired&quot;"/>

</tql>

The following figure shows the above-mentioned TQL mapping elements in the
smPopConfFile.xml file:

<tgl name="rdbmsData™ XslFile="rdbm= population. xalt™>
<request type="Retrieve™ datalvps="ci"

retrieveFileList="file.device,file.rdbms"
retrievekeys_uerylame="RetrieveucmdbRIEMSKeysListRequest™
retrievelistCuseryName="RetrieveucmdbBEIEMSL.i stRequest™
basicfuerylondition="type#sequot; rdbmazquot ;™
fullfueryCondition="istatus-=gquot;Disposed/Eetiredsquot =™
changediipdatefuerylondition="(devicemodtime>" {fromDate}" or (devicemodtime=NULI
changedDeletionguerylondition="devicemodtime>" {fromDate]l ™ and istatus=squot;Di:

</l

</mapping>

The following figure shows an excerpt of the ucmdbRDBMS WSDL for your reference:
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- «<xs:complexType name=" i =
- <xXs:isequence:
<xs:element minOccurs="0" name="TTT
</¥s:sequence:
<xs:attribute name="query" type="xs:string" use="optional" /=
<xs:attribute name="updatecounter" type="xs:long" use="optional" />
<fxs:complexType>
- =xs:complexType name="
- <xs:isequence:
- <xs:element name="{lle.device">
- <xs:complexType:>
- <xs:complexContent=
- <xs:extension base="cmn:StructureType"=
- <xs:isequence:
<xs:element minQccurs="0" name="CIIdentifier" nillable="true" t}rpe 'cmn:StringType" /=
<xs:element minOccurs="0" name="Vendor" nillable="true" type '‘cmn:StringType" />
<xs:element minQccurs="0" name="Type" nillable="true" type="cmn:StringType" /=
<xs:element minQccurs="0" name="CIName" nillable="true" type="cmn:StringType" />
<xs:element minCccurs="0" name="Description" nillable="true" type 'cmn: StrlngType" I
<xs:element minQccurs="0" name="Version" nilable="true" type="cmn:StringType" /=
<xs:element minCccurs="0" name="SubType" nillable="true" type="cmn:StringType" /
<xs:element minQccurs="0" name="CustomerId" nillable="true" type="cmn: StrlngType
<xs:element minQccurs="0" name="ApplicationName" nillable="true" type= cmn.StrlngType" =
<xs:element minCccurs="0" name="UCMDBId" nillable="true" type= cmn'StringType" /=
<xs:element minQccurs="0" name="ProductVersion" nilable="true" type="cmn:StringType" /=
</¥s:sequence:
=/xs:extension:
</xs:complexContent>
</xs:complexType=
</%xs:element=
- «<xs:element name="file.rdk =
- <xs:complexType:
- «<xs:complexContent>
- <xs:extension base="cmn:StructureType"=
- <xs:sequencex
<xs:element minCOccurs="0" name="DBInstance" nlllable "true type="cmn:StringType" />

nillable="true" type="cmn:StringType" />

||.l

5. Save the configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

How to Map the Cl Type's Attributes to Web Service
Fields

The integration uses the Service Manager Adapter to transform Service Manager web services
objects to Universal CMDB CI attributes. The Service Manager Adapter uses XSL transformation
files to convert a properly formatted Service Manager web services messages into Universal
CMDB CI. Out-of-the-box, each integration query has a corresponding XSL transformation file. In
addition, each attribute you want to populate to Universal CMDB requires its own entry in the XSL
transformation file.
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If you want to add a Cl type to the integration, you must create a matching XSL transformation file
that defines how the Service Manager Adapter transforms each Service Manager web service field
into a Cl type. In order to create a proper XSL mapping, you must be familiar with the service and
object names that Service Manager publishes as Web services. For information on publishing
tables and columns as Web service fields, see the Service Manager 9.31 Web Services Guide.

To create an XSL transformation file for the SM RDBMS ClI type, which is described in previous
sections:

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management.

3. Click the Create new resource button
4. Select New Configuration File.
5. Select the ServiceManagerAdapter9-x package.

6. Enter the full file name using this format: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/rdbms_population.xslt.

7. Copy the content of an existing XSL transformation file to use it as a template to create the
new transformation file. For example, copy the content of business_service_
population.xslt tothe new file.

8. Findthe web service response name definition element, which uses the following format:
<xsl:template match="/SM_WEBSERVICE_RESPONSE_NAME">

SM_WEBSERVICE_RESPONSE_NAME is the name of web service response in the Service Manager
system.

The following figure shows an example of Web Service response definition in business_
service_population.xslt:

<xsl:stylesheet version="1.0" xmlns:xsl="http://uwuww.w3.org/1999/XSL/Transf &
oFm'>
<xsl:template match="/nc7: " 1bBusi S icelistRes| My
{topology>
{xsl:for-each select="instance">
{ci class="business_service">
{*——import:cmdb_root_attributes_population.xslt-->
{attribute mame="provider" type="String"><{xsl:value-of
select="file.device/ServiceProvider”/><{/attribute>
<fcir
{/rsl:For-each>
{/topology>
</xsl:templatef
</usl:stylesheet> x|
11,16-19 All
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9. Update the web service response name to match the response name that you want to add to
the integration. For example, you can create the following CI type definition element to add the
database response of retrieve object list to the integration.

<xsl:template match="/RetrieveucmdbRDBMSListResponse">

10. Find the Universal CMDB ClI type definition element, which uses the following format:
<ci class="UCMDB_CI_TYPE_NAME">

UCMDB_CI_TYPE_NAME is the Cl type name in the Universal CMDB System.

The following figure shows an example Cl type definition in business_service
population.xslt:

<xsl:stylesheet version="1.8" xmins:xs1="http://www.w3.org/1999/5SL/Transfor &
m'*>
{xsl:template match=""/RetrieveucmdbBusinessServicelListResponse™>
{topology>
<%sl:for—each select="instance”>
<ci class="hus! i ice">
<t--import:cmdb_root_ attributes population.xslt-->
{attribute name="provider” type="String"><{xzsl:value-of s_
elect="file.device/ServiceProvider"/><{/attribute>
</fci>
{/%s5]1 - for—-each>
</topology>
{fxsltemplate>
</xsl:stylesheet] d
12,17 All

11. Update the Universal CMDB CI type definition name to match the name you want to add to the
integration. For example, create the following CI type definition element to add the database
response of retrieve object list to the integration.

<ci class="sm_rdbms">

12. Find the elements that transform Service Manager web service fields into Universal CMDB CI
attributes. The ClI attribute transformation elements use the following format:

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI_attribute_type" ign
oreCIIfEmpty="true">
<xsl:value-of select="SMAttributeName "/></attribute>

UCMDB_CI_attribute_name is the name of the Cl attribute in the Universal CMDB system.

UCMDB_CI attribute type is the type of the Cl attribute in the Universal CMDB system that
this integration supports. Currently the following types are supported: String, StringList,
Integer, Long, Double, Boolean, IPAddress, Date, Float, and IntList.

ignoreCIIfEmpty is a parameter that specifies whether or not to ignore the CI during
population if this attribute has an empty value (true: ignore; false: not ignore).
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Note:
= A StringList is a list of strings separated by a semicolon (;). For example, str1;str2;str3.
An IntList is a list of integers separated by a semicolon (;). For example, 1;2;3.

= Forinformation about setting a time zone and date format for the Date type, see "How
to Update the Time Zone and Date Format for the Integration Adapter" on page 33.

SMAttributeName is the name of a web service attribute published by the Service Manager
system.

See the following figure for an example of Cl attributes in business_service

population.xslt:
{xsl:stylesheet version="1.08" xmlns:xsl="http://fwww.w3.org/1999/8SL/Transf =]
orm'>
{xsl:template match="/RetrieveucmdbBusinessServicelListResponse™>
<topology>
{xsl:for-each select="instance”>
{ci elass="hus! ju ice">
{t--import:cmdb_root_attributes population.xslt-->
{attribute name=""| Tder™ type="String"><{xsl:value-of
select="file._device/ServiceProvider”/><{/attribute>
<fcir
{f¥sl:for-each>
<ftopology>
</xs1:templatef]
<{fxsl:stylesheet> =l
11,16-19 All

Refer to the following screenshot to match Cl attributes in the Universal CMDB
BusinessService Cl type:
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Cl Types Dependencies | Details || Attributes || Gualifiers lcon | Adts
4 H ﬁ = Thiz page enables you to edit the attributes of the Cliype.
7 Managed Objact (9) N
@] activityLog (0) + & K | I
@] Asset ()
_ Attachment (0) = Display Mame | Marme Type | Description | Default WValue
—[®] Budget @) Last Access Time root_lastaccesstime date When was ...
— BudgetLine (0) Last Modified Time last_modified_time date When was .
— Business Objective (0) = layer layer layer_enum business_...
() Configurationttem (2) MEML MEML xml <MENU><...
ELJ—O BusinessElement (4)
O Business Service Viev Note data naote string
BusinessActivity (0) 9 . - ) . .
@ BusinessApplication 1 I Operation Corr State | data_operationcorrs...  opergtionst...  Operagtion ... Normal
BusinessFunction 1) Cperation |z New data_operationisnew  boolean Operation ... falze
["] BusinessProcess (0) Operation State data_operationstate operationst...  Operation ... Normal
BusineszTranzsaction
(Z) Datacenter (0) Owner Tenart Tenart Owner string The Tenan...
&J Service (2) Provider [ string Service Pr...
% ﬁ:si:ss:fervisce I Provizion provision string Service Pr...
rastructure Sery
(@] CiCallection (1) i ,
E—[E] InfrastructureElement (5) State state string
—O Loestion (0) Store KPI History Fo... | is_save_persistency | boolean Store KPLh...  true
Fe—[e] Monitor () System root_system tring
() Party (0) ':‘ (=] il ,
4 1 3

Refer to the following screenshot to match Cl attributes in the Service Manager
ucmdbBusinessService web service:

External Access Definition

Service Name: |'u|:mdb1ntegration | [ released
Mame: ﬁoinbizservice |v| [ beprecated
Object Name: |ucrndeusinessService |
< Allowed Actions | < Expressions | “ Fields |

Field | Caption | Type

ucrndb.id UCMDEId

ci.name ServiceMame

type Type

subtype Subtype

company CustomerId

logical.name Clldentifier

vendor ServiceProvider

id CIMame

13. Inthe SM RDBMS population example, there are no sub items of a Cl. If you want to populate
the sub items of a Cl, for example, to populate the IP addresses of a computer together with
the computer ClI, you need to add a “link” element under the “ci” element. A link transformation
element uses the following format:
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<link direction="Link_Direction" linkType="UCMDB_Link_Type">
<ci class="UCMDB_SUB_CI_TYPE_NAME">

<attribute name="UCMDB_CI_attribute_name" type="UCMDB_CI attribute_typ
e">
<xsl:value-of select="SMAttributeName "/></attribute>

<attribute name="UCMDB_CI attribute_name2" type="UCMDB_CI attribute_ty
pe2">
<xsl:value-of select="SMAttributeName 2"/></attribute>

</ci>
</xsl:for-each>
</link>

Link_Directionis the direction between a parent Cl and sub CIl. The supported directions
are:

= outgoing: The link direction is from an upstream CI to the current downstream CI (for
example, from node to ip_address).

= incoming: The link direction is from a downstream CI to the current upstream CI.
UCMDB_Link_type is the relationship type in the Universal CMDB system.

The following figures show the out-of-the-box configurations for populating the Computer ClI
together with its IP addresses:
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{xsl:stylesheet version="1.8" xmlns:xsl="http://www. w3 . org/1999/X5L/Transform >
<{¥sl:template match="/RetrieveucmdbHodeListResponse">
{topology>
<¥sl:for—-each select="instance'>
{®sl:variable name="building" select="file._device/Building"/>
{xsl:variable name="floor" select="file.device/Floor" />
<¥sl:variable name="roon" select="file.device/Room"/>

<ci class=""node">

{*——import:cmdb_root_attributes_population.xslt-->

<attribute name="primary_ dns_name" type="String"><{xsl:value—
of select="file.device/DHSHame"/><{/fattribute>

<attribute name="calculated location" type="String"><xsl:wal
ue—of select="concat{'Building:*, $building, 'Floor:', %floor, 'Room:', %room)"/
»{fattribute>

<attribute name="discovered os_name" type="String"><xsl:valu
e-of select="file.device/05"/><{/attribute>

{attribute name="default gateway ip_ address" type="String"><
xsl:value—of select="file.device/DefaultGateway”/></attribute>

{attribute name="discovered os version" type="String"><{xsl:w
alue—of select="file.node/0SVersion”/><{/attribute>

<attribute name="memory size" tEpe="Integer"><xsl:ualue—nF 5
elect="file_node/Physicalbemory”/><{/fattribute>

{*——import:cpu_mapping_population.xslt-->

{t--import:disk device mapping population.xslt-->

{*——import:filesystem_mapping_population.xslt-->

-1 =

{*——import:interfaces_mapping_population.xslt-->

<fci>
<fxsl:for—each>
</topology>
{fxsl:template>
</xslistylesheet>
16,52 All

FY

[

Link definition in the import xslt file (ips_mapping_population.xslt)is illustrated in the
following screenshot:

<1link direction="gutgaing”’ linkType=""mmmiad nit> -
{xsl:for-each select="777 le/addlIPAddr faddl IPAddr''>
{ci class="ip_add S
{attribute mame="'nam=" type="String"><{xsl:value—of select

="AddlIPAddress"/><{/attribute>

{attribute name="data_externalid" type="3tring”><{xsl:valu
e—of select="AddlIPAddress"/><{/fattribute’>

{attribute mame="1ip_ netmask" type="String"><{xsl:value-of
select="Add1Subnet"”/><{/attribute>

<fcix
</#sl:for-each>
</link> j
9,7 All

Refer to the following screenshot to match Cl attributes and links in the Service Manager
WSDL(http://<SM server>:<port>/SM/7/ucmdbNode.wsdl):
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- «xs:complexType name="ucmdbNodeInstanceType">
- <xsiseguence:
- «xs:element name="file.device"=
- <xs:complexType >
- <xs:complexContent=
+ «<xs:extension base="cmn:StructureType">
</xs:complexContent=
<fxs:complexType=
<fxg:elemant>
- =xs:element name="fMle.noda">
- «<xs:complexType >
- =xs:complexContent>
- «xs:extension base="cmn:StructureType">
- <xSisequence:
- «xs:element minCccurs="0" name="addTPA ">
- =xs:complexTypes
- «xs:complexContent>
- =xs:extension base="cmn:ArrayType">
- «xSISequence:
- «xs:element maxOccurs="unbounded" minOccurs="0" name="addiTbAddy"=
- «xs:complexTypex
- =xs:complexContent>
- «<xs:extension base="cmn:StructureType">
- <x5:sequence:>
<xs:element minOccurs="0" name="AddlIPAddress" nillable="true" type="cmn:StringType" />
<xs:element minOccurs="0" name="AddISubnet" nillable="true" type="cmn:StringType" /=
</xs:sequence>
</xs:extensionz
</xs:complexContent>
</xs:complexType>

~lyaalamant=

Refer to the following screenshot to match Cl links in UCMDB at the TQL level:

i‘ Compositio
SRR =

i Interface

Root
‘Contanment

i,

IpAddress

Note: The Matching CI links in UCMDB at the TQL level figure is provided here only to
give you a graphic view of how relevant Cls are stored in UCMDB. You do not need to
create the TQL query, since the population feature does not require it.

Refer to the following screenshot to match Cl type and attributes in the UCMDB CI Type
(IpAddress):
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Cl Types Dependencies | Details | Attributes | Gualfiers lcx
>
Cl Types | N s .
S| General Details

E’: \— USTACEMTEr HeS0urce A]
= Marne:

Metwork Entity (3)
(=] AT Port ()
(=] ATM Switching (

Display Mame: | IpAddress

—[=1 Bridge @) Scope:

(0] DuS Zone @) Created By:

—(2 ELan o) .

— D Chassis (0) Description. Thiz class reprezents the logical network identifier of a node on the
— trterfacetnedex represent either an [Pv4 or an IPVE address.

(il IpAddress (2)
—[&] IPMP Group ()
— IpSubnet (1) 1 14

Cl| Types Dependencies | Detals || Attributes | Gualfiers lcon Al
»»
Cl Types || ﬁ | This page enables you to edit the sttributes of the Cltype.
E: \— Latacenter HesouUrce ‘]
= Metwork Entity (3) 4 P (®) | I
(@] ATM Pert (0)
— ATM Switching (i Dizplay Mame | = Mame Type | Description | Default Wall
—= Bricge (0) matching_rules matching_rules string_list ip_netmask
—[d] DNS Zone (@)
_ ELAN (0) MEMU MEMNL xml =MEML==.
_ IO Chassis (0) Mame | name string
[ Irteraeetnaext Actual Delete Time root_actualdeletetime | date When will ...
[]— IpAddress (2) Actual Deletion Period | roct_actualdeletionp...  integer What is the... 40
—[&] IPMP Group (@) Candidate For Deleti... root_candidatefordel... date When will t...
(2] Ipsubnet (1) 4] | €l Type root_class string Class nam...
— Layer2Connectic _| |k
_ MairframeMajor ! Deletion Candidate ...  root_deletioncandida...  integer What is the... | 20

14. Add or update the ClI attribute transformation elements for each Cl attribute you want to add to
the integration. For example, you can use the following XSL transformation elements for the
database Cl type.

Sample XSL transformation elements for database Cls

UCMDB
attribute Sample transformation elements

discovere <attribute name="discovered_product_name" type="String">
d_product <xsl:value-of select="file.device/CIIdentifier"/></attribute>

name
product_ <attribute name="product_name" type="String">
name <xsl:value-of select="file.device/ApplicationName"/></attribut

e>

application_  <attribute name="application_version" type="String">
version <xsl:value-of select="file.device/ProductVersion"/></attribute>

vendor <attribute name="vendor" type="String">
<xsl:value-of select="file.device/Vendor"/></attribute>
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Sample XSL transformation elements for database Cls, continued

UCMDB
attribute Sample transformation elements
version <attribute name="version" type="String">

<xsl:value-of select="file.device/Version"/></attribute>

dbinstance | <attribute name="dbinstance" type="String">
<xsl:value-of select="file.rdbms/DBInstance"/></attribute>

port <attribute name="port" type="String">
<xsl:value-of select="file.rdbms/Port"/></attribute>

description  <attribute name="description" type="String">
<xsl:value-of select="file.rdbms/Description"/></attribute>

Attribute mappings in rdbms_population.xslt are illustrated in the following screenshot:

<xsl:stylesheet version=""1.0" xmlns:xsl="http://wwu. w3 . org/1999/XSL/Transform"> &
{xsl:template match="/RetrieveucmdbRDBMSListResponse™>
{topology>
<¥sl:for—-each select="instance’'>
<ci class="sm_rdbms">
<t--import:cmdb_root_attributes population.xslt-->
<attribute name=""discovered_product_name" type="String"><{xsl
:value-of select="file.device/CIIdentifier"/></attribute>
{attribute name="product_name" type="String"><xsl:value-of s
elect="Ffile._device/ApplicationHame"/><{/fattribute>
<attribute name="application version" type="String"><{xsl:val
ue-of select="file.device/ProductUersion”/></attribute>
<attribute name="vendor" type="String"><{xsl:value-of select=
"file.device/Uendor"/><{/fattribute’
<attribute name="version" type="String"><{xsl:value-of select
="file.device/Version”/><{/attribute>
{attribute name="dbinstance" type="String"><xsl:value-of sel_|
ect="Ffile.rdbms/DBInstance”/><{fattribute>
{attribute name="port" type="String ><{xsl:value-of select="f
ile.rdbms/Port™/><{/attribute’
{attribute name=""description” type="String ><{xsl:value-of se
lect="file.rdbms/Description”/></attribute>
<feci>
<f#sl:for—each>
{/topology>
<fxsl:template>
</fusl:stylesheet>
- =l

—— SELECT — 8 14,189-124 All

15. Save the XSL transformation file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.
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How to Add a Cl Type’s Relationship Types to the
Integration for Population

Once you have added a new ClI type to the integration for population, you need to add the new CI
type’s relationship types to the integration. For each relationship type, perform the following tasks.

As an example, the following steps describe how to add the Ownership relationship type to the
integration; these steps assume that you have already added the Cost and CostCategory Cl types
to the integration for population.

1.

Create an XSL transformation file to map each relationship type’s attributes to web service
objects.
See "How to Map Each Relationship Type's Attributes to Web Service Objects" below.

2. Add a TQL mapping for each relationship type to the population configuration file.

See "How to Define a TQL Mapping for Each Relationship Type" on page 200.

How to Map Each Relationship Type's Attributes to Web
Service Objects

This example illustrates how to create an XSL transformation file to map the attributes of the
Ownership relationship type to web service objects.

1.

2.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Adapter Management.

Click the Create new resource button ™
Select New Configuration File.
Select the ServiceManagerAdapter9-x package.

Enter the full file name using this format: <AdapterlD>/<filename>. For example,
ServiceManagerAdapter9-x/cost_to_costcategory population.xslt.

Click Yes to ignore the file extension warning. The file is added to the Configuration Files
folder.

Copy the content of an existing relationship population XSLT file (for example, computer_to_
computer_connects_population.xslt)tothe new XSLT file.

Note: In the next step, you will update the <ci class> names and link Type value.

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.0rg/1999/XSL/Transfor
m">
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<xsl:template match="/RetrievecirelationshipltolListResponse">
<topology>
<xsl:for-each select="instance">
<ci class="node">

<attribute name="name" type="String"><xsl:value-of selec
t:
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="tcp">
<ci class="node">

<attribute name="name" type="String"><xsl:value-
of select=
"downstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-
of select=
"downstreamci.id"/></attribute>

</ci>
</1link>
</ci>
</xsl:for-each>
</topology>
</xsl:template>

</xsl:stylesheet>

9. Change the <ci class> names to cost and cost_category, and linkType to ownership.

<ci class="cost">

<attribute name="name" type="String"><xsl:value-of selec
‘t:
"upstreamci.logical.name"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of sele
ct=
"upstreamci.id"/></attribute>

<link direction="outgoing" linkType="ownership">
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<ci class="cost_category">

ci class: the name (not display name) of the each Cl type involved in the relationship. It
should be the Name field value on the General Details tab of the Cl type definition.

linkType: the name of the relationship type. It should be the Name field value on the General
Details tab of the relationship type definition.

Note: In this example, you do not need to change the link direction (outgoing). This is
because the relationship (Ownership) direction is from cost to cost_category, that is, from
a <ci class> outside of the <link> element to a <ci class> inside it).

10. Save the XSL transformation file.

How to Define a TQL Mapping for Each Relationship Type

For each relationship type of the new ClI type, you need to define a TQL mapping in the
smPopConfFile.xml file.

1. Loginto UCMDB as an administrator.

2. Navigate to Data Flow Management > Adapter Management > ServiceManagerAdapter9-
x > Configuration Files > smPopConfFile.xml.

3. Inthe smPopConfFile.xml file, add a TQL mapping for the relationship type, by copying an
existing TQL mapping element.

Note: In the next step, you will update the highlighted values with values of the new
relationship type.

<tql name="SM Biz To Biz With Usage"
xslFile="businessservice_to_businessservice_usage_population.xslt">

<request type="Retrieve" dataType="relationship"
retrieveKeysQueryName="RetrievecirelationshipltolKeysListRequest"

retrievelistQueryName="RetrievecirelationshipltolListRequest"

basicQueryCondition="upstreamci.type=&quot;bizservice&quot; and
downstreamci.type=&quot;bizservice&quot; and
relationship.subtype=&quot;Usage&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt; '{fromDate}' and
status~=&quot;Removed&quot;"
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changedUpdateQueryCondition="created.datetime&lt;="{fromDate}' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt; '{fromDate}' and
status=&quot;Removed&quot;"/>

</tql>

4. Update the TQP mapping element with the values of the new relationship type.

Note: For the TQL name, you can enter any descriptive name as you like (for example, SM
Cost to CostCategory with Ownership). This TQL query does not really exist,
since population does not require it.

The upstreamci.type, downstreamci.type, and relationship.subtype values are defined in
the cirelationship1to1 table in Service Manager.

<tgl name="SM Cost to CostCategory with Ownership"
xslFile="cost_to_costcategory_population.xslt">

<request type="Retrieve" dataType="relationship"
retrieveKeysQueryName="RetrievecirelationshipltolKeysListRequest"
retrievelListQueryName="RetrievecirelationshipltolListRequest"

basicQueryCondition="upstreamci.type=&quot;cost&quot; and
downstreamci.type=&quot;costcategory&quot; and
relationship.subtype=&quot;Ownership&quot;"

fullQueryCondition="status~=&quot;Removed&quot;"

changedCreationQueryCondition="create.datetime&gt; '{fromDate}' and
status~=&quot;Removed&quot;"

changedUpdateQueryCondition="created.datetime&lt;="{fromDate}"' and
update.datetime&gt;'{fromDate}' and status~=&quot;Removed&quot;"

changedDeletionQueryCondition="update.datetime&gt; '{fromDate}' and
status=&quot;Removed&quot;"/>

</tql>

5. Save the population configuration file.

Note: When you create/edit and then save a configuration file in Adapter Management,
UCMDB automatically restarts the adapter with the new configuration file.

Now the relationship type is added to the integration for population. Next, you need to add the
relationship TQL name you specified in the population configuration file (in this example, SM Cost
to CostCategory with Ownership) to a relationship population job, so that the integration can
populate this type of relationships to UCMDB. See the following figure and also "How to Add
Custom TQL Queries to Integration Population Jobs" on page 204.
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Refer to the following screenshot to add a new relationship TQL name to a relationship population

job:

| £ Edit Integraticn Job

F B
| %] Add Query )

f Edit Integration Job

Define the Integration Job details and scheduling information

Mame

Job Definition
Allow Integration Job to delete removed data

i | 5M Biz To Biz With Containmert

|| | 5M Biz To Biz With Uzage

SM Biz To Computer With Cortainmert
SM Biz To Computer With Usage

SM Computer To Computer With Connects

Scheduler Definition

[ seheduler enabled

Gnee

o =
E root
—Ej 5 Biz To Biz With Cortainmert
—IE]) sW Biz To Biz With Usage
—Ej S Biz To Computer With Cortainment
— 5M Eiz To Computer With Usage
—Ej SM Business Service Population
—Ej SM Computer Population
—Ej SM Computer To Computer With Connects
—Ej |SM Cost to Cost Category with Dwnership|

e

How to Customize UCMDB ID Pushback for a ClI

Type

Out-of-the-box, UCMDB pushes the UCMDB ID of each CI type back to Service Manager during
population, by calling a Service Manager web service (ucmdbIDPushBack) based on the

ucmdbid.pushback.request and ucmdbid.pushback. xs1t settings in the sm.properties file in
UCMDB (see "How to Update the Integration Adapter Configuration File (sm.properties)" on page

124).

To better suit your business needs, you can make the following tailorings to the ucmdb id pushback
feature, using the <idPushbackConfigurations> element in the ServiceDeskConfiguration.xml

file:

e "How to Disable the UCMDB ID Pushback Feature for a Specific Cl Type" on the next page

o "How to Define a Custom Pushback Web Service and xslt File for a Specific Cl Type" on the

next page

Note: For a specific UCMDB class (Cl type), its definitions in the
ServiceDeskConfiguration.xml file supercede the following global settings in the
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sm.properties file:

¢ idPushbackEnable: Inthe sm. properties file, this setting is not present; however, out-of-
the-box, it is set to true for all Cl types.

¢ idPushbackRequest: In the sm.properties file, its out-of-the-box value is
UpdateucmdblDPushBackRequest.

e idPushbackXSLT: In the sm.properties file, the out-of-the-box value is ucmdbid

pushback.xslt.

How to Disable the UCMDB ID Pushback Feature for a

Specific Cl Type

You may want to disable the pushback feature for certain UCMDB CI types, for example, UCMDB
classes that are mapped to a sub-item type (IP Address, CPU, etc.) in Service Manager. Doing so
can aviod unnecessary system overload.

To disable the pushback feature fora UCMDB CI type (class), use this format:

<idPushbackConfiguration ucmdbClassName="<ucmdbClassName>" idPushbackEnable="fal

se"/>

Where, <ucmdbClassName> is the name of the UCMDB Cl type.

Here are the out-of-the-box settings in the ServiceDeskConfiguration.xml file:

<idPushbackConfigurations>
<idPushbackConfiguration
<idPushbackConfiguration

<idPushbackConfiguration
e"/>

<idPushbackConfiguration
e"/>

<idPushbackConfiguration

</idPushbackConfigurations>

ucmdbClassName="interface" idPushbackEnable="false"/>
ucmdbClassName="cpu" idPushbackEnable="false"/>

ucmdbClassName="disk_device" idPushbackEnable="fals

ucmdbClassName="file_system" idPushbackEnable="fals

ucmdbClassName="ip_address" idPushbackEnable="false"/>

To enable the pushback feature for a Cl type, set idPushbackEnable="true" forit.

How to Define a Custom Pushback Web Service and xslt
File for a Specific Cl Type

There are occasions when you need to define a custom pushback web service and XSLT for a
specific Cl type (class), for example, when a Cl type you want to populate is not stored in the
device table in Service Manager. This is because the out-of-the-box ucmdbIDPushBack web

service is based on the device table.
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For example, you have tailored the integration in order to populate the Functional Group from
Service Manager to UCMDB. If the Functional Group in Service Manager is not stored in the device
table, you can define a custom web service and XSLT like the following:

<idPushbackConfigurations>

<idPushbackConfiguration ucmdbClassName="functional_group"
idPushbackEnable="true"
idPushbackRequest="UpdateucmdbIDPushBackForFunctionalGroupRequest"
idPushbackXSLT="ucmdbid_pushback_functionalgroup.xslt"/>

</idPushbackConfigurations>

Note: To support your pushback customizations, you need to create the specified custom web
service record in Service Manager and XSLT file in UCMDB.

How to Add Custom TQL Queries to Integration
Population Jobs

In order for the integration to send your custom Service Manager web service object and fields to
your UCMDB system, you must add your custom TQL queries to the population job between your
Service Manager data store and your UCMDB data store. The following steps illustrate how to add
the custom rdbmsData TQL query described in previous sections.

To add custom TQL queries to population job definitions:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.

3. Double-click the name of your Service Manager integration point. For example, SM
Integration.

4. Click the Population tab.

5. Select a population job. For example, SM Configuration Item Population job.

6. Click the Edit Integration Job button & .

7. Click the Add button ¥ .
The TQL names configured in the smPopConfFile.xml file are listed.

8. Click Root > rdbmsData.
9. Click OK to add a custom query.

10. Click OK to close the Update Job Definition window.

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 204 of 256



Universal Discovery Content Guide - Service Manager Integration
Tailoring the Integration

How to Add an Attribute of a Supported Cl Type for
Federation

Out-of-the-box, the integration supports federation for three external Cl types in UCMDB: Incident,
Problem, and RequestForChange.

For each of the supported Cl types, there is alist of attributes in UCMDB that you can map to
Service Manager web service objects for federation. The following figure shows the out-of-the-box
UCMDB CI attributes available for the Incident CI type.

Incident Cl attributes supported for federation are illustrated in the following screenshot:

sm_irtegration Population || Federation || Data Push

Federation retrieves Cl Types and attributes when a query is run or a view is displayed
Integration of type Federation defines a Data Source with the Integration Point's name

Supported and Selected Cl Types Cl Type Retrieval Mode

[h "] \
By B B B ) Retrieve Cls of selected Cl Type

EH P ,
(®) Retrieve selected attributes
B

: -
mlil IMETHE L Selected attributes will be retrieved from the Integration. The Cls must already exist inthe
2] Problem

@ ReguestFor Change Select Attributes

[l activeProcess

[l Actusl Deletion Period
[CJallow 1 Updste

O Categary

[ ciosedTime

O CompletionCode
[CJconsumer Tenarts

[ cortainer

[ create Time

[Ccreated By

[[] Deletion Candidate Period
O Cescription

O Dizplay Label E
—_ L

3

For example, to add an SM Incident attribute for federation, you need to expose the field in the SM
Ucmdblncident web service object and then map it to an appropriate UCMDB attribute (if one does
not already exist, you need to create it in UCMDB first).

The following figure shows the fields that are exposed in the UcmdbIncident web service object in
Service Manager:
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External Access Definition

Service Name: rLlcmdentegratiDn | [ Released
Marne: [prgbsummar}r | i | [7] Deprecated
Object Name: |Ucmdhlncident |

< Allowed Actions | < Expressions | < Fields

Field Caption Type
lzgical.name Configurationitem

number IncidentID

brief.description BriefDescription

subcategory Category

severity Urgency

open.time OpenTime DateTimeType
updatetime UpdatedTime DateTimeType
closetime ClosedTime DateTimeType
problem.status IMTicketStatus

affected.item Service

priority.code PriorityCode

initial.impact ImpactScope

You can expose more fields so that more Incident attributes can be federated to UCMDB. As an
example, the following describes how to add the “action” field in the Service Manager probsummary
(Incident) file for federation, by mapping it to a new UCMDB attribute named “details”.

Note: On the Incident form in Service Manager, the “action” field is labeled “Description”, which
describes the incident ticket in more detail. See the following figure.

Title | Systern crashes with message "not encugh memery” while cpening multiple applications

( Description [fpetoms ceack with masccans nat ananak ssessany while opening multiple applications

A description of the incident in more detail

file=probsummary
form=IM update.incident

("" field=action b

To add an attribute of a supported Cl type for federation:
1. Add the SM attribute to its web service object.
The following example describes how to expose the SM “action” field of Incident in the
Ucmdblncident web service object.

a. Loginto Service Manager as a system administrator.

b. Navigate to Tailoring > Web Services > WSDL Configuration.
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c. Enterthe following field values, and then click Search.
o Service Name: ucmdbIntegration

o Name: probsummary
The Ucmdblncident web service object displays.

d. Onthe Fields tab, add the following row:
o Field: action.

o Caption: Description

External Access Definition

Service Mame: [ucmdblntegration | [] Released
Marme: |prnbsummary | o | [7] Deprecated
Object Name: |Ucmdb1ncident |
< Allowed Actions | < Expressions | < Fields

Field Caption Type

logical.name Configurationltem

number IncidentID

brief.description BriefDescription

subcategory Category

severity Urgency

open.time OpenTime DateTimeType

update.time UpdatedTime DateTimeType

closetime ClosedTime DateTimeType

problem.status IMTicketStatus

affected.item Service

pricrity.code PriorityCode

initial.impact ImpactScope

oction [ Description |

e. Save the web service object.
2. Map the SM attribute to a UCMDB attribute.
The following example describes how to map the SM “action” attribute to a new UCMDB
attribute named “details”.
a. Loginto UCMDB as an administrator.

b. Navigate to Modeling > Cl Type Manager.

c. Browse toltProcessRecord > Incident, and open its properties pane.
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d. Click the Add button to add a new attribute named “details” to the Incident Cl type.
|£| Edit Attribute

Adtribute Name:

Display Mame: Dietailz

Scope:

Deseription: Inciclert details

Aftribute Type:

Primitive Enumeration/List

Value Size:

Drefault Value

4

o name: details
o Display Name: Details
o Description: Incident details

o Attribute Type: Primitive > List of strings (this is because the “action” field in SM is an
array)

e. Save the Incident Cl type record.

f. Navigate to Data Flow Management > Adapter Management >
ServiceManagerAdapter9-x > Configuration Files.

g. Click the ServiceDeskConfiguration.xml file.

h. Add a mapping entry for the “details” attribute in the Incident attributeMappings section, as
shown in the following.

<ucmdbClassConfiguration ucmdbClassName="incident">

<attributeMappings>
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<attributeMapping ucmdbAttributeName="reference_number"
serviceDeskAttributeName="IncidentID"/>

<attributeMapping ucmdbAttributeName="name"
serviceDeskAttributeName="BriefDescription"/>

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace”
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore"/>

<attributeMapping ucmdbAttributeName="urgency" serviceDeskAttribut
eName="Urgency"/>

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeName="
Description"/>

</attributeMappings>

Tip: The attribute mapping entry uses the following format:

<attributeMapping ucmdbAttributeName="details" serviceDeskAttributeNam
e="Description"/>

Where:

ucmdbAttributeName is the UCMDB attribute name in the Incident CI type definition
to which you want to map the SM attribute;

serviceDeskAttributeName is the field caption you defined in the SM web service
object.

For an SM attribute (for example, problem.status) that is a drop-down list, the attribute
mapping uses the following format (you only need to change the attribute names):

<attributeMapping ucmdbAttributeName="incident_status"
serviceDeskAttributeName="IMTicketStatus"
converterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToUpperAndReplaceUnderscoreWithSpace"
reversedConverterClassName="com.mercury.topaz.fcmdb.adapters.
serviceDeskAdapter.converter.PropertyValueConverterFirstLetter
ToLowerAndReplaceSpaceWithUnderscore"/>
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i. Click OK to save thefile.

Now the Description (field name: action) attribute of SM Incident has been added to the
integration for federation. You can run an Incident federation query in the UCMDB Modeling
Studio to see if the SM Description data is properly federated. For details, see "Examples of

Using Federation" on page 44.

The following figure shows an example where the Description of an SM incident ticket has

been federated to UCMDB as Details:

| £ Configuration [tem Properties

o |

I?_Iézl Configuration Item Properties

Mame: IW10003

1D: am_integration % 0Aincident %041 %0 AIncident|D %30 STRING %30 IM10003 %604

Cl Type: Incident

=Eyl i

BExport ~ | Quick fitter:

Q- Type here to fiter properties

ActiveProcess

Actual Deletion Period
Allow Cl Update
Category

ClosedTime
Completion Code
Consumer Tenarts
Container

Create Time

Created By

Deletion Candidate Period
Description

True
performance

Maon Sep 3 2007 11:49 AM CST
sm_integration

40

20

CDetaiIs

[Sy=stem crash with message not enough memaory while openi.._.)-_

Dizplay Lakel

Enakle Aging

Escalated
ExternalProcessReference
Glaobal Id

Impact Scope

Incident Status

Incidert Type

|z Candidate For Deletion

IM10003
Falze
False

user
work_in_progress

False
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When data push and population errors occur, you can check the error messages and the integration
log files to identify the root causes and fix the errors. This chapter describes the general
troubleshooting steps, as well as typical errors and solutions.

This section includes:

e "Troubleshooting Data Push Issues" below

o "Troubleshooting Population Issues" on page 237

Troubleshooting Data Push Issues

When data push errors or problems occur, you can check the error messages and the log file to
figure out the root causes and then fix the errors.

This integration uses the following error codes for data push.

Data push error codes

Error
code

-1

0

3
28
51
70
71
881
882

Description

Unspecified error.

Success.

Resource unavailable.

Not authorized.

Record modified since last retrieved.

Invalid SOAP action / unrecognized application action.
Validation failed.

Cl does not exist in Service Manager.

Unable to remove the relationship because at least one of Cls involved in the
relationship does not exist in Service Manager.

When a data push job has failed, the job status becomes Failed. Troubleshoot the failed job as

follows:

o Check the error messages of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Push Job" on the next page.

o Check the log file for more details.
See "How to Check the Push Log File" on page 217.
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When a data push job was completed, but with partial records failed, the job status becomes
Passed with failures. Troubleshoot the failed records as follows:

o Check the error messages of failed Cls in the Universal CMDB studio.
See "How to Check the Error Messages of Failed Cls/Cl Relationships in a Push Job" on the

next page.

o Check the log file for more details.
See "How to Check the Push Log File" on page 217.

Once you have fixed the issues with the failed records, you can re-push them one by one orin
batches. For details, see "How to Re-push Failed CI/CI Relationship Records" on page 222.

How to Check the Error Message of a Failed Push
Job

To check the error message of a failed job:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Select the integration point for this integration from Integration Point list.
4. Click the Data Push tab.
5. Select the job from Integration Jobs.

6. Click the Job Errors sub-tab, and double-click the Severity of a message from the list.
A popup window displays the detailed error message of this failed job. Following is an excerpt
of a sample error message indicating that an XSLT file was not found.

java.io.FilaNotFoundException: Resource:
business service push file not exist.xslt, was not found
at

com. mercury.topaz.cmdb. server. fecmdb . adapterstate.AdapterstateBesourceServerFacade
-openResocurceForReading (AdapterStateResourceServerFacade. java: 51}

at
com.mercury.topaz.cmdb. server. femdb. spi.adapter.environment . DatafdapterEnvironmen
tImpl.openResourceForReading (DatakdapterEnvironmentImpl.java:119)

at
cofm. mercury. topaz . fomdb . adapters. serviceDeskbdapter . TransformUtils . readPrombile (T

rangformUtils.java:11l3)

at
com.mercury.topaz. fomdb. adapters. serviceDeskAdapter.push.XsltTransformer . createTe

mplates (XsltTransformer.java: 33)
«: . 36 mMOEre

& &
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How to Check the Error Messages of Failed Cls/Cl
Relationships in a Push Job

When a data push job is completed with partial records failed, in the Universal CMDB studio, you
can check the source Cl XML of Universal CMDB, the XSLT-transformed XML and the response

XML from Service Manager to see if the failure is caused by dataissues.

To check the error messages of failed records in a data push job:

1.

2.

Loginto UCMDB as an administrator.

Navigate to Data Flow Management > Integration Studio.

Select the integration point for this integration from Integration Point list.

Click the Data Push tab.
Select the job from Integration Jobs.

Click the Query Status sub-tab.

Double-click a query with failures. The Error Message and Cl Count for each failed Cl Type

display.

T

Statistics || Guery Status || Job Errors

o

SM Push job = SM Business Senvice Push

Error Message | Cl Type

Cl Count

Valiclstion Check Fails Error from SM @ BuzineszApplication
‘Valiclation Check Fails Error from S @’l_;l BusinessService
Walidation Check Fails Error from SM & Infrastructure Service

Double-click an error message. A list of failed records displays.

Double-click a failed record.
The detailed error message of the record displays.
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|£:| Error message for 2s1320226187110313

Q@ =

Validation Check Failz Error from SM, return code 71, the error message is "Validation failed"

C1 Push Details:

Source free XML:

<?xml version="1.0" encoding="UTF-16"7=>

=businesz_elemert bdm Type="BusinessApplication" customer_id="1"
dizplay_label="as1329226187110313"
friendly Type="BusinessApplication"
dlobal_id="4de030e5ab82e02acceifcd7h57 adkhes”
id="4de030e5ab82e02accclfcd7hETa%bes" name="as1328226187110313">

Transformed XML:
<7xml verzion="1.0" encoding="UTF-15"?=
=Createucmdb Buzsiness Service Reguest>
=model>
<keys/l>
=instance=
<UCMDEId>4del30e5abi2e02acccifcdTheTalhea</UCMDEId=
=Customerld=1=/Customer d=
<Type=hizzervice</Type:=
=Subtype>Application Service=/Subtype>
=ServiceMName=as132922618711031 3</ServiceMName>
<Clldertifier>as132922618711031 3</Clldentifier=
4 1}

The following is a sample error message that indicates a validation failure, and the root cause
is that a not-null key (key definition #18 of the device table) contains an empty value.
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Validation Check Fails Error from S5M, return code 71, the error message is
"Validation failed",

CI Push Detals:

Source tree XML:

<ncde bdmType="Node" customer id="1"

display label="XMAlé.asiapacific.hpgcorp.net" friendly-Type="Windows"
global id="fd2lb94ddf26dcleelSde2ladcaiddc™
id="fd21b94ddi26dcY%e054e2ladcaid4cl” os_vendor="Microsoft"

primary dns name="XMARl6.asiapacific.hpgcorp.net">

<ip addresss direction="outgoing" linkLabel="Containment" linkName="32"
linkType="Containment™>

<ip address bdmType="Iphddress" customer id="1"
friendlyType="IpAddress" id="bd03e3418%cT138598712dcac500730ba™
name="16.158.154.152" realRelationType="Containment" />

</ip addresss>

<interfaces direction="outgoing" linkLabel="Composition™ linkName="33"
linkType="Composition™>

<interface bdmType="Interface" customer id="1" friendlyType="Interface"
id="5897567531c55aTbdl96bd2d5acaadB5" mac address="B439EAESACTA"
realRelationType="Composition™
root_container="UCHMDB%0ANt30Al%0AInternal id%3DSTRINGH3DEd21b94ddi26dceel54e2
ladca3ddc0%0A" />

<finterfaces>

</node>

Transformed XML:
<CreateucmdbNodeRequest>
<model>
<heys/>
<instance>
<file.device>
<UCMDBId>fd21b94ddf26deeadSde?ladea3ddel< /UCMDBIA>
<Customerld>1l</Customerld>
<Type>computer</Type>
<Subtype>Server</subtype>

<add] IPAddr:>
<Add1TPAddress>16.158.154.152</Add] IPAddress:
<AddlSubnet/>
</addlIFAddr>
</addlIPAddr>
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<CITdentifier>xMnlé.asiapacific.hpgoorp.net</CITIdentifiar>
<DNSHame>XMAl6.asiapacific.hpgcorp. net</DNSHame>
</file.device>
<file.node>
<0sVendor>Microscft</0SVendor>
<addl IPRddr>
<AddlMacAddress>
<hddlMachddress>B499BAESACTA< /AddIMachddress>
</AddlMachddress>
</file.node>
</instance>
</modal>
< /CreateucmdbNodeRequest>

Response message rom SM:

<CreateucmdblodeResponse message="Validation failed" returnCodes"T1"
schemaRevisicon-Date="2011-09-18" schemaRevisicnLevel="5" status="FAILURE"
xmlns="http://servicecenter.pereqrine.com/PWs"
¥mlns:cmn="http: //servicecenter.peregrine.com/PWs/Common™
xmlns:xsd="http:// www.w3.org/2001/3MLSchema”
¥mlns:xsi="http:/ fwww.w3.org/2001/XMLSchema-instance™
x¥si:schemalocaticon="http://servicecenter.peregrine.com/FHs
http: //¥MAl6.asiapacific.hpgocorp.net: 13080/ scé2server/ucmdbNode . xsd™>

<model>
<keys>

<CIIdentifier
type="String">¥XMAl6.asiapacific.hpgcorp.net</CIIdentifier>

</ keys>

<instance
uniquequery="file.device, logical .name=gsquot; XMAl6. asiapacific. hpgcorp. netaquot
i
<file.device type="Structura">

<CIIdentifier
type="String">xXMAlé.asiapacific.hpgoorp.net</ClIdentifier>

<DNSHame type="String">¥MAlé&é.asiapacific.hpgcorp.net</DNSHame>

<Type type="String">computer</Type>

<CIName type="String">CI108659</CIName>

<Subtype type="String">Server</Subtype>

<UCMOBId type="String®>f£d21b%4ddfZédcieelSdeZladcaiddcl</UCMDBIO>
</file.device>
<file.node type="Structure">

<addlIPAddr type="Array">

<addlIPAddr type="StructureType">
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</add]l IPRddr>
</addl IPRddr>
<AddlMachddress type="Array">
<hAddlMachddress type="String">B495BAESACTA</AddlMachddress>
</RBddlMachddress>
</file,node>
</instance>
</model>
<messages>
<cmn:message type="String">T=s===add</cmn:message>

<cmnimessage type="String">Key #18 is ampty.
(se.base.method, add. record. radd) </cmn:message>

<cmn:message type="String">file: (devica)
key: (logical .name=XMR16.asiapacific.hpgoorp.net)
(se.base.mathod, add. record. radd) </cmn:message>

<Chn:message type="String”>The record being added contains a NULL key
(se.base.metheod, add. record. radd) </cmn:message>

<cmn:message type="String">file: (joinnode)
key: (file.device, logical .name=XMR16.asiapacific.hpgcorp. net)
(se.base.method, add. record. radd) </cmn :message>

<cmn:message type="String">The record being added contains a NULL key
(se.base_method, add. record. radd) </cmn:message>

<emnimessage type="String">This record contains an invalid null
key.</cmn:message>

</messages>

</CreateucmdbModeResponses

How to Check the Push Log File

You need to set the Development adapter log level to DEBUG so that you can check the source
tree XML file of UCMDB, the XSLT-transformed XML file, and the response XML file from Service
Manager.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned three XML files are in a good format. See the following for the steps.

To set the Development adapter log level to DEBUG:
1. Logintothe UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\UCMDBServer\conf\log\fcmdb.properties file. For example:
C:\HP\UCMDB\UCMDBServer\conf\log\fcmdb.properties.
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3. Openthe fcmdb. properties file in a text editor.

4. Update the log4j.category.fcmdb.adapters loglevel to DEBUG.
luguj-categury.cum-mercury.tupaz-cmdh-Seruer.chdh-dataHCCESS=${lugleuel},chdh-;J
dataAccess.appender
log4j.category.com.mercury.topaz.cndb.shared.fendb.datafdccess=5{1loglevel},fcndb.
datafccess.appender

1loghj.cateqory.fendb. ftql.calc=3{loglevel’,fcmdb.ftql.calc.appender -J

log4j.category.fecmdb.config.audit=info,fcmdb.config.audit.appender
log4j.category.fomdb.lifecycle=info,fcmdb.lifecycle.appender
log4j.category.focndb.mapping.engine=%{loglevel},fcmdb.mapping.engine.appender

ttevery change in fcmdb.adapters will affect fcocmdb.adapters.<integration_ point_na
me .1log

loghj.category._ fcmdb._adapters=DEBUG, fcmdb _adapters
loghj.cateqgory.fendb.statistics=%{1loglevel},fcndb.statistics.appender
log4j.category.com.hp.ucndb.dataacquisition=${loglevel?,datafAcquisition.appender
;,dallithaApi.appender
loghj.cateqory.com_hp.ucmdb.api.server_datastoremgmt=%{loglevel} , daWithApi.appen
der

log4j.category.population=%{loglevel},population.appender

5. Save thefile.
To enable the Development Mode for the integration point:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Select the integration point for this integration.
4. Click the Edit Integration Point button.
5. For Development Mode, select True from the list.
6. Click the OK button to save the integration point.
To check the push log file:
1. Logintothe UCMDB server host as an administrator.

2. Navigate tothe <UCMDB installation
folder>\UCMDBServer\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C: \HP\UCMDB\UCMDBServer\runtime\log\fcmdb.adapters.SM
Integration.log

3. Open thelogfile in a text editor.
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4. Search fortext strings Source tree XML:, Transformed XML:, and Response message from
SM:.
The following is a sample log file.

2011-11-30 14:22:03,325 [17519201318Default-7] DEBUG - SM Integration >> Source
tree XML:
<node bdmType="Node" customer id="1"
display label="XMAl6.asiapacific.hpgcorp.net” friendlyType="Windows"
global id="fd21b9%4ddf26dcY9eel54e2ladcalidicl”
id="fd21b%4ddf26dcSaal54e2]ladcaiddcl” os vendor="Microsoft®
primary dns name="XMAl6.asiapacific.hpgcorp.net">
<ip addresss direction="outgoing" linkLabel="Containment" linkName="32"

linkType="Containment">

<ip address bdmType="IpAddress" customer id="1"
friendlyType="IpAddress" id="bd03e3418%cT13898712dcac500730ba"
name="16.153.154.152" realRelationType="Containment”/>

</ip addresss>

<interfaces direction="eoutgeing" linkLabel="Composition" linkNama="33"
linkTypes"Composition™>

<interface bdmType="Interface" customer id="1" friendlyType="Interface"

id="5897567531c55a7bdl96b42d5a6aa485" mac_address="B499BAESACTA"
realRelationType="Composition"
root container="UCMDBE0Ant20Al%0Ainternal id%3DSTRING%3Dfd21bI34ddf26dcteal5da
ladca3d4cO%0A™ />

<finterfaces>
</node>
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2011-11-30 14:22:07,615 [17519201318Default-7] DEBUG - 5M Integration >>
Response message from SM:

<CreateucmdbModeResponse message="Success" returnCode="0"
schemaRevizionDate="2011-09-18" schemaRevizionLewel="5" status="SUCCESS"
x¥mlns="http://servicecenter.peregrine.com/PWs"
xmlns:cmn="http://servicecenter.peragrine.com/PWS/Common™
xmlns:xsd="http://www.w3.org/2001/MLSchema"
¥mlns:xsi="http:// www.w3.org/ 2001/ XMLSchema-instance”
xsi:schemalocation="http://servicecenter.paregrine.com/FHS
http://¥MAl6.asiapacific. hpgoorp.net: 13080/ sc62server /fucmdbNode . xsd" >

<model>
<keys>

<CIIldentifier
type="5tring">XMRl6.asiapacific.hpgocorp.net</CIIdentifier>

</keys>

<instance
unique-query="file.device, logical .name=&quot ; ¥MAl6. asiapacific.hpgcorp.netsquo
£

<file.device type="Structure">

<CITdentifier
type="String">X¥MAl6.asiapacific.hpgcorp.net</CIIdentifier>

<DNSHame type="String">XMAlé6.asiapacific.hpgcorp.net</DNSHame>
<Type type="String">computer</Type>
<Subtype type="String">Server</Subtype>
<UCMDBId type="String">fd21b94ddfZedcieelSde?ladcaiddcl</UCHMDBIA>
<ffile.device>
<file.node type="Structure">
<addlIPAddr type="Array">
<addlIPAddr type="StructureType">
<hddlIPAddress type="String">16.158.154.152</Add1IPAddress>
</addlIPAddr>
</addlIPAddr>
<hddlMachddress type="Array">
<AddlMacAddress type="String">E499BAESACTA</AddlMacAddress>
</BddlMachddress>
</file.node>
</instance:>
</model>
<messages>
<cmn:message type="String">0=====update</cmn:message>

</messages>
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How to Re-push Failed CI/Cl Relationship Records

The push error handling mechanism allows you to re-push failed C1/Cl Relationship records either
one by one orin batches.

To re-push failed data in a query of a data push job:
1. Select the data push job.

2. Onthe Query Status tab, double-click the failed query.

Integration Jobs

* ¢ R G PR
Job Name | Status Last Synchronization Type
SM Configuration tems Push job @ Succeeded Changes
SM Push job ‘i\, Pazsed with failures Changes
SM Relations Push job ‘i\, Pazsed with failures Changes
ST
Statistice | | Query Status || Job Errors
o
SM Push job
Query Name | Status | Start Time Finish Time
SM Metwork Componert Push @ Succeeded Mon Feb & 2012 10:17 AM CST Mon Feb 6 20121017 AM CST ‘|
SM Mode Relations Push | A Passed with failures | Mon Feb 6 2012 03:47 PM CST Mon Feb 6 2012 03:47 PM CST
SM Bunning Software Push @ succeedsd Mon Feb 6 201210017 AM CST Mon Feb 6 20121017 AM CST
SM Storage Push @ Succeeded Mon Feb 6 201210017 AM CST Mon Feb 6 20121017 AM CST §|

The query failure details (Error Message, Cl Type, and CI Count) display.

Statistics | | Query Status | | Job Errors

o

SM Push job > SM Meode Relations Push

Error Message | Cl Type Cl Count

Invalid Data Error from SM Composition &

3. Double-click the Error Message, to see more details of the failed records.
Stabistics || Query Status || Job Errors

{5}

SM Pushjob = S5SM Node Relations Push > Invalid Diata Error from SM ( composition )

Error Message | Display Label Occurrence Date
Invalid Data Error from SM, return code 881, the erro... 133—=12312312 Sun Feb 05 19:40:02 C5T 2012 A
Invalid Data Error from SM, return code 881, the erro... Cl14449—=cracle_rac Sun Feb 05 19:40:02 C5T 2012
Invalid Data Error from SM, return code 881, the erro... CH1476—=12312312 Sun Feb 05 19:40:02 CST 2012 =
Invalid Data Error from SM, return code 881, the erro... CH4449 12312312 Sun Feb 05 19:40:02 CST 2012

4. Double-click each failed record to see the detailed error message of the record.

5. Fix the issues with each failed record according to the error information.
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6. Select afailed record, and then click the Push selected failed data button to re-synchronize
the record.

Statistics || Guery Status || Job Errors

c®

SM Pushjob = SM Mode Relations Push = Invalid Data Error from SM ( composition )

Error Message | Display Label Occurrence Date
L‘ nvalid Data Error from SM, return co@ 881, the erro... | 133—=12312312 Sun Feb 05 19:40:0_2 C5T 2012 ) =
Invalid Data Error from SM, return code 881, the erro.. Cl4449—=oracle_rac Sun Feb 05 19:40:02 CST 2012
Invalid Data Error from SM, return code 881, the erro... CH1476—=12312312 Sun Fek 0519:40:02 CST 2012 =
Invalid Data Error from SM, return code 881, the erro.. Cl4449—=12312312 Sun Feb 05 19:40:02 CST 2012 |

Alternatively, click the query name link (in this example, “SM Node Relations Push”), select the
error message of the query, and then click the Push selected failed data button to re-push all
failed records in the query.

Stafistics | | Gueny Status | |Job Errors

)

SM Push job > SM Nede Relations Push

Error Message | Cl Type Cl Coumnt
Invalid Ciata Error from SM | Composition i )]

Typical Push Errors and Solutions

This section describes typical error messages that may occur during data push, as well as their
solutions.

This section includes:

¢ "TQL not Configured in smSyncConfFile.xml" on the next page

o "Non-Existing XSLT File Name Defined for a TQL in smSyncConfFile.xml" on page 225

¢ "Request Name not Found fora TQL in smSyncConfFile.xml " on page 226

¢ "Wrong Service Manager WS Request Name Defined in smSyncConfFile.xml" on page 228
o "XSLT file not Well Formed" on page 229

o "Wrong UCMDB Attribute Name in XSLT File" on page 231

¢ "Wrong Service Manager Field Name in XSLT File" on page 232

o "Empty Value for No Nulls Key in Service Manager" on page 233

e "Cl Logical Name Truncated or Cl not Pushed due to Logical Name Truncation" on page 236
¢ "Service Manager Database Case-Sensitivity Issue" on page 236

e "Global ID and Customer ID Missing in XSLT" on page 237
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TQL not Configured in smSyncConfFile.xml

Sample configuration

The TQL query used for populating business service Cls is named SM Business Service Push,
however you have not configured it (or have commented it out) in the smSyncConfFile.xml file:

Resourcediscovery ConfigFiles/Service ManagerAdapterS-xism Sync ConfFile xml

e ¢

g «<!-- nev enhancement -->

9 <f--

10 Wildcard i1s supported for TOL

11 vou can —"A—_'_ P

12 = u

13

14

15

18 n wil ukt 1cally use LI mapping er n all of the three TQLs.
17 Howew us1ng T name to configu the mapping 15 sti1ll supported.
1s -—>
19 <tgl name="3M Bunning Software Push*" xslFile="runningsoftware push.xslt">
20 <l-- this 15 logical application tgl --=
21 <request typ=—""reate name="CreateucndbRunningSoftwareRequest" />
22 <request type="Update" name="UpdateucmdbRunningSoftwareRequest”/ >
23 <request type="Delete” name="DeleteucmdbRunningSoftwareRequest”™ />
24 </tgl=
25 C<!--tgl name="SM Business Service Push*" %51F1le="bUs1Nes5 SErvice push.xslt’s =3
26 Tr=="thr1s 15 "business service ror catalog tgl ==
27 <request Ty e="Create" nsn=—""reateucmﬂbBu51nessServ1ceRequest"f}
28 <request type="Update"” nsn=—"UpdateucmﬂbBu51nessServ1ceRequest"f}
a0 L AlaTel + FrommemNalsatea” sarcmreNa ] st amdlbDisas meaaaCewrrd anTlesamas s =10

Error message

The push job fails with a “Failed” status. From both the log file and the detail error message of the
failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed Push
Job" on page 212), you receive an error like the following:

java.lang.RuntimeException: Heo mapping is found for TQL: "SM Business Service Push",
please configure in smSyncConfFile.xml

at

com.mercury.topaz . focmdb. adapters. serviceDeskAdapter .push. SmPusher . pushObjects (SmPush
er.java:273)

at
com.mercury.topaz . fomdb . adapters . sarviceDeskidapter.push. SmPusher. push [SmPusher . java
:93)

vos 31 more

Solution

Search for text No mapping is found for TQL to find the TQL name that is not yet configured,
and then configure the TQL name in the smSyncConfFile.xml file.

For instructions on how to add a mapping for a TQL, see "How to Map the C| Type’s TQL Query to
an XSL Transformation File" on page 165.
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Non-Existing XSLT File Name Defined for a TQL in
smSyncConfFile.xml

Sample configuration

The XSLT file for populating business service Cls is named business_service_push.xslt,
however you have configured a wrong name business_service_push_wrong_name.xslt in
smSyncConfFile.xml.

Resourcediscovery ConfigFiles/Service Manager Adapter 9-xizm Sync ConfFile.xml

QE®OE 2
13 vou could still push 1t to SM witl
14
15
14
17 Howew n he exact TOL nam
18
139 <tgl name="5M Running Software Push*" xslFile="runningsoftware push.xslt">
20 <l-- this 15 logical application tgl -->
21 <recquest type="Create"” name="CreateucmdbRunningSoftwareRequest™/>
22 <request type="Update"” name="UpdateucmdbRunningScftwareRequest"/>
23 <request type="Delete” name="DeleteucmdbPRunningScftwareRegquest™/>
24 </tgl>
25 <tql name="5M Business Service Push*™ x31File="business_service push Wrong name.X31t™>
26 4 Fr s s mnss e Srryas Fam A + =
27 <request Ty e="Create” name= EreafeucmﬂbBusineSSServiceRequest"f}
28 <request type="Update" name="UpdateucmdbBusinessServiceRequest"/>
29 <recuest type="Delete” name="DeleteucmdbBusiness3erviceRequest™/>
30 </tgl>
31 <tgl name="5M Computer Push*" xslFile="computer_ push.xslt">
32 <I-- this 15 host-rip,interface,sm server tgl --»
33 <request type="Create” name="CreateucmdbNodeRegquest™/>
a4 Fanmenreo + i remTTTmAs A" e mrrm e T A s s s e AR A A s T s s e T s

4

Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:
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java.io.FileNotFoundExcepticon: Resource: business service push wrong name.xslt, was
net found

at
com.mercury.topaz.cndb. server. femdb. adapterstate . AdapterStateResourceServerFacade . op
enResourceForReading (AdapterStateResourceServerFacade. java:5l)

at
com.mercury.topaz.cmdb. server. femdb, spi . adapter. environment. DatafdapterEnvironmentIm
pl.cpenRescurceForReading (DatafhdapterEnvironmentImpl.java:119)

at
com.mercury.topaz. fomdb. adapters.serviceDeskhdapter. TransformUtils. readFromFile (Tran
sformUtils. java:113)

at
com.mercury.topaz. fomdb. adapters. serviceDeakhdapter.push.XsltTransformer. createTempl
ates (XsltTransformer.java:393)

. 36 more
Solution

Search for text java.io.FileNotFoundException: Resource: tofind the wrong XSLT file name,
and then correct the XSLT file name in the smSyncConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How to Map the Cl Type’s
TQL Query to an XSL Transformation File" on page 165.

Request Name not Found for a TQL in
smSyncConfFile.xml

Sample configuration

The Service Manager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have not configured it (or have commented
it out) in the smSyncConfFile.xml file.
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Resourcedizcovery Config FilesiService Manager Adapterf-d/sm Sync ConfFile xml
D E| e
13 you cou 1 y;s'r' 1t ko SM witl
14 Fa hawve Sc ad the <T
15 th
18 in
17 How
18 -
18 <tgl name="3M Running Joftware Push#*" xslFile="runningsoftware push.xzslt">
20 <l-- this 1s logical application tgl --»
21 <regquest Ty e="Create"” name="CreateucmdbRunningScftwareRequest™ />
22 <request type="Update" name="UpdateucmdbRunningSoftwareRequest”/>
23 <regquest type="Delete” name="DeleteucmdbRunningScftwareRequest™ />
24 </ bl
25 <tgl name="3M Business Jerwvice Push*" xs1File="business_service push.xslt">
26 <!-— this 15 business service for catalog tgl —->
27 (: <!-—request type="Create™ name="CreateucmdbBusinessServiceRequest "/ —-» j}
28 <request type="Update" name="UpdateucmdbBusinessServiceRequest" />
29 <request type="Delete” name="DeleteucmdbBusinessServiceRequest™/>
30 </ Lol
31 <tgl name="3M Computer Push*" xslFile="computer push.xslt™>
32 <!-- this 1s host-»ip,interface,sm server tgl -->»
33 <request type="Create" nc1r.=—"CrEateucm:]andERequest"fb
2Aa T = rrrrmem T TTm A m " e mrr e e T TTam Al = = o s A AT Al = T ey = 17
4

Error message

The data push job fails with a “Failed” status. From both the log file and the detail error message of
the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:

java.lang.RuntimeException: No request name was found for operation "Create"™ of TOL
name "SM Business Service Push", please check in smSyncConfFile.xml file.

at
com.mercury.topaz.fomdb.adapters. serviceDeskAdapter.push.Mapping. createTransformer (M
apping.java:§9)

at
com.mercury.topaz. focmdb.adapters. serviceDeskRdapter.push. SmPusher.pushObjects (SmPush
er.java:276)

at
com.mercury.topaz. femdb. adapters. serviceDeskAdapter.push.SmPusher.push (SmPusher.java
195)

= 31 MOre & &
Solution

In the error message find the TQL name for which a request name was not found, and then in the
smSyncConfFile.xml file add the request name for the TQL name.

For instructions on how to configure a request fora TQL, see "How to Map the CI Type’s TQL
Query to an XSL Transformation File" on page 165.
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Wrong Service Manager WS Request Name Defined in
smSyncConfFile.xml

Sample configuration

The Service Manager web service request of the Create type is named
CreateucmdbBusinessServiceRequest, however you have configured a wrong request name
CreateucmdbBusinessServiceRequest_wrongname in the smSyncConfFile.xml file.

Fesourcediscovery ConfigFiles/Service Manager Adapter9-x/zmSync ConfFile xml

QAEE & | &
18 ma of the three TQOLs.
17
15 -—x
18 <tgl name="3M Bunning Software PFush*"™ xslFile="runningsofitware_ push.x3lt">
20 «l-- this 15 logical application tgl -->»
21 <request :ype="CreatE" name="CreateucmdbRunningSoftwareRequest™ />
22 <request type="Update” name="UpdateucmdbRunningSocftwareRequest™/>
23 <request type="Delete” name="DeleteucmdbRunningSoftwareRequest™ />
24 </tgl>
25 <tgl name="5M Business Service Push*™ xslFile="business service push.xsltc">
26 «!-- this 15 business service for catalog btgl --»
27 ¢ <request type="(reate"” name="CreateucmdbBusinessServicelequest wrongname®™/> )
28 <request type="Update" naeme="UpdateucmdbBusinessServiceRequest™/ >
28 <request type="Delete” name="DeleteucmdbBusinessServiceRequest™/>
30 </tgl>
31 <tgl name="35M Computer Push*" xslFile="computer push.xslt">
32 «l-- this 15 host I m_server tgl --»
33 <request type="Create™ I ="CreateucmdbNodeRequest™ />
34 <request © "Tpdate™ r ="TpdateucmiblodeRequest™ />
35 <request type="Delete” name="DeleteucmdbNodeRequest™/>
34 </tgl>
an 2 TR | T T O Dh s+ Thamakb T e T T3 7 ™ nn a5 = nb wraab s T+ W
4

Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed Cls in the Universal CMDB studio (see "How to Check the
Error Messages of Failed Cls/Cl Relationships in a Push Job" on page 213), you receive an error
like the following:
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Other exception while sending message to 5M, the exception message is "SOAFP fault
received: A C¥mlApiException was raised in native code : error 16 : scxmlapi(lé) -
Invalid or missing file name in XML reguest"”

& &

Scurce tree XML:

<?uml version="1.0" encoding="UTF-16"7%>

<business_element bdmType="BusinessService" customer id="1"
display label="test bizservice push 1"
friendlyType="BusinessService" id="dc57462318247594f82cTbccd2448630"

—n

name="test bizservice push 1" provider="providerl"/>
Transformed XML:
<?xml version="1.0" encoding="UTF-16"7>
<CreateucmdbBusinessServiceRequest wrongname>
<model>
<keys/>
<instance>
<UCMDBEId>de57d62318247594f82cTbecd2448630< /UCMDET A
<CustomerId>l</CustomerId>
<Typerbizservice</Type>
<Subtype>Business Service</Subtype>
<SarviceProvider>providerl</ServiceProvider>
<ServiceMame>test bizservice push l</ServiceName>
<CIIdentifier>test bizservice push 1</CIIdentifier>
<finstance>
</model>

</CreateucmdbBusinessServiceRegquest wrongname>

Solution

Inthe Transformed XML section of the error message, check the Request name (which is
configured as CreateucmdbBusinessServiceRequest_wrongname in this sample), and make sure
that the request name specified in smSyncConfFile.xml is the exact name defined in the WSDL.

For instructions on how to configure a Service Manager web service request fora TQL, see "How to
Map the Cl type's TQL Query to an XSL Transformation File" on page 183.

XSLT file not Well Formed

Sample configuration

The end tag of “instance” should be </instance>, however you have configured a wrong end tag
</instance_wrong_end_tag>.
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Rezource dizcovery ConfigFiles/Service Manager Adapter9-x/busziness_service_push.xsk
QD e
1 <xsgl:stylesheet verzion="1.0" xmlnz:xsl="http://wWww.w3.org/1999/¥5L/Transform™>
2 <xsl:variable name="CIlists" select="document('5M CIT Subtype list.xml')/lists™/>
3 <xsl:template match="/business element">
4 <model>
] <keys/ >
a LSinetanreas
7 <!—-1mport:cmdb root attributes.xslt--x>
g <Typerbizaervice<s/Type>
] <xzl:variable name="CIT" select="(EbdmType"/>
10 <Subtyper<xsl:ivalue-of select="zCIT"/></Subtype>
11 <xszl:for-each select="$CIlists/list[fname="CIType bizservice']"»>
12 <fubtyper<xsl:value-of select="entry[fucmdb=:CIT]/Eam"/></Subtype>
13 </xsl: for-each>
14 <xzl:for-each select="(Eprovider">
15 <ServiceProvider><xsl:value-of =zelect="."/></5erviceProvider>
1a </xs1l: for-each>
17 <x=l:for-each sslect="Fdisplay label™>
18 <ServiceNamer<x=l:value-of zslect="."/></5ervicelame>
15 <CITdentifier>x=l:ivalue-of select="."/>/CIIdentifier>
20 </xs1l: for-each>
21 {f"lhqi':rnr'e wrondg end taogs
22 </model>
23 </xzl:template>
24 </xsl:stylesheet>
4

Error message

The data push job fails with a “Failed” status. From both the log file and the detailed error message
of the failed job in the Universal CMDB studio (see "How to Check the Error Message of a Failed
Push Job" on page 212), you receive an error like the following:

javax.xml.transform. TransformerConfiqurationException: Failed to compile styleshest

at
com. sun.org.apache.xalan.internal.xsltc.trax.TransformerFactoryImpl .newTemplates (Unk
nown Source)

atc
com.mercury.topaz. fecmdb. adapters. serviceDeskAdapter.push.XsltTransformer.createTempl
ates (XsltTransformer.javas: 100)

s 36 more

In addition, you can find more detailed error message in the log file to see which XSLT file is not well
formed. You should see something like following:
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2011-12-12 14:54:58,108 [170025072@Default-10] ERROR - SM Integration >> Got
DatahccessException while updateData

com. hp.ucmdb. federationspi.exception.DatafAccessGeneralException: Hot walid XSLT file
"busi-ness service push.xslt", please check this XSLT file

at
com.mercury.topaz.fecmdb. adapters. serviceDeskAdapter.push.XsltTransformer.createTempl
ates (XsltTransformer.javas:103)

at
com.mercury.topaz. fomdb. adapters. serviceDeskRdapter .push.Mapping.parseConfig(Mapping
-java:54)

Solution

Search for text Not valid XSLT file tofind the XSLT file name, and then validate the XSLT file in
an XML editor (for example, XMLSpy). You can easily find and fix any validation issues.

G| & BB o | # O # | [3[CcE |V |50 6 E T G

gl stylesheet version="1.0" xmins x=l="httg;=: = 4999/ %5/ Transform " =
<xzlvarable name="Clists" select="doc fe TE {F_B} btype_list xml)lists" />
<xsltemplate match="/business_element"=

IR

<model =
heysss
= <instance’
<l-mpart :cmdb_root_attributes xsh—
< Type=hizservice </ Type:
x5l varable name="CIT" select="Ebdm Type"/>
<5ubtype sl valueof select="8CIT"/ =< Subtype:
= «usl foreach select="8Cllists list[@name="ClType_bizservice]"=
i «Subtypexaslvalue-of select="entry[@ucmdb=8CIT]/@sm" /=< Subtype =
B </l foreach=
] <xsl foreach select="Eprovider" >
i <ServiceProviders<xslvalue-of select=""/></Service Provider:
B </xslforeach:
L= <zl for-each select="@display_label" >

i «ServiceMame x<xslvalueof select="."/></ServiceName >
i <Clidertifiers<xs value-of select="_"/=</Clldentifier>

B </wsl foreach:

- Bynstance wrong end tagk

B </model=

- <fusliemplate:

= «fslstyleshest =

This file is not welfomed:
Q instance closing element name expected. @’ Recheck |

Wrong UCMDB Attribute Name in XSLT File

Pl Pl T Y

Sample configuration

The Universal CMCB attribute name is provider, however you have configured a wrong attribute
named provider_wrong.
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Reszource discovery ConfigFiles/Service Manager Adapter8-xbusiness _service_push.xsh
QARG E| &£
1 <xsl:stylesheet wersicn="1.0" zmlns:xsl="http://www.w3.org/l999/X5L/Transform™>
2 <xsl:variable name="CIlists" select="document('SM CIT Subtype list.xml')/lists"/>
3 <xszl:template match="/business element">
4 <model>
3 <Eeys/>
& <instance>
7 <!--import:cmdb root attributes.xslE-->
8 -:'I‘gpebbizservic?a-:f'l‘;ﬁeb
£ <xsl:variable name="CIT" select="{bdmType"/>
10 <Subtype><xsl:value-of select="sCIT"/></Subtype>
11 <xsl:for-each select="5CIlists/list[Bname="CIType bizservice']™>
12 <Subtyper<usl:value-of sslect="entry[fucmdb=5CIT] /Eam" />»</Subtype>
13 </xsl:for-each>
14 <xsl:for-each select="fprovider wrong™»
15 <ServiceProvider><xsl:value-of zslsct="."/></ServiceProvider>
la </xsl:for-each>
17 <xsl:for-each zelect="(display label™:>
& <ServiceNamer<xsl:value-of select="."/></3ervicellame>
19 <CITdentifier»<usl:value-of select="."/></CIIdentifier>
20 </xs1l:for-each>
21 </instance>
22 </model>
23 </xsl:template>
24 </xsl:stylesheet>
4

Error message

You will NOT get any error messages either in the log file or in the Universal CMDB studio, however

the Universal CMDB attribute value will not be pushed to Service Manager.
Solution

If you find a UCMDB attribute value that cannot be pushed to Service Manager, double-check the
UCDMB attribute name and Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 144.

Wrong Service Manager Field Name in XSLT File

Sample configuration

The Service Manager field name is ServiceProvider, however you have configured a wrong
attribute named ServiceProvider_wrong in the XSLT file. This error also commonly occurs since
the attribute is case-sensitive.
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Rezource discovery ConfigFiles/Service Manager Adapterd-xibusiness_service_push.xsh

QE®E | &
1 <xsgl:stylesheet verzion="1.0" xmlnz:xs1="http:// /wwW.W3.0rg,/1999/X5L/Transform™>
2 <xzl:variable e="CIlistas" select="document ('5M CIT Subtype_ list.xml")/lists™/>
3 <xsl:template match="/business element">
4 <model>
5 <keys/>
& <instance>
7 <!--import:cmdb root attributes.xslt-->
2 «Typerbizaervice</Type>
2] <xsl:variable name="CIT" zelect="{bdmIype"/>
10 <Subtyper<xslivalue-of select="sCIIT"/>/Subtype>
11 <xsl:for-each select=":CIliats/liat[@name="CIType_bizservice']™>
12 <Subtyper<xsl:value-of select="entry[fucmdb=5CIT]/E@am"/></Subtype>
13 </xsl: for-each>
14 <xz]1:for-each sclect="(@provider™>
15 <Rawricalrorider wronme<xs] ivalue-of select="."/=/SavrricaeProvrider wrona>
1a </xsl:for-each>
17 <xsl:for-each select="(diaplay_lakel™>
g <ServiceName><xsl:value-of sslect="."/></Servicelame>
19 <CITdentifier»><xsl:value-of select="."/></CIIdentifier>
20 </xs1:for-each>
21 </instance>
22 </model>
23 </xsl:template>
24 </xsl:stylesheet>

4

Error message

You will NOT get any error messages either in the log file or in the Universal CMDB studio,
however, the Universal CMDB attribute value will not be pushed to Service Manager.

Solution

If you find a Universal CMDB attribute value that cannot be pushed to Service Manager, check both
the Universal CDMB attribute name and Service Manager field name of the mapping in the XSLT
file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 144.

Empty Value for No Nulls Key in Service Manager

Sample configuration

In Service Manager you have configured a No Nulls key for field “testnotnullfield” of the device
table, however you have not mapped this field in the XSLT file.
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Mame: |de'u-i::e Status:

Caze Mode:  Case Inzensitive

& Fields | & Keys| & SQL Tables

| Mo Mulls | - |
testnotnullfield

| Unigue | b |
logical.name

| Mulls & Duplicates | - |
vendor

n Bhullz & Muonliratas =1

Error message

The data push job is completed with a “Passed with failures” status. From both the log file and the
detailed error messages of the failed Cls in the Universal CMDB studio (see "How to Check the
Error Messages of Failed Cls/Cl Relationships in a Push Job" on page 213), you receive an error
like the following.
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</model>
<messages>
<cmn:message type="String">f=====add</cmn:message>
<omn imassage type="String">Key #1 is empty.

{se.base.method; add. record. radd) </cmn :message>

<Cinn i message type="5tring">i;;u:[dCT;ﬁc:
key: (logical .name=test bizservice push 1)
(se.base.method, add. record. radd) </cmn :massage>

<Chn:message typem"String”>The record being added contains a NULL key
{se.base.method, add. record. radd) </cmn:message>

&
< /messagqes>

</CreateucmdbBusinessServiceRespongse>

Solution

Find the key number in the <messages> section to see which No Nulls key has a NULL value. For
example, if you find a message “Key #1 is empty”, check the first key definition of the device table
to see which field(s) this key is for, and then make sure that a non-NULL value has been mapped to
the field(s) in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to a
Web Service Field" on page 144.

Cl Logical Name Truncated or Cl not Pushed due to
Logical Name Truncation

Sample configuration

The length of a UCMDB CI name exceeds 200 characters, which is the maximum allowed field
length for 1logical.name (Cl Identifier) in Service Manager. When this Cl is pushed to Service
Manager, the Cl name is truncated.

Two UCMDB Cls have the same Cl name that is 200 characters in length. When the second Cl is
pushed, it is supposed to be renamed if the DEM Duplication Rule is configured so; however, the
renamed logical name will be truncated to be same as the first CI’s logical name. As a result, the
second Cl will not be able to be pushed to Service Manager due to an invalid duplicate key error.

Error message

You receive an error message that contains this string: This record contains an invalid
duplicate key.

Solution

Update the Cl type’s XSL transformation file so that, before running a push, the integration can
make sure that all Cl names are significantly less than 200 characters in length.

Service Manager Database Case-Sensitivity Issue

Sample configuration
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Your Service Manager database is case-insensitive. You have two UCMDB Cls with a name of
CINAME1 and ciname1, respectively.

When running a push job to push these Cls, the integration considers the second ClI a duplicate of
the first one, and therefore either renames it or returns an error according to the Duplication Rule
setting of the relevant DEM Rule record.

Solution

HP recommends using a case-sensitive Service Manager database to avoid this issue.

Global ID and Customer ID Missing in XSLT

Sample configuration
You create an XSL transformation file for push without the following element:
<!--import:cmdb_root_attributes.xslt-->

The cmdb_root_attributes.xslt file contains Global ID and Customer ID, which are required for
data push:

<UCMDBId><xsl:value-of select="@id"/></UCMDBId>
<CustomerId><xsl:value-of select="@customer_id"/></Customerld>
Error message

No error message occurs, however when you update or delete a Cl record in UCMDB, the update or
deletion will not be pushed to Service Manager.

Solution
In the XSL transformation file, include the missing element:

<!--import:cmdb_root_attributes.xslt-->

Troubleshooting Population Issues

When population errors or problems occur, you can check the error messages and the population
log file to identify the root causes and then solve the problems.

When a population job has failed, the job status becomes Failed. Troubleshoot the failed job as
follows:

¢ Check the error message of the failed job in the Universal CMDB studio.
See "How to Check the Error Message of a Failed Population Job" on the next page and "Typical
Error Messages and Solutions" on page 244.

o Check the log file for more details.
See "How to Check the Population Log File" on page 239.
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How to Check the Error Message of a Failed
Population Job

While a population job fails, you can check the detailed error messages in the Universal CMDB
studio.

To check the error message of a failed population job:
1. Loginto UCMDB as an administrator.
2. Navigate to Data Flow Management > Integration Studio.
3. Select the integration point for this integration.
4. Click the Population tab.
5. Select the failed job from Integration Jobs, and click the Job Errors sub-tab.
6. Double-click an error message from the list.

A pop-up window opens to display the error details. The following is a sample error message
about a non-existing XSLT file:

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 238 of 256



Universal Discovery Content Guide - Service Manager Integration
Troubleshooting

Failed initializing the datastore. adapterlID:ServiceManagerBdapter9-x destID:SM
Integration
ER-ROR:com.mercury.topaz.cmdb.shared. femdb. dataAccess. exception. AdapterAccessFaile
dToStartidapterException: [ErrorCode [850] Integration Point cannot start{sM
Inteqration}]

Failed to start adapter [SM Integration].java.lang.RuntimeException: Mo XSLT file
is found "busi-ness service population wrong.xslt", please configure the right XSLT
file in smPopConfFile.xml

com. hp.ucmdb . federationspi.exception.DataAccessCommunicationException:
java.lang.RuntimeException: No XSLT file is found

"business service population wrong.xslt", please configure the right XSLT file in
smPopConf=File.xml

at

com.mercury. topaz. femdb. adapters.serviceDeskAdapter.ServiceDeskidapter.start (Servi
ceDeskhdapter.java:841)

at

com.mercury.topaz.cmdb. server. femdb.datafccess.manager. impl.AbstractDatafccessCont
ainerManagerImpl.startAdapter (AbstractDatadccessContainerManagerImpl.java:244)

at

com.mercury. topaz. cmdb. server. femdb. datafccess. manager. impl . AbstractDataAccessCont
ainerManagerImpl.addStartAndReturnBasicDatafdapterWrapper (AbstractDatafhccessContal
nerManagerImpl.java:162)

ac
com.mercury.topaz.cmdb. server. fomdb. datafccess.manager. impl.AbstractDatahccessCont
ainerManagerImpl . getStartedBasicDatafdapterWrapper (AbstractDataldccessContainerMana
gerImpl.java:lg87)

at
com. hp . ucmdb . discovery. probe. agents. probemgr . adapters.DatafccessAdaptersFacade. get
StartedBasicDatahdapterWrapper (DatahccesshdaptersFacade. java:139)

at
com. hp.ucmdb . discovery.probe. services.dynamic.core. AdapterService . runDi scovery (Ada
pterService.java:l72)

at
com. hp.ucmdb . discovery. probe . services . dynamic.core. AdapterService . discover (Adapter
Service.java:140)& &

How to Check the Population Log File

You can set the Development adapter log level to DEBUG to check the incoming CI XML file of
Service Manager, and the XSLT-transformed XML file.

Tip: You are recommended to enable the Development Mode for the integration point so that
the above-mentioned two XML files are in a good format.

To set the adapter log level to DEBUG:
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1. Logintothe UCMDB server host as an administrator.

2. Navigate tothe <UCMDB installation folder>\DataFlowProbe\conf\log
\fcmdb.properties file. For example:
C:\HP\UCMDB\DataFlowProbe\conf\log\fcmdb.properties

3. Openthe fcmdb. properties configuration file in a text editor.

4. Update the log4j.category.fcmdb.adapters loglevel to DEBUG:

loghj.cateqory.focmdb.ftgql.calc=%{loglevel},fcmdb.ftql.calc.appender |
log4j.category.fecmdb.config.audit=info,fcmdb.config.audit.appender
log4j.category.femdb.lifecycle=info,fcndb.lifecycle.appender
luguj.categury.chdh.mapping.Engine=${lugleuel},chdh.mapping.engine.append—J

er

fievery change in fcmdb.adapters will affect fcmdb.adapters.{integration_poi
nt_name>_.log

lughj.categury.chdh.adapter5=DEBUGLchdh.adapters
loghj.category.femdb.statistics=${loglevel?,fcndb.statistics.appender
loghj.category.com.hp.ucmdb.dataacquisition=%{loglevel?,datafcquisition.app
ender ,daWithApi.appender
loghj.category.com.hp.ucmdb.api.server.datastoremgnt=%{loglevel?,daWithApi.
appender

loghj.category.population=%{loglevel’,population.appender

—— SELECT — & 36,36 19%

5. Save thefile.
6. Wait a while for the change to take effect.

To enable the Development Mode of the integration point:
For detailed steps, see "How to Check the Push Log File" on page 217.
To check the population log file:

1. Logintothe UCMDB server host as an administrator.

2. Navigate to the <UCMDB installation
folder>\DataFlowProbe\runtime\log\fcmdb.adapters.<integration_point_name>.log
file. For example: C: \HP\UCMDB\DataFlowProbe\runtime\log\fcmdb.adapters.SM
Integration.log

3. Open the logfile in a text editor.

4. Search for text strings Source SM CI XML, Transformed XML, Source tree XML for ID
Pushback, Transformed XML for ID Pushback and Response message from SM For ID
Pushback. The log looks like the following:

HP Universal CMDB (UCMDB 10.10, CP 13.00) Page 240 of 256



Universal Discovery Content Guide - Service Manager Integration
Troubleshooting

2011-12-13 11:01:18,063 [JobExecuterWorker=-0:D5 SM Integration bizservice
population] DEBUG - SM Integra-tion »>> Source SM CI XML:

<?xml version="1.0" encoding="UTF-1&6"7>
<S0AP-ENV:Envelope xmlns:S0ARP-ENV="http://schemas.xmlsocap.org/scapfenvelope/">
<SOAP-ENV: Body>
<RetrieveucmdbBusinessServicelistResponse

xmlns="http://servicecenter.peregrine.com/PHs"
message="Success" returnCode="Q"
schemaRevisionDate="2011-09-18" schemaRevisicnLevel="5"
status="SUCCESS"
xmlns:cmn="http://servicecenter.peregrine. com/EWs/Common™
xmlns:xsd="http:/ www.w3.org/2001/¥ML5chema"

¥mlns:xsi="http://www.w3.org/ 2001/ ¥ML5chema-instance™
xzi:schemalocation="http://servicecenter.peregrine.com/FPHS
http: //XMAl6.asiapacific.hpgoorp.net: 13080/ sc62server/ucmdbBusinesssService . xad"™>

<instance query=""
unigquequery="file.device, logical.name=&guot;:test_biz servecie l&iquot:">

<file.device type="Structure”>
<CIldentifier type="String">test biz servcie 1l</CIIdentifier>
<ServiceProvider type="String">VENDORl</ServiceProvider>
<Type type="String">bizservice</Type>
<CIName type="String">CI10873</CIName>
<Subtype type="String">Business Service</Subtype>

</file.device>

</instance>

<instance query=""
unigquegquery="file.device, logical .name=gquot;test biz servcie Ziquot;">

<file.device type="Structure”>
<CITIdentifier type="String">test biz servcie 2</CIIdentifier>
<ServiceProvider type="String">VENDORZ</ServiceProvider>
<Type type="String">bizservice</Type>
<CIName type="String">CI10872</CIName>
<Subtype type="String">Business Service</Subtype>

<ffile.device>

<finstance>
</RetrieveucmdbBusinessServicelistResponse>
</SOAP-ENV:Body=>
=/SOAP-ENV:Envelope=
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2011-12-13 11:01:18,414 [JobExecuterWorker-0:D5 SM Integration bizservice
population] DEBUG - SM Integra-tion »>> Transformed WML:

<?xml version="1.0" encoding="UTF=-16"7%>
<topology>
<ci class="business service">
<attribute name="name" type="String">test biz servcie l</attribute>
<attribute name="sm id" type="String">CIl0873</attribute>
<attribute name="glcbal id" type="String"/>
<attribute name="provider" type="String">VENDORl</attribute>
<fci>
<ci class="business service">
<attribute name="name" type="String">test biz servcie 2</fattribute>
<attribute name="sm id" type="String">CI10872</attribute>
<attribute name="glcbal id" type="String"/>
<attribute name="provider" type="String">VENDORZ</attribute>
<fci>
</topology>
& &

2011=-12-13 11:01:32,081 [JobExecuterWorker=-0:D5 sSM Integration bizservice
population] DEBUG - SM Integra-tion >» Source tree XML for ID Pushback to update 5M
CI "CIl0873" with uCMDBE ID "50fccdeaecd9bldflalfSdca’?9942b27";

<?xml wersion="1.0" encoding="UTF-16"7%>
<ucmdbIDPushBack:>

<ci id="CI10873" ucmdbid="50fccdeaecd?b1dflalfS4ca’9942p27"/>
</ucmdbIDPushBack:

2011-12-13 11:01:32,084 [JobBxecuterWorker-0:D5 SM Integration bizservice
population] DEBUG - SM Integra-tion >> Transformed XML for ID Pushback:

<?xml version="1.0" encoding="UTF-16"7>
<UpdateucmdbIDPushBackRequest>
<model xmlns:ns="http://schemas.hp.com/SM/T">
<keys/ >
<instance>
<ConfigqurationItem>CI10873</ConfigqurationItem>
<UemdbID>50fccdeascd9b1d81al £54ca99942b27 </ UecmdbI D>
<finstance>
</model>
< /UpdateucmdbIDPushBackRequest>
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& &

2011-12-13 11:01:32,240 [JobExecuterWorker-0:Ds sM Integration kizservice
population] DEBUG - SM Integra-tion >> Response message from SM For ID Pushback:

<?xml version="1.0" encoding="UTF-16"7>
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlscap.orqg/scap/envelope/ ">
<SORP-ENV:Body>
<UpdateucmdbIDPushBackResponse

xmlns="http://servicecenter.peregrine.com/PWs"
message="Success" returnCode="0"
schemaRevisionDate="2011-09-18" schemaRevisionLevel="5"
status="SUCCESS"
xmlns:cmn="http: //servicecenter.peregrine.com/FW5/Common"
xmlns:xsd="http:// www.w3.org/2001/¥MLSchema™

xmlns:xsi="http:/ www.w3.org/2001/¥MLSchema-instance™
#si:schemalocation="http://servicecenter.peregrine.com/FWS
http: //xMAl 6. asiapacific.hpgoorp.net: 13080/ sc62server /ucmdbIDPushBack . xsd" >

<model >
<keys>
<ConfigurationItem typem"String">CI10873</ConfiqurationItem>
</ keys>

<instance recordid="CI10873 - -
unigueguery="logical.name=&quot;CI108T38quot; ">

<ConfigurationItem type="String">CI10873</Configurationltem:>

<UcmdbID
type="String">50fccdeaect 9bldBlal £54ca99942h2 7</UcmdoI D>

</instance>

</modal>

<messages>
<cmn:message type="String">==Foundabcdefg</cmn:message>
<omnimessage type="String">Found</cmnimessage>

<cmn;:message type="String®>going to update ucmdb id to
abedefg</cmn:message>

<cmn:message type="S5tring">Update done!</cmn:messages
<cmn:message type="String">Foundabcdefg</cmn:message>
</messages>
</UpdateucndbIDPushBackResponse
</ SOAP-ENV: Body>
</SOAP-ENV:Envelope>
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Typical Error Messages and Solutions

The following describes typical error messages that may occur during population, and their
solutions.

This section includes:

"No TQL Configured in smPopConfFile.xml " below
"Non-Existing XSLT File Name Defined for a TQL in smPopConfFile.xml" on the next page
"No “Retrieve” Type Request Defined for a TQL in smPopConfFile.xml" on page 246

"Wrong Request Name of retrieveKeysQueryName Configured fora TQL in
smPopConfFile.xml" on page 247

"Wrong Request Name of retrieveListQueryName Configured for a TQL in smPopConfFile.xml"
on page 248

"XSLT File not Well Formed" on page 250

"Wrong UCMDB Attribute Name in XSLT File" on page 251

"Wrong Service Manager Field Name in XSLT File" on page 252

"Wrong Universal CMDB Attribute Data Type in XSLT File" on page 253

"UCMDB CI Attribute sm_id not Mapped to the Right Service Manager Field in XSLT" on page
254

No TQL Configured in smPopConfFile.xml

Error message

If you have not yet added a TQL to your job, you cannot select this TQL from the list while you
create/update your job.

If you have already added this TQL to your job before removing this TQL from smPopConfFile.xml,
you will get a “Failed” status while you run this population job. In addition, in the Universal CMDB
studio, you will get an error message like the following (see "How to Check the Error Message of a
Failed Population Job" on page 238):
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Failed running population. destID:5M Integration, Failed during query: , all
queries: [SM Business Service Popula-tion), finished queries:[]

ERROR: com. hp.ucmdb. federationspi.exception.DatakccessGeneralBxception: Query [SM
Business Service Population] is not supported by this adapter.

at
com.mercury.topaz. focmdb.adapters. serviceDeskAdapter.ServiceDeskBdapter.getQueryByN
ame (ServiceDeskidapter.java: 990)

at
com. hp.ucmdb . discovery. probe. services . dynamic. core. AdapterService . retrieveQueryDef
initionByRootType (AdapterService.java:247)

at
com. hp.ucmdb.discovery.probe. services.dynamic. core. AdapterService. runDiscovery (Ada
pterService.java:183)

at
com. hp.ucmdb.di scovery.probe. services. . dynamic. core. AdapterService . discover (Adapter
Service.java:140)

at
com. hp.ucmdb . discovery.probe. agents.probemgr . taskexecuter. JobExecuter. launchTask (J
obExecuter.java:1194)

at
com.hp.ucmdb.discovery.probe.agents.probemgr. taskexecuter. JobhExecuteriJobExecuteri
orker.launch (JobExecuter.java: 963}

at
com. hp.ucmdb.discovery. probe . agents . probemgr . taskexecuter. JobExecutersJobExecuter
orker.executeTask (JobExecuter.java: 908)

at
com. hp.ucmdb . discovery.probe.agents.probemgr . taskexecuter. JobExecuterSJobExecuter
orker.run(JobExecuter. java:813)

Solution

Searchfortext is not supported by this adapter to find the TQL name that has not yet been
configured, and then configure it in the smPopConfFile.xml file.

For instructions on how to add a mapping to a TQL, see "How to Map the Cl type's TQL Query to an
XSL Transformation File" on page 183.

Non-Existing XSLT File Name Defined for a TQL in
smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:
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java.lang.RuntimeException: Mo XSLT file is found
"business service population wrong.xslt", please configure the right XSLT file in
smPopConfFile.xml

com.hp.ucmdb . federationspi.exception.DataAccessCommunicationException:
java.lang.RuntimeException: No ¥SLT file is found

"business service population wrong.xslt", please configqure the right XSLT file in
smPopConf=File. xml

at
com.mercury.topaz.fcmdb.adapters.serviceDeskAdapter.ServiceDeskAdapter.start (Servi
caDaskhdapter.java:841)

at
com.mercury.topaz.cmdb.server. focmdb.datalccess. manager. impl . AbstractDatafhccessCont
ainerManagerImpl.starthdapter (AbstractDataAccessContainerManagerImpl.java:244) & &

Solution

Search fortext No XSLT file is found to find the wrong XSLT file name, and then correct the
name in the smPopConfFile.xml file.

For instructions on how to configure an XSLT file name for a TQL, see "How to Map the Cl type's
TQL Query to an XSL Transformation File" on page 183.

No “Retrieve” Type Request Defined for a TQL in
smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:

java.lang.RuntimeException: Ho request was configured for operation "Retrieve" of
TOL name "SM Business Ser-vice Population”, please check in smPopConfFile.xml file.

at

com.mercury.topaz. fomdb. adapters. serviceDeskhdapter.population. PopChunkGetter. init (
PopChunkGetter.java:134)

at

com.mercury.topaz. fomde. adapters.servicebDeskAdapter.population. PopChunkGetter. <init
= {PopChunkGetter. java:104)

at

com.mercury.topaz. fomdh. adapters. serviceDeskBdapter.ServiceDeskidapter . getChanges (S
erviceDeskhdapter.java:1108)

at
com.mercury.topaz.cmdb. server. fcmdb. datakccess. cperation. query. impl . DatakccessAdapt
erQueryBetrieveChanges.getChangesResult (DatafhccessAdapterQueryRetrieveChanges. java:
48)

Solution
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Search fortext No request was configured for operation to find the TQL name for which a
retrieve type request is missing, and then add the missing request name in the smPopConfFile.xml
file.

For instructions on how to configure a request fora TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 183.

Wrong Request Name of retrieveKeysQueryName
Configured for a TQL in smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:

2011-12-13 17:18:04,394 [JobExecuterWorker-0:D5 5M Integration bizservice
population] ERROR - SM Integra-tion >> Populate ci data failed for element

com. hp.ucmdb. federationspi.exception.DataAccessGeneralException: SOAF fault received
for retrieving SM CI Keys: A CXmlApiException was raised in native code : error 16 :
scxmlapi (16) - Invalid or missing file npame in XML reguest

at

com.mercury.topaz. fomdb . adapters. serviceDeskAdapter.population. SmPopulater. response
ExceptionHandle (SmPopulater.java:322)

at

com.mercury.topaz. femdb. adapters. serviceDeskAdapter . population.SmPopulater.queryEey
List (SmPopulater.java: 116}

ac
com.mercury.topaz.fecmdb. adapters. servicelDeskAdapter.population. PopChunkGetter. init (
PopChunkGetter.java:139)

at
com.mercury.topaz. fomdb. adapters. serviceDeskRdapter.population. PopChunkGetter.<init
> (PopChunkGetter. java:104)

at
com.mercury.topaz. femdb. adapters.serviceDeskAdapter. ServiceDeskAdapter.getChanges (S
erviceDeskAdapter.java:1111)

& &

Further more, you can find more detailed error message in the log file that indicates which request of
retrieving Cl keys is wrong. The following is an example:
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2011-12-13 17:18:02,832 [JobExecuterWorker-0:DS 5M Integration bizservice
population]) DEBUG - SM Integra-tion >> Web Service Request XMl For getting SH CI
keys:

<?xml wersion="1.0" encoding="UTF-16"7%>

<socapenv:Envelope xmlns:enc="http://schemas.xmlscap.org/scap/encoding/"
xmlns:env="http://schemas.xmlscap.org/scap/envelop/"
xmlns: scapenv="http://schemas.xmlscap.org/scap/envelope/"

xmlns:xsd="http://www.w3.org/2001/XMLSchema"
xmlns:xsi="http: //www.w3.org/2001/MLEchema-instance™>

<scapenv:Body>
<axisZnsl:RetrieveucmdbBusinessServiceKeysListRequest wrong>
<axisinsd:model>
<axis?nsi:keys query="typediquot;bizserviceiquot;"”/>
<axis?nsd:instance>
<axisZnsS:file.device/>
</axisZnsd:instance>
caxis?nsb:messages/>
<faxisZns2:model>
<faxisZnsl:RetrieveucmdbBusinessServiceKeysListRequest wrong>
< /soapany:Body>

</3scapenv:Envelope>

Solution

Search fortext Web Service Request XM1 For getting SM CI keys to find the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request fora TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 183.

Wrong Request Name of retrieveListQueryName
Configured for a TQL in smPopConfFile.xml

Error message

You will get a “Failed” status while you run the population job. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message like the following:
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com. hp.ucmdb. fedarationspi . exception.DataRkccassGenaral Exception: SOAF fault received
for retrieving SM CI List: A CXmlApiException was raised in native code : error 16 :
scxmlapl (16) - Invalid or missing file name in XML request

at
com.mercury.topaz. femdb.adapters.serviceDeskAdapter.population.SmPopulater.response
ExceptionHandle (SmPopulater.java:324)

at
com.mercury.topaz. foemdb. adapters. serviceDeskAdapter.population. SmFopulater.queryRec
ordList (SmPopulater.java:188)

at
com.mercury.topaz.fcmdb. adapters. servicelDeskAdapter.population. PopChunkGetter. addor
DelCIsToTopology (PopChunkGetter. java:177)

ac
com. mercury.topaz. fomdb . adapters. serviceDeskAdapter.population. PopChunkGetter. getNe
#HtResultChunk (PopChunkGetter.java:164)

at
com.mercury.topaz. fomdb. adapters. serviceDeskAdapter. ServiceDeskhdapter..getChanges (S
erviceDeskAdapter.java:1149)

& &

Further more, you can find more detailed error message in the log file that indicates which request of
retrieving Cl list is wrong. The following is an example.

2011-12-13 17:30:23,424 [JcbExecuterWorker-0:DS SM Integration bizservice
population] DEBUG — SM Integra-tion >> Web Service Request XMl For getting SM CI
List:

<?xml version="1.0" encoding="UTF-16"72>

<spapenv:Envelope xmlns:enc="http://schemas.xmlscap.org/soap/encoding/"
xmlns:env="http://schemas.xmlscap.org/scap/envelop/"
xmlns: soapenv="http://schemas.xmlscap.org/scap/envelope,/"

xmlns:xsd="http:// www.w3.org/ 2001/ MLSchema"
x¥mlnsg:xsi="http: //www.w3.org/2001/XMLSchema-instance™>

<soapenv:Body>
<axisnsl3:RetrieveucmdbBusinessServicelistRequest wrong>
<axisinsld:keys>
anisinsl5:CITdentifier>test biz sarveie 1</axisZnsl15:CIIdentifier>
<faxisZnsld:keys>
<axisZnslé:keys>
caxnisinslV:CITdentifier>test biz sarveie Z</axisZnslT:CIIdentifiers
<faxis?nsl6:keys>
</axis2nsl3:RetrieveucmdbBusinessServicelistRequest wrong>
< /acapeny:Body>

</scapenv:Envelope>

Solution
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Search fortext Web Service Request XM1 For getting SM CI List to find the wrong request
name, and then specify the right request name in the smPopConfFile.xml file for the TQL name.

For instructions on how to configure a request for a TQL, see "How to Map the Cl type's TQL Query
to an XSL Transformation File" on page 183.

XSLT File not Well Formed

Sample configuration

The end tag of “ci” should be </ci>, however you configured a wrong end tag </ci_wrong>.

Resource dizcovery ConfigFiles/Service Manager Adapter9-x/business_service_population.xsh

Q@E2E| g

1 <xzl:stylesheet wverzion="1.0" xmlns:xsl="http:// www.w3.org/l1999/X5L/Transform">
2 <xsl:template match="/RetrieveucmdbBusinessServicelistResponse™>
3 <topology>
4 <xsl:for-each sslect="instance">
] <ci class="business_service"»
a <xsl:for-each select="file.device™s
7 <l--import:cmdb roob atbribntes populabion.xslb--x>
g <attribute 1FT-=-—"pr“"1:i-=r" "1:-=—"Str:|.|:1g >
9 <xzsl:value-of select="ServiceProvider"/>
10 <fattribute>
11 <fxsl: for-each>
12 </ ci wron o
13 </xsl: for-each>
14 </topology>
15 </xz]:template>
la </xs]l:stylesheet>
17
4

Error message

If you have not yet created your integration point, when you create it an error message similar to the
following example will occur in the Universal CMDB studio or the log file, causing the creation to
fail.

If you have already created your integration point, but not yet activated it, you can no longer activate
it, because when you attempt to activate it you will get a detailed error message in the probe error
log file (probe-error. log), similar to the following example.

If you have created and activated your integration point, you will get a “Failed” status when you run
the population job. In addition, from both the population log file (see "How to Check the Population
Log File" on page 239) and the Universal CMDB studio (see "How to Check the Error Message of a
Failed Population Job" on page 238), you will get an error message similar to the following example.
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java.lang.RuntimeException: Got SAXException while parsing the XSLT file
"business service population.xslt"!

com. hp.ucmdb. federationspi.exception.DatafAccessCommunicationException:
java.lang.RuntimeException: Got SAXException while parsing the XSLT file
"business serwvice population.xslt"!

at
com.mercury.topaz.fomdb.adapters.serviceDeskAdapter. ServiceDeskhdapter. start (Servic
eDeskRdapter.java:841)

at
com.mercury.topaz.cmdb. server. fomdb . datafccess . manager. impl .AbstractDataAccessConta
inerManagerImpl.startAdapter (AbstractDataAccessContainerManagerImpl.java: 244)

at
com.mercury.topaz.cmdb.server. femdb .datakccess.manager . impl . AbstractDataAccessConta
inerManagerImpl.addStartAndReturnBasicDataldapterWrapper (AbstractDatafccessContaine
rManagerImpl.java:l62)

& &

Caused by: org.xml.sax.SAXParseException: The end-tag for element type "ci"™ must end
with a ">' delimiter.

at org.apache.xerces.parsers.DOMParser.parse (Unknown Source)

At org.apache.xerces.jaxp.DocumentBuilderImpl.parse (Unknown Source)& &

Solution

Search for text Got SAXException while parsing the XSLT file to find the name of the
problematic XSLT file, and then validate the file in an XML editor (for example, XMLSpy). You can
easily find and fix any validation issues.

1 -1 =xslstyleshest version="1.0" xmins xsl="http ./ Awww w3.ong 19955 L.-"Tlan
2z = <usltemplate match="/RetieveucmdbBusiness Service List Response " =
3 = dopology
4 =) el foreach select="instance" >
5 = ! <ol class="business_service ">
6 = i «xslforeach select="file device" >
7 | <l<mport:cmdb_root_attributes_population xsht—>
8 <attribute name="provider" type="5tring "> <xslvalue-of select="ServiceProvider"/></
9 = i i sl foreach:
10 - i<
11 = «fusl for-each =
12 = </topology =
13 ~  <Asliemplates
14 = < fuslshyleshest =

This file is nat wellformed:
Q ci closing element name expected. [¥ Recheck |

Wrong UCMDB Attribute Name in XSLT File

Sample configuration
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The UCMDB attribute name is provider, however you configured a wrong attribute provider_
wrong. This error also commonly occurs since the attribute name is case-sensitive.

Rezource dizcovery ConfigFilesiService Manager Adapterf-x/buziness_service_population. xsh

Q@D &

1<xzl:stylesheet verzicn="1.0" xmlns:xsl="http://www.w3.org/1993/X5L/Transform">
2 <xzl:template match="/RetrieveucmdbBusinessServicelistResponse™=

3 <topology>

4 <xz]l:for-each sslect="instance">

3 <cl class="business_service"»

a <xz]l:for-each select="file.device">

7 <l--import:cmdbh root attributes population.xsli--»

g <attribute name="provider wrong™ type="String”>

9 <xzl:value-of select="3srviceProvider"/>
10 <fattribute>
11 </x=l: for-each>
12 <fcix
13 </x=]l: for-each>
14 </topology>
13 </xzl:tenplate>
la=/xzl:3tylesheet>
17

4 3

Error message

You will NOT get any error messages either in the log file or the Universal CMDB studio, however
the Service Manager field value will not be populated to Universal CMDB.

Solution

If you find that a Service Manager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 179.

Wrong Service Manager Field Name in XSLT File

Sample configuration

The Service Manager field name is ServiceProvider, however you configured a wrong attribute
ServiceProvider_wrong:
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Feszource discovery ConfigFilesiService Manager AdapterS-xhusiness_service_population. xsh
QBT EH| &
1<xzl:stylesheet verzicn="1.0" xmlns:xsl="http://www.w3.org/1993/X5L/Transform">
2 <xzl:template match="/FEetrieveucmdbBusinessServicelistResponse™>
3 <topology>
4 <xsz]l:for-each sslect="instance">
3 <cl clasz="business_service">
a <xz]l:for-each select="file.device">
7 <l--import:cmdb root attributes population.xslt--»
g <attribute name="provider" type="3tring">
9 <xzl:value-of select="ServiceProvider wrong"/>
10 <fattribute>
11 </x=]1: for-each>
12 <fcix
13 </xsl: for-each>
14 </topology>
15 </xzl:tenplate>
15 </x=l:styleshest> |
17
4 3

Error message

You will NOT get any error messages either in the log file or the Universal CMDB studio, however
the Service Manager field value will not be populated to Universal CMDB.

Solution

If you find that a Service Manager field value cannot be populated to Universal CMDB, check both
the UCDMB attribute name and the Service Manager field name of the mapping in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 179.

Wrong Universal CMDB Attribute Data Type in XSLT File

Sample configuration

The data type of Universal CMCB attribute “provider” is String, however you configured a wrong
type Integer:
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Reszource dizcovery ConfigFiles!Service Manager AdapterS-xibusiness_service_population. xsh
QEDE &
2 <x=z]l:template mztch="/RetrieveucmdbBusinessServicelistEesponse™>
3 <topology>
4 <x=zl:for-each select="instance">
3 <cl claszs="business service">
f <xsl:for-each select="file.device™s
7 <!l--1mport:cmdb roob abtbtributes popunlabion.xsli--»>
g <attribute JrTﬂ—"prﬁ"ldﬂr" "1=—"T“*“"“"">
] <x=zl:value-of select="3erviceFrovider"/>
10 </attribute> =
11 </x=]l: for-each> b
12 <feix
13 </xz]l:for-each>
14 </topology>
15 </xzl:templatex
la</xsl:3tylesheet>
17 |
4

Error message

The Cls will be populated to Universal CMDB, but the field value with a wrong data type
configuration will not be populated to Universal CMDB.

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message similar to the following:

General datastore error: SM Integration >> The value "VENDORL1" of field "provider"
is not a integer number, ig-nore this field walue!

java.lang.NumberFormatException: For input string: "VENDORL"
at java.lang.NumberFormatException.forInputString (HumberFormatException.java:48)

at java.lang.Integer.parselnt (Integer.java:449)

Solution

Search fortext The value "xxx" of field "yyy" is not to find the name of the attribute with a
wrong data type, and then specify the right data type in the XSLT file.

For instructions on how to configure an attribute data type, see "How to Map the CI Attribute to the
Web Service Field" on page 179.

UCMDB CI Attribute sm_id not Mapped to the Right
Service Manager Field in XSLT

The Service Manager Cl ID must be mapped to Universal CMDB CI attribute sm_id, since it is
used to push the Universal CMDB CI ID back to Service Manager.
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Out-of-the-box, this attribute mapping is configured in XSLT file cmdb_root_attributes_
population.xslt, whichis imported by the other XSLT files as a common field mapping, and the
Service Manager CI ID field is exposed as the caption CIName.

Sample configuration

If you configured the mapping for sm_id in one of the following ways:

¢ You did not configure the mapping for sm_id;

o You did not expose the Service Manager CI ID field in the Service Manager web service;
¢ You exposed the Service Manager CI ID field with a caption other than CIName;

o The Service Manager CI ID field was exposed in the web service as the caption CIName, but you
configured a wrong name (for example, CIName_wrong) in the XSLT file (see the following
figure).

<attribute name="name" type="String"><xsl:value-of
select="CIlIdentifier"/></attribute>

<attribute name="sm_id" type="String"><xsl:value-of
select="CIName wrong"/></attribute>

<attribute name="global id" type="String"><xsl:value-of
select="UCMDEI4" /></attribute>

Error message

When you run the population job, you will get a “Failed” status. In addition, from both the population
log file (see "How to Check the Population Log File" on page 239) and the Universal CMDB studio
(see "How to Check the Error Message of a Failed Population Job" on page 238), you will get an
error message similar to the following:

java.lang.RuntimeException: The Universal CMDB attribute "sm id" of CI type
"business service" is mapped to an empty wvalue, please check this mapping in XSLT
£13

at

com.mercury.topaz. femdb. adapters.serviceDeskAdapter .population. PopChunkGetter.addor
DelCITaTopology (PopChunkGetter . java: 198)

at
com.mercury.topaz. fomdb. adapters.serviceDeskAdapter.population. PopChunkGetter.addOr
DelCIsToTopolegy (PopChunkGetter. java: 184)

at

com.mercury.topaz. femdb. adapters. serviceDeskAdapter.population. PopChunkGetter .getie
xtResultChunk (PopChunkGetter. java:164)

atc
com.mercury.topaz. femdb, adapters. serviceDeskhdapter.ServiceDeskhdapter.getChanges (5
erviceDeskidapter.java:1149)

at
& &

Solution
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Search fortext The Universal CMDB attribute "sm_id" of CI type tofindthe Cl type, and
then configure the attribute mapping for this Cl Type in the XSLT file.

For instructions on how to configure an attribute mapping, see "How to Map the CI Attribute to the
Web Service Field" on page 179.
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